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Chapter 1
Welcome to ZoomText

ZoomText is a powerful computer access solution that allows low vision
computer users to see, hear and use everything on Windows desktops,
laptops and tablet devices. ZoomText gives you the tools to enlarge,
enhance and read everything just the way you want, so that you can
tully enjoy using your computer.

g ZoOm

ZoomText is available in two product versions: ZoomText Magnifier and
ZoomText Magnifier/Reader.

e ZoomText Magnifier provides the complete set of screen
magnification tools for enlarging and enhancing everything on
your computer screen.

e ZoomText Magnifier/Reader provides all of the features of
ZoomText Magnifier, plus a user-friendly set of screen and
document reading tools tailored for low vision users. ZoomText
reading tools are also perfect for individuals with learning
disabilities, low literacy and other print disabilities.



Both versions of ZoomText are designed for users of all ages and skill
levels and with the goal of providing independence, productivity and
success at home, school and in the workplace.
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Magnifier Features

ZoomText Magnifier is an advanced screen magnification program that

enlarges and enhances everything on your computer screen.

ZoomText Magnifier features include:

Flexible Magnification. ZoomText provides a full range of
magnification levels up to 60x. Levels include: 1x to 8x in steps of
1, 10x to 16x in steps of 2, 20x to 36x in steps of 4, 42X, to 60x in
steps of 6, and fractional powers of 1.2x, 1.4x, 1.6x, 1.8x, 2.5x, 3.5x
and 4.5x. You can zoom in and out using All Zoom Levels,
Favorite Zoom Levels Only or Whole Power Levels Only.

Powerful Zoom Windows. ZoomText provides a wide variety of
zoom window types for both single and multiple monitor
configurations, allowing you to configure the magnified view
according to your needs.

Advanced Smoothing. ZoomText provides two types of advanced
smoothing, xFont® and Geometric Smoothing, ensure the text and
graphics (including photographs) are crisp and legible at all zoom
levels.

Multiple Monitor Support. ZoomText's Multiple Monitor Support
allows you to see more information in a variety of ways.
ZoomText’s unique MultiView modes —MultiView Local and
MultiView Global (patent pending), allow you to simultaneously
view multiple applications or multiple locations within the same
application.

Enhanced Screen Colors. Innovative color controls improve
screen clarity and reduce eyestrain. Special effects include color
dyes, two-color modes and, replacement of problem colors.

Visible Pointers and Cursors. Size and color enhancements make
it easy to see the mouse pointer. Special locators around the mouse
pointer and text cursor make them easy to find and follow.



Focus Enhancements. Focus enhancements make it easy to locate
and follow the control focus when you navigate through menus,
dialogs, and other application controls.

Smooth Navigation. Navigating your applications and scrolling
the view is always smooth and comfortable.

Support for Touch Screen Devices. ZoomText for can be used on
Windows 10 and 8.1 touch screen devices including tablets,
laptops and desktop monitors. ZoomText follows along as you
tap, drag and swipe your way through all of your applications.
And you can instantly access key ZoomText features using the
ZoomText Touch Icon and gestures. Note: Requires a 5-point or
greater multi-touch device. For more information, see Touch
Screen Support.

Finder. Finder helps you search, skim, navigate, and read in
documents, web pages and email. You can search for single words
or phrases throughout the entire document or only in specific
items, such as headers, forms and links.

ZoomText Camera. ZoomText Camera allows you to magnify
printed documents, books and other items using a standard HD
webcam.

Application Settings. Save unique settings for each application
that you use. As you switch applications, ZoomText automatically
loads the desired settings.

Windows Logon Support. ZoomText provide magnification and
screen reading support in the Windows logon screen and other
secure mode prompts.
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Magnifier/Reader Features

ZoomText Magnifier/Reader is a fully integrated magnification and
screen reading program that enlarges, enhances and reads aloud
everything on your computer screen.

ZoomText Magnifier/Reader includes all the features of ZoomText
Magnitier, plus:

e Complete Screen Reading. ZoomText automatically speaks all
program controls and events as you navigate through
applications; including menus, dialogs, list views and messages.
Three verbosity levels give you complete control over the amount
of information spoken.

e AppReader. With the AppReader you can read right in the target
application or switch on-the-fly to the high contrast text view
that's better for visual reading. You can also spot read blocks of
text by clicking and dragging the mouse. Use AppReader's 'Read
from Pointer' command to instantly start AppReader at the word
under the mouse pointer.

e Reading Zones. Reading Zones allow you to instantly see and
hear selected locations in your applications. Define up to 10 zones
per application that you can trigger via a pop-up menu or
keyboard commands.

e Full Internet Accessibility. ZoomText reads any web page, in the
proper reading order. You can read automatically or manually
navigate by word, line, sentence and paragraph.

e Text Navigation. Navigation keys make it easy to read while
creating and editing documents. With simple commands you can
read by character, word, line, sentence and paragraph, even while
selecting text.

e Typing Echo. Each key or word that you type is automatically
spoken. You can choose to have all keys spoken or only selected
groups of keys.



Mouse Echo. Mouse echo automatically reads text that you point
to. Single words or complete lines of text are spoken instantly or
after hovering briefly.

SpeaklIt Tool. The SpeaklIt tool allows you to read selected areas of
the screen by clicking or dragging the mouse.

Background Reader. Background Reader allows you to listen to
documents, web pages, email or any text while you
simultaneously perform other tasks.

ZoomText Recorder. ZoomText Recorder allows you to turn text
from documents, web pages, email or other sources into audio
recordings that you can listen to on your computer, or transfer the
recordings to your mobile device for listening to on the go.

Built-in Premium Voices. ZoomText Magnifier/Reader includes a
full library of Vocalizer Expressive speech synthesizers, providing
voices for the most commonly spoken languages and dialects from
around the world.
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Getting Started with ZoomText

ZoomText has a lot of features designed to cover the varying needs of
users. This topic provides an overview of how ZoomText works along
with quick start instructions for the essential features that all users need
to learn and use.

How ZoomText Works

Most of the time ZoomText works in the background providing a
magnified and enhanced view that follows all of your activity. So as you
move the mouse pointer, type text, and navigate your applications, your
point of interest is always in view. If you're running ZoomText
Magnifier/Reader, ZoomText also echoes and narrates what you're
doing, audibly confirming where you are, what you type, and more. All
of this happens automatically, so you can think of ZoomText as your
personal guide in your computer.

The ZoomText Toolbar

The ZoomText toolbar has a streamlined and modern layout that makes
it easy to learn and fast and fluid to use. You can access and operate the
entire toolbar using the mouse or the keyboard.

ZoormText MagnifierfReader - x

ZoomText Magnifier Reader Tools

2 B AR Q= T

Zoorm Lewvel Windou Color  Pointer  Cursor  Focus Mawvigation
Llina A A A A A A
Zoom Windows E Screen Enhancements IE Mavigation
The ZoomText Toolbar

Using the arrow keys, you can navigate in and between the ZoomText

menu, toolbar tabs, toolbar controls and button menus. When the focus
is on a split button, pressing the Enter key will toggle the feature, while
pressing the down arrow will open the attached menu. When the focus



is in the Zoom Level spin box (on the Magnifier toolbar) or the Rate spin
box (on the Reader toolbar), pressing the Up and Down keys will adjust
the spin box value and pressing the Left and Right keys will move the
focus to the next control. On the Zoom Level spin box, pressing the
Enter key will also toggle the Zoom to 1x feature.

Setting Up the Magnified View

Since the primary purpose of ZoomText is to make everything larger
and easier to see, the first task is to adjust the zoom level and screen
colors for comfortable viewing. Here are the fast-track methods for
making these adjustments.

= To increase and decrease the Zoom Level

Hold down the Caps Lock key and press the Up and Down arrow
keys.

= To toggle between the current Zoom Level and 1x
Hold down the Caps Lock key and press the Enter key.
= To invert the brightness of the screen

Hold down the Caps Lock key and press C.

You can learn more about all of ZoomText's visual features and settings
in Chapter 5—Magnifier Features.
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Setting Up the ZoomText Voice and Echo Features

If you're running ZoomText Magnifier/Reader, ZoomText audibly
echoes and narrates everything you do, so your second task is to adjust
ZoomText's voice rate and echo settings so that ZoomText speaks
program activity the way you like. This includes how the keyboard is
echoed when you type, and how ZoomText's program echo announces
menus, dialog boxes and other controls as you navigate through your
applications. Here are the fast-track methods for making these
adjustments.

= To speed up and slow down ZoomText's voice rate
Hold down Caps Lock + Alt and press the Up and Down arrow keys.
= To adjust how the keyboard is echoed when you type

Hold down Caps Lock + Alt and press K. Each press cycles the
keyboard echo to hear a choice of characters only, words only,
characters and words, or nothing at all.

= To adjust the verbosity level for program echo

Hold down Caps Lock + Alt and press B. Each press cycles the
verbosity level between a choice of Low, Medium and High levels.
Low verbosity speaks the minimum details about each item, while
high verbosity speaks the maximum details.

You can learn more about all of ZoomText's voice and echo features in

Chapter 6—Reader Features.
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Reading Documents, Web Pages and Email

Once again, if you are running ZoomText Magnifier/Reader, there is one
more important feature that you should learn, and that's ZoomText's
AppReader. AppReader makes it easy to have documents, web pages
and email read aloud with simple commands. You can choose where
AppReader starts reading and let it read continuously to the end of the
document. You can take control to pause and resume reading, or skim
forwards and backwards through the text. And you can choose to read
in App View or Text View. App View reads right in the source
application, while Text View reads in a special environment where text
is displayed in high contrast text in teleprompter and ticker tape style
views.

The easiest way to start AppReader is using the Read from Pointer
command. Here's how it works...

To launch AppReader using the Read from Pointer command

Position the mouse pointer over the word where you want to start
reading, and then press the Read from Pointer hotkey: Caps Lock +
Alt + Left-Click

AppReader launches in the selected mode and begins reading at the
clicked on word.

To stop automatic reading

Press Enter or click.

To resume automatic reading

Press Enter or double-click where you want to resume reading.

To skim read by sentence and paragraph

Press the left and right arrow keys to read the previous or next
sentence. Press the up and down arrow keys to read the previous or
next paragraph.
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= To switch between App View and Text View
Press Tab.

= To exit AppReader
Right-click or press Esc.

When AppReader exits, the cursor is automatically positioned at the
last word that was highlighted in AppReader, if a cursor exists in the
application.

You can learn more about AppReader in the AppReader section of
Chapter 6 —Reader Features.
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Toggling ZoomText Off and On, and Exiting ZoomText

While most ZoomText users keep ZoomText running and active
throughout each work session, there may be times when you want to
toggle ZoomText off, or exit ZoomText altogether. You can do each of
these as described below.

= To toggle ZoomText off (and back on)

Click on the ZoomText menu and select Disable ZoomText or Enable
ZoomText. You can also toggle ZoomText off and on by holding
down Caps Lock + Ctrl and press the Enter key.

= To exit ZoomText

Click on the ZoomText menu and select Exit ZoomText.

Next Steps

The instructions provided above should allow you to start working
productively in all of your applications. But there are many other
features and settings to be learned that will help you optimize your use
of ZoomText even more. So we recommend that you invest some time in
exploring the entire user guide to learn more about how to use
ZoomText.



Chapter 2
Setting Up ZoomText

Getting ZoomText set up on your system is a straightforward process
that only takes a few minutes and a few steps to complete.

This section will walk you through the steps to get ZoomText fully
installed and ready to use.

e System Requirements

o Step 1—Install ZoomText

e Step 2—Start ZoomText

e Step 3— Activate ZoomText

e Step 4—Update ZoomText
e Adding More Voices
e Using the Startup Wizard

e Uninstalling ZoomText
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System Requirements

The following hardware and software are required to run ZoomText:

Windows 10, 8.1 or 7 with Service Pack 1 (or later).

Processor: 2 GHz i3 dual core processor or similar. i5 or i7
recommended.

4 GB Ram. 8 GB recommended.

Video/Graphics card or integrated graphics with support for
DirectX 10 or higher.

1.3 GB hard drive space. SSD drive recommended.
5-point multi-touch display for touch screen support.

USB 2.0 for ZoomText Camera support.
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Step 1—Install ZoomText

Installing ZoomText is very straightforward, allowing you to complete
the process in a few simple steps.

= To install ZoomText

1. Disable virus-protection software and close all other programs.

2. Insert the ZoomText disc into the DVD drive.
The ZoomText Setup program will start automatically.

Note: If you download the ZoomText installation software, select
the downloaded file and then press Enter to start the setup
program.

3. Follow the instructions to complete the installation.
4. Restart Windows.

Note: The ZoomText setup program will install system-level
components. In order to install these components, you must have
administrator privileges. If you do not have these privileges, contact
your network administrator before proceeding with the installation.
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Step 2—Start ZoomText

By default, the setup program will configure ZoomText to start
automatically when Windows starts up. If you unselected this option in
the Setup program you will need to start ZoomText manually using one
of the methods described below.

= To start ZoomText
Do one of the following:

e In the Windows Start menu, choose ZoomText {version}.

¢ On the Windows desktop, double-click on the ZoomText {version}
program icon.

e Press Windows + R to open the Run dialog, then type
"ZT{version}" and press Enter.

When ZoomText starts up, it changes your display to show a magnified
view of your Windows desktop and applications. As you move the
mouse, type text and navigate within your applications, the magnified
view automatically scrolls, keeping the area of activity in view. If you
have installed ZoomText Magnifier/Reader, ZoomText will also speak
aloud, to echo and narrate each event and action you perform in your
applications. All of your Windows programs will operate normally
while ZoomText is running.

Note: A shortcut key can be added to the ZoomText program icon
allowing you to start ZoomText with a keyboard command. Adding
shortcut keys to a program icons is standard Windows functionality.
Refer to Windows Help for instructions on adding a shortcut key.
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Step 3—Activate ZoomText

The License Manager lets you activate ZoomText using an Internet
connection. The activation process begins automatically when you start
ZoomText.

Note: If you do not have an Internet connection, you can activate
ZoomText by telephone, fax, or by visiting www.fsactivate.com from a
computer that has Internet access. For more information on these
options, choose Activation Help when the activation process begins.

= To activate ZoomText using the Internet, do the following:

1. In the Activation dialog box, choose Start Activation.

2. Read the message that displays and then use the arrow keys to
select Internet (recommended), and then press Enter.

3. If your 20-digit Authorization number is not automatically
displayed, type it into the Authorization Number edit box. You
can find your Authorization number in print and braille on your
ZoomText DVD sleeve.

4. Press Enter to continue. You will be asked to connect to the
Internet if you have not already done so. You must establish an
Internet connection before continuing with the activation.

5. If you have not registered ZoomText, you are asked to do so now.
Registering ZoomText lets you receive technical support. Choose
Register Now and complete the online registration form by
following the instructions provided. You can choose to register
later, but you must register the next time you activate ZoomText.

6. After you submit your registration, Internet License Manager
attempts to activate ZoomText. This process may take several
minutes. When the activation is successful, choose Finish.

Note: If Internet License Manager cannot activate ZoomText, you may
need to reconfigure your firewall. Refer to the Activation Help for more
information.
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Dongle Authorization

A dongle is a hardware device that you can connect to a computer's USB
port. ZoomText is authorized to run on that computer as long as the
dongle remains connected. This is useful if you frequently need to use
ZoomText on many different computers and do not want to activate the
program on each of them.

When ZoomText starts, it first determines whether a dongle is
connected to the computer. If one is connected, ZoomText uses the
features and information for the license associated with the dongle to
authorize ZoomText. If no dongle is connected, ZoomText searches for
the license information stored on the computer. You can use the Dongle
Viewer utility to view information on the license associated with the
dongle currently connected to your computer. To start the Dongle
Viewer utility; in the ZoomText menu, choose Manage License

> Explore Utilities Folder, then choose Dongle Viewer.

Dongles are sold separately or as an additional ZoomText feature. If you
want to purchase one, contact Freedom Scientific Sales.

Network License

If you have a multi-user network license, your system administrator
must go to www.fsactivate.com/network and download the network
authorization tools and license server. This page also contains simple
instructions for setting up the license server and activating the network
license.
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Step 4—Update ZoomText

ZoomText includes automatic updating that makes sure that your
installation of ZoomText is always current with the latest enhancements
and fixes, so that you always have the best possible experience. For this
reason alone, we highly recommend that you keep the automatic
updating feature enabled. If you choose to disable automatic updates,
you can still manually check for updates at any time.

Note: An Internet connection is required to use this feature.
= To enable or disable automatic updating

1. In the ZoomText menu, choose Preferences > Program

2. Check or uncheck the box next to Check for online updates each
time ZoomText is launched.

3. Click OK.

= To use automatic updating

e When automatic updating is enabled, each time you start
ZoomText the Update Wizard checks to see if you are running the
latest version. If an update is available, the Update Wizard will
ask if you want to download and install the update. Select the Yes
button to download and install the update.

= To manually check for updates

e In any version of Windows; In the ZoomText menu, choose
Manage License > Check for Updates

The Update Wizard appears and walks you through the update
process.
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Adding More Voices

ZoomText Magnifier/Reader includes a library of Vocalizer Expressive
voices for the most commonly spoken languages and dialects from
around the world. When you install ZoomText, one male and/or female
voice matching the language of your Windows operating system is
automatically installed with ZoomText.

You can download additional voices in the Vocalizer Expressive library
from the Voice Synthesizer page on the Freedom Scientific website.

= To download additional Vocalizer Expressive voices

1. On the Reader toolbar tab, click the arrow next to Voice or
navigate to Voice and press the down arrow key.

2. In the Voice menu, choose Settings.
The Voice Settings dialog appears.
3. Choose the Voice tab.

4. Choose Download More Voices...

Your web browser will open to the Synthesizer Downloads page on the
Freedom Scientific website.

5. Follow the instructions to webpage to select and download
installers for the desired voices.

6. For each download, double-click on the file to launch the installer.

Note: ZoomText also supports SAPI 4 or SAPI 5 based synthesizers that
have been installed by a third-party program and are compatible and
open for use by ZoomText.
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Using the Startup Wizard

The ZoomText Startup Wizard displays a series of simple dialogs that
make it easy for you to configure ZoomText's most popular features and
settings. The Startup Wizard automatically runs right after you activate
ZoomText. The Startup Wizard can also be run at anytime when
ZoomText is running.

= To manually run the Startup Wizard
¢ In the ZoomText menu, choose Preferences > Run Startup Wizard

The Startup Wizard appears and walks you through the startup
configuration process.

Note: These settings also appear in ZoomText’s Program Preferences
dialog. To learn more, see Program Preferences in Chapter 9—
Preference Settings.
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Uninstalling ZoomText

If you no longer need ZoomText on your system, you can uninstall it at
any time.

= To uninstall ZoomText

[y

Open the Windows Start menu.
2. In the Search box, type: Programs and Features

3. Press Enter.

The Windows Programs and Features app will appear displaying a list
of applications that are installed on your system.

4. In the list of applications, choose Freedom Scientific ZoomText
{version}, and then press Enter.

The ZoomText uninstall program will appear and guide you through
uninstalling ZoomText.

5. Follow the on-screens instructions to complete the uninstall
process.



Chapter 3
Running ZoomText

ZoomText is a standard application that you can start up and exit at any
time during your Windows session. You can even configure ZoomText
to start automatically when Windows starts up, both in the Windows
logon screen and at the Windows desktop.

To help you learn and master ZoomText faster, we recommend that you
explore the information and resources described in Getting Help with
ZoomText (later in this chapter). These resources are always available
and we encourage you to use them.

Knowing how to manage your ZoomText software and license is also
important. This includes keeping your software up to date with the
latest improvements, knowing when and how to transfer the activation,
and utilizing the ZoomText Support resources.

e Starting ZoomText

e Enabling and Disabling ZoomText

e Using the Caps Lock Key

e Exiting ZoomText

o Getting Help with ZoomText

e Windows Logon and Secure Mode Support
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Starting ZoomText

If ZoomText is not configured to start automatically when Windows
starts up, you can start ZoomText manually using any of the following
procedures.

To start ZoomText
Do one of the following:

e On the Windows desktop, select the ZoomText {version} program
icon.

¢ In the Windows Start menu, choose ZoomText {version}.

e Press Windows + R to open the Run dialog, type
"ZT{version}" and press Enter.

When ZoomText starts up, it changes your display to show a magnified
view of the normal screen. As you move the mouse, type text and
navigate within your applications, the magnified view automatically
scrolls, keeping the area of activity in view. If you have installed
ZoomText Magnifier/Reader, ZoomText will also speak aloud; echoing
and narrating each event and action you perform in your applications.
All of your Windows programs will operate normally while ZoomText
1S running.

Note: Once ZoomText is running, you can enable and disable the Start
ZoomText automatically when Windows starts option in the Program
Preferences dialog. To learn more, see Program Preferences in Chapter
9 —Preference Settings.
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Enabling and Disabling ZoomText

You can enable and disable ZoomText at any time, without exiting the
program. When disabled, ZoomText returns the screen to its normal
(unmagnified) state and all speech output is suspended.

= To enable and disable ZoomText
Do one of the following:

e Press the ZoomText On/Off hotkey: Caps Lock + Ctrl + Enter

e In the ZoomText menu, choose Enable ZoomText or Disable
ZoomText.

Tip! If you are frequently disabling and re-enabling ZoomText to view
the unmagnified screen, try using the Zoom to 1x feature. To learn more,
see Using Zoom to 1x in Chapter 4 —Magnitfier Features.
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ZoomText's Use of the Caps Locks Key

The Caps Lock key is used in many of ZoomText’s keyboard commands.
These commands involve holding down the Caps Lock key while
pressing one or more additional keys. These commands do not toggle
the caps lock state and do not interfere with pressing and releasing the
Caps Lock key (by itself) to toggle the caps lock on and off.

Announcement of the Caps Lock State

By default, ZoomText does not announce when the caps lock state is
toggled on or off. However, you can configure ZoomText to announce
the Caps Lock caps lock state as follows:

1. On the Reader toolbar tab, click the arrow next to Keyboard or
navigate to Keyboard and press the down arrow key.

2. In the Keyboard menu, choose Settings.
The Echo Settings dialog box appears with the Keyboard tab displayed.

3. Inthe Echo these keys when they are pressed section, check the
Locking Keys check box.

4. Click OK.
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Exiting ZoomText

You can exit ZoomText at any time. When you exit ZoomText, the
screen returns to its normal (unmagnified) state and all speech output is
terminated.

= To exit ZoomText
Do one of the following:

e In the ZoomText menu, choose Exit ZoomText.

e In the ZoomText title bar, click the close box.

x|
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Getting Help with ZoomText

A wide variety of ZoomText features and services are available to help

you get the most from ZoomText. Below are descriptions of these
features and services and where to find them.

ZoomText User Guide. The full package version of ZoomText
comes with the English version of the printed ZoomText User
Guide, which provides complete instructions for using both
ZoomText Magnifier and ZoomText Magnifier/Reader. Features
and instructions that are unique to ZoomText Magnifier/Reader
are grouped and marked for easy identification. Printable versions
of the ZoomText User Guide (in all localized languages) are
available for download at www.zoomtext.com/documentation.

ZoomText Help. ZoomText Help is your complete ZoomText User
Guide built right into ZoomText. ZoomText Help allows you to
quickly browse and search for help topics on the features you
want to use. For extra convenience, you can add topics you refer to
often to a list of Favorites. To learn how to open ZoomText Help,
see Using ZoomText Help below.

Toolbar Tooltips. When you move the mouse pointer over a
control on the ZoomText toolbar, a tooltip will appear, displaying
the name, description and the associated hotkeys for the control.
This is the quick way to learn what action each of the toolbar
controls perform and how to perform the action in any application
using the hotkey. To learn how to enable and disable the toolbar
tooltips, see Using Toolbar Tooltips below.

Online Resources. Online self-help resources are available any
hour of the day, including the Help Center, product updates,
manual activation, and more. You'll find these resources at
www.zoomtext.com/help.

Technical Support. The ZoomText support team is available
Monday through Friday from 8:30am to 5pm Eastern Time. Give
us a call at 727-803-8600.


http://www.zoomtext.com/documentation
http://www.zoomtext.com/help
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Using ZoomText Help

You can open ZoomText Help at any time when you are running
ZoomText.

= To open the ZoomText Help System
From the ZoomText toolbar, do one of the following:

e Press the F1 key.

¢ In the ZoomText menu, choose Help and Learning > ZoomText
Help.

e Inside of a ZoomText dialog boxes, click the Help button that
appears in the lower-right corner of the dialog. This action opens a
help topic about that dialog and feature.

The ZoomText Help system appears.
= To use the ZoomText Help System

In the Help window, click one of the following tabs:
e Contents. Allows you to choose a topic from a section of the
online Help.
e Index. Allows you to use the index to find a topic.
e Search. Allows you to find a topic by searching for a particular

word or phrase in the online Help.

Note: Each ZoomText dialog box also contains a Help button that,
when selected, displays context-sensitive Help for that dialog.
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Using the Toolbar Tooltips
You can enable and disable the toolbar tooltips as needed.

= To enable and disable the Toolbar Tooltips

1. From the ZoomText toolbar, choose ZoomText > Preferences
> User Interface.

The Preferences dialog appears with the User Interface tab displayed.

2. Check or uncheck Display tooltips for the ribbon controls.
3. Click OK.
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Windows Logon and Secure Mode Support

ZoomText Secure Mode provides essential magnification and screen
reading features in the Windows logon prompt and other Windows
secure mode prompts. The ZoomText Secure Mode toolbar allows you
to zoom in and out, invert the screen colors, and enable the voice to
announce each control and action you perform in the secure mode
prompts.

ZoomText Secure Mode is enabled by choosing Enable ZoomText in the
Windows logon prompt in ZoomText's Program Preferences dialog box.
See Enabling and Disabling ZoomText in the Windows Logon Prompt

below.

The ZoomText Secure Mode Toolbar

When ZoomText's logon support is enabled, the ZoomText Secure Mode
toolbar will appear whenever the Windows logon prompt or a secure
mode prompt becomes active. This toolbar provides controls to adjust
the settings that are available in ZoomText Secure Mode.

ZoomText Secure Mode

1 | B

ZoormnTexk Zoorm Level Imverk Vioice

The ZoomText Secure Mode toolbar

e ZoomText button. Enables or disables ZoomText. When
ZoomText is disabled, all magnification and screen reading
features are turned off without exiting the program.

Hotkey: Caps Lock + Ctrl + Enter
e Zoom Level. Sets the magnification level from 1x to 60x.

Hotkey: Caps Lock + Up / Caps Lock + Down
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e Invert. Enables and disables color inverting.
Hotkey: Caps Lock + C

e Voice. Enables and disables the ZoomText voice.
Hotkey: Caps Lock + Alt + Enter

Note: ZoomText Secure Mode settings are automatically saved
and restored each time you exit and enter a Windows secure mode
prompt.
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Enabling and Disabling ZoomText Secure Mode

ZoomText Secure Mode is enabled and disabled in ZoomText's Program
Preferences dialog box.

= To enable and disable ZoomText Secure Mode
1. In the ZoomText menu, choose Preferences > Program.
The Preferences dialog appears with the Program tab displayed.

2. Check or uncheck Enable ZoomText in the Windows logon
prompt.

Note: You must be logged in with administrative privileges to
adjust this option. If you are not logged in with administrative
privileges this option will be grayed out.

3. Select OK.
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Preferences

Pragram Ilzer Interface Smoothing

Logaon Suppork

[ JEnable ZoomTe:xt in the Windows logon prompk:

Skartup Setkings

[]5tart ZoomText automatically when Windows starks
] start ZoomText with the boolbar minimized

Display the "Welcome" window when ZoomText skarks
Display a ZoomText icon on the desktop

Exit Setkings

[ 5ave ZoomText settings automatically when exiting
Prampk to confirm intent to exit ZoomTexk

nload magnification process when exiting ZoomText

Autamatic Updating

Check For anline updates each time ZoomText is launchead

Errar Reparting

[ ]Report ZoomText errors ko Freedom Scientific via the Internet

Cancel Help

The Program tab

Setting Description

Logon Support

Enable ZoomText in the | Enables the ZoomText Secure Mode utility in
Windows logon prompt | the Windows logon prompt and other Windows
secure mode prompts.
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The ZoomText User Interface

The ZoomText user interface provides a variety of ways to operate
ZoomText, including the ZoomText Toolbar, Command Keys, and touch
screen gestures.

The primary way to operate ZoomText is using the ZoomText Toolbar,
which provides complete access to all of ZoomText's features and
settings through toolbar controls, menus and dialogs that are easy to
use. The ZoomText user interface can be fully accessed using the
keyboard, mouse, or touch screen gestures.

You should learn to use at least some of ZoomText's Command Keys,
which will allow you to adjust and operate ZoomText without having to
activate the toolbar and switch away from where you are working. You
don't need to learn and use all of the command keys, but utilizing
command keys for frequently used features will allow you to work
much faster in all of your applications.

If you are using a desktop, laptop or tablet that includes a touch screen,
you can use ZoomText's Touch Screen Support to access the ZoomText
Toolbar, modal tools, and key feature adjustments using standard touch
screen gestures.

e The ZoomText Toolbar

¢ Command Keys

e Touch Screen Support
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The ZoomText Toolbar

When you start ZoomText the ZoomText toolbar appears on the screen.
The ZoomText toolbar contains all of the controls for operating
ZoomText, neatly organized in the "ZoomText" menu and several
toolbar tabs. Each tab provides quick-action buttons for enabling and
adjusting all of ZoomText's core features. Many of these buttons are
split-button controls that allow you to toggle the feature on and off and
open a menu of related settings. The buttons are grouped by category
and have intuitive icons and labels for easy identification.

ZoomText MagnifierfFeader - X

ZoormText bagnifier Feader Tools

: 3 Ak D= T

Zoorm Lewel  Windour Color  Pointer  Cursor  Focus Mavigation
(I e h v e A A
oo Windows E Screen Enhancerments |_'g Mawigation
The ZoomText Toolbar

e ZoomText menu. Displays the ZoomText menu, where you can
toggle ZoomText on and off, open ZoomText Help, save and load
configurations, configure the command keys, use support tools
and more.

e Magnifier toolbar tab. Displays toolbar controls for ZoomText's
magnification features.

e Reader toolbar tab. Displays toolbar controls for ZoomText's
screen reading features.

e Tools toolbar tab. Displays toolbar controls for ZoomText's Finder,

Camera and Listening features.

Note: The Reader toolbar tab only appears when running
ZoomText Magnifier/Reader.
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Operating the ZoomText Toolbar with the Keyboard

The ZoomText toolbar is fully keyboard accessible using standard
Windows navigation commands. For added ease of use, the toolbar can
be fully navigated and operated using only the arrow keys and Enter
key. Using the arrow keys, you can navigate in, out and between the
ZoomText menu, toolbar tabs, toolbar controls and button menus. When
the focus is on a split button, pressing the Enter key will toggle the
teature, while pressing the down arrow will open the attached menu.
When the focus is in the Zoom Level spin box (on the Magnifier toolbar
tab) or the Rate spin box (on the Reader toolbar tab), pressing the Up
and Down keys will adjust the spin box value and pressing the Left and
Right keys will move the focus to the next control. On the Zoom Level
spin box, pressing the Enter key will also toggle the Zoom to 1x feature.

Minimizing and Restoring the Toolbar

The ZoomText toolbar can be minimized (hidden) and restored (made
visible) without affecting the operation of ZoomText.

»= To minimize ZoomText
Do one of the following:

e On the ZoomText title bar, click on the minimize button.

e While the ZoomText toolbar is active, press Esc.
= To restore ZoomText
Do one of the following;:

e Click on the ZoomText button in the task bar.
e Press the Show User Interface hotkey: Caps Lock + Ctrl + U.

Note: If the ZoomText toolbar is already open but covered by
other applications, restoring it will bring it into view.
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Command Keys

ZoomText's Command Keys allow you to adjust and operate ZoomText
without having to activate the toolbar and switch away from where you
are currently working. Using the command keys will allow you to work
faster and more productively in all of your applications.

Types of Command Keys

The Essential Command Keys

The Command Keys Dialog

The Layered Keys Banner

Resolving Hotkey Conflicts
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Types of Command Keys

ZoomText provides two types of command keys, Hotkeys and Layered
Keys.

e Hotkeys are the fastest and recommended way to operate
ZoomText, as they allow you to trigger commands in a single
keyboard action. Hotkeys are performed by holding down one or
more modifier keys and then pressing a primary key. For example,
to toggle ZoomText on and off, you hold down the Caps Lock and
Ctrl keys and then press the Enter key. This hotkey appears as
Caps Lock + Ctrl + Enter in the ZoomText user interface and
documentation. Hotkeys for other ZoomText commands appear in
this same format.

Note: Some applications may have hotkeys that use the same
combination of keys as ZoomText hotkeys. When this occurs
ZoomText will process the hotkey without passing it through for
processing by the application. To work around this problem, see
Resolving Hotkey Conflicts.

e Layered Keys are not as fast to perform as hotkeys, but have the
advantage of never conflicting with other applications and being
easier to perform if you have limited hand dexterity. Layered keys
are performed by pressing a sequence of keys that (1) enters the
Layered Key Mode, (2) selects a command group, and (3) triggers
the desired command. For example to toggle ZoomText on or off
with layered keys, you would (1) press Caps Lock + Spacebar to
enter the layered key mode, (2) press P to enter the Program
group, and (3) press Enter to toggle ZoomText on or off. This
layered key sequence appears as Caps Lock + Space, P, Enter in
the user interface and documentation. Layered keys for other
ZoomText commands appear in this same format.
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Note: Because use of hotkeys is recommended over using layered
keys, in the ZoomText documentation the layered keys only
appear in feature topics where the feature does not have
equivalent hotkeys. To see a full list of the available layered keys,
open the ZoomText Command Keys dialog box or see list of
command key tables in the ZoomText Commands section.

Tip! For each ZoomText command, the hotkey and layered key
use the same key to complete the command, which makes learning
both commands intuitive.

Tip! If you are running ZoomText Magnifier/Reader, while you
are in any level of the Layered Key Mode, you can type a question
mark to hear a list of the commands that are available in the
current level. You can also press the F1 key to exit the layered
mode and open the help system to the list of commands for the
current level.
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The Essential ZoomText Hotkeys

To use ZoomText in your applications, it is helpful to learn and use the
essential hotkeys. These hotkeys will allow you to adjust and operate the most
commonly used features and settings without having to switch away from
your application.

Note: Commands specific to each feature and setting are located in the topics
throughout the ZoomText documentation. You will also find a complete list of
commands hotkeys in the ZoomText Commands section and in the Command
Key dialog box.

Essential Commands \ Hotkeys

Global ZoomText Commands

Start ZoomText Ctrl + Alt + Shift+ Z
Toggle ZoomText On / Off Caps Lock + Ctrl + Enter
ZoomText User Interface Caps Lock + Ctrl + U

Magnifier Commands

Zoom In Caps Lock + Up

Zoom Out Caps Lock + Down

Zoom to 1x (toggle) Caps Lock + Enter

Scroll Up Caps Lock + Shift + Up
Scroll Down Caps Lock + Shift + Down
Scroll Left Caps Lock + Shift + Left
Scroll Right Caps Lock + Shift + Right

Enhancement Color Caps Lock + C
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Reader Commands (ZoomText Magnifier/Reader only)

Voice On / Off Caps Lock + Alt + Enter
Voice Rate Faster Caps Lock + Alt + Up

Voice Rate Slower Caps Lock + Alt + Down
Verbosity (program echo) Caps Lock + Alt + B

Echo Keyboard Mode Caps Lock + Alt+ K

Launch AppReader from Caps Lock + Alt + Left-Click
Pointer

Launch App View Caps Lock + Alt+ A

Launch Text View Caps Lock + Alt+ T

Launch SpeaklIt Tool Caps Lock + Alt+S
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The Command Keys Dialog

The ZoomText Command Keys dialog box displays a list of all
ZoomText commands and allows you to customize the hotkey for each
command. You can quickly find any command or group of commands
by typing the name, keys or status in the Search box. You can also
reassign, unassign and enable/disable hotkeys according to your needs
as described in the instructions below. You can sort the list
alphabetically by clicking on any column in the list.

Note: Access keys have fixed key assignments that cannot be reassigned.

= To open the ZoomText Command Keys dialog box

e On the ZoomText toolbar choose ZoomText > Command Keys.

The ZoomText Command Keys dialog appears.

ZoomText Cormmand Keys

Search: Twpe the name of the command or kews you are searching For.

ZoomText Command Keys;

Command Layvered Kev Hotkey Hotkey Status o)
AppReader: Launch App Yiew .68 Caps Lock + Alt + A& Enabled
AppReader: Launch AppReader AR Caps Lock + Alt + R Enabled
AppReader: Launch AppReader From Pointer A, Left click Caps Lock + Alc + Left click. Enabled
AppReader: Launch SpeakIt Tool n,3 Caps Lock + Alt + 5 Enabled
AppReader: Launch Text Yiew a,T Caps Lock + Alt + T Enabled
Lavered Keys: AppReader Commands A none Unassigned
Lavered Keys: Command Made Selection Caps Lock + SpaceBar Enabled
Lavered Kevs: Launch Backaround Reader B Caps Lock + Chrl + B Enabled
Layvered Keys: Launch Camera [ Caps Lock + Chel + Enabled
Lavered Keys: Launch Finder F Caps Lock + Ckrl+ F Enabled
Lavered Kewvs: Launch Recorder [n] Caps Lack + Chrl + D Enabled
Layvered Keys: Magnifier Commands 1 none Unassigned ™
Command:  Launch App Yiew
Description:  Launches the AppReader in App Yiew.
Assign Haotkey.., Disable Selected Hotkeys
Import Hotkeys. ., Reset Selected Hotkeys
Assign Configurakion Eile, .. Banner Settings. .. Cancel Help

The ZoomText Command Keys dialog box.
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Description

Search Allows you to search and filter the list of commands by
typing the command name, keys or status you are
looking for.

ZoomText Displays a complete or filtered list of the ZoomText

Command Keys

command keys. You can sort the list alphabetically by
any column by clicking on the column title.

Assign Hotkey

Opens the Assign Key dialog box where you can assign
(or reassign) the key combination for a command’s
hotkey.

Import Hotkeys

Opens the Import Hotkeys dialog box where you can
browse to and select a ZoomText configuration file from
which to import hotkey assignments.

Assign
Configuration File

Opens the Assign Configuration dialog box where you
can browse and select an existing ZoomText
configuration file to assign to the selected Load
Configuration command.

Note: The Assign Configuration File button is only
enabled when a Load Configuration command is
selected.

Enable Selected Enables the hotkey for any commands that are currently

Hotkeys selected and disabled in the ZoomText Command Keys
list.

Reset Selected Resets the hotkey to the factory default for any

Hotkeys commands that are currently selected in the ZoomText

Command Keys list.

Banner Settings

Opens the Layered Keys Banner Settings dialog, where
you can enable and disable the banner and configure the

appearance and sound cues for the banner.
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Viewing and Managing Command Keys
= To search, filter and sort the list of commands

1. Click in the Search box or press the Tab key to move the keyboard
focus to the Search box.

2. Type the command name, keys or status you are looking for and
press the Enter key.

3. Click on the column titles to sort the list as desired.
= To enable or disable hotkeys for one or more commands

1. Select the commands you want to enable or disable.

2. Click the Enable Selected Hotkeys button, or the Disable
Selected Hotkeys button.

= To reset hotkeys for one or more commands (to the factory
default assignments)

1. Select the commands that you want to reset.

2. Click the Reset Selected Hotkeys button.
= To assign a new key combination to a hotkey

1. Select the command that you want to assign a new or different
hotkey.

2. Select the Assign Hotkey button.
The Assign Key dialog box appears.
3. Select the desired modifier keys and primary key.

If the selected combination of keys is already in use by another
command, a "KEY CONFLICT!" warning will appear with options to
disable the hotkey or save the hotkey and reassign the conflicting
hotkey.

4. Click OK.
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= To import hotkeys from another configuration file

1.

2.

3.
= To assign a configuration file to a Load Configuration command

1.
2.

Select the Import Hotkeys button.

The Import Hotkeys dialog box appears and displays a list of
ZoomText hotkey configuration files.

Select a configuration file from the displayed list or browse to a
different folder to select the desired configuration file.

Click OK.

Select the desired ZoomText: Load Configuration command.

Select the Assign Configuration File button.

The Assign Configuration File dialog box appears. The current
assignment to the Load Configuration command is displayed.

Select the Browse and Select a Configuration File button.

The Select Configuration dialog box appears and displays a list of
ZoomText configuration files.

Select a configuration file from the displayed list or browse to a
different folder to select the desired configuration file.

Click OK.
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Layered Keys Banner

When you enter the Layered Keys Mode, a banner can be displayed to
let you know that the mode is active and which layered mode you are
currently in. You can adjust the appearance of the banner in the Layered
Keys Banner Settings dialog box. You can enable and disable the banner
and select the size, color and location where the banner will appear.
Sound cues are also available to provide audible indication that the
layered key mode is active. You can enable and disable the sound cues
and select the style and volume level for the sound cue.

= To open the Layered Keys Banner Settings dialog box

1. On the ZoomText toolbar choose ZoomText > Command Keys.
The ZoomText Command Keys dialog appears.

2. Select the Banner Settings button.
The Layered Keys Banner Settings dialog appears.

3. Adjust the banner settings as desired.

4. Click OK.

Layered Keys Banner Settings X

Display the layered keys banner fuwhen the layered keys are enabled)

Banner size: hedium L
Banner calar; Black L
Banner |ocation: Top of Screen w

scroll banner text that is wider than the screen
[ ] Play the layered keys sound cues fwhen the layered keys are enabled)
Ilze these sounds: Sound et 4

Zound cue wolume:  BMedium Wolume

| Ok || Cancel || Help

The Layered Keys Banner Settings dialog box.
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Setting Description

Display the layered keys
banner (when the layered
keys are enabled)

Displays a banner showing the current layered
key mode at the top or bottom of the screen
when the feature key mode is active. The banner
provides visual indication that the mode is
active.

Banner size:

Selects the size of the layered keys banner.

Banner color:

Selects the color of the layered keys banner.

Banner location:

Selects the location of the layered keys banner,
which can be located at the top or bottom edge
of the screen.

Scroll banner text that is
wider than the screen

When the text displayed in the banner is wider
than the screen, the text will scroll side to side so
that the full text can be read.

Play the layered key sound
cues (when the layered
keys are enabled)

Plays a sound cue when the layered key banner
is active. The sound cue provides audible
indication that the mode is active.

Use these sounds:

Selects the style of sound cue that will be
played.

Sound cue volume:

Selects the volume level for the sound cue.
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Resolving Hotkey Conflicts

There may be situations where a ZoomText hotkey uses the same key
combination as a hotkey in another application, creating what is known
as a "hotkey conflict". When this occurs, ZoomText receives and
processes the command and your other application does not. You can
work around or resolve this problem using the following methods:

Method 1: Use the Pass Next Hotkey command

e Prior to pressing the conflicting command that you want your
application to receive and process, execute the Pass Next Hotkey
command using the hotkey or layered keys:

e Hotkey: Ctrl + Alt + Shift + P
e Layered Keys: Caps Lock + Spacebar, U, P
ZoomText will pass the next hotkey through to the active application.

Method 2: Use the ZoomText layered keys instead of the hotkey

ZoomText’s Layered Keys are modal and therefore are free of
conflicts with other applications.

Method 3: Reassign or disable the hotkey in ZoomText

e Follow the instructions provided in The Command Keys Dialog.
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Touch Screen Support

ZoomText can be used on Windows 10 and Windows 8.1 touch screen
devices including tablets, laptops and desktop monitors. This means
that you can operate ZoomText’s complete feature set and your
applications using touch screen gestures; that is, taps and swipes you
perform with one or more fingers. ZoomText will not interfere with
gestures targeted at your applications, but will respond to gestures the
same way it responds to events produced when using the keyboard and
mouse. You can also access ZoomText’s user interface (toolbars, menus
and dialogs) using the same standard gestures that you are used to from
other applications.

To learn how to operate Windows and your applications with touch
screen gestures, see the Windows Help system, or search the Microsoft
Windows website for articles on using touch screen devices and
gestures in Windows.

Note: You must have a Windows device that supports at least five
simultaneous touch points. These devices will display the "Designed for
Windows" logo.

e Using ZoomText on a Touch Screen

e Using the ZoomText Touch Icon

e Accessing ZoomText Features with Touch Gestures
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Using ZoomText on a Touch Screen

There are a few important concepts, behaviors and techniques to keep in
mind when using ZoomText on a touch screen display:

e Many applications provide zooming and panning of the
documents they display. A screen magnifier will add a second
layer of zooming and panning on top of this, which can become
disorienting if both the application and the screen magnifier are
zooming at the same time. To avoid this disorienting experience, it
is recommended that you just use one layer of zooming at a time.

e Using a standalone touch screen device requires the use of an on-
screen keyboard. When using ZoomText with a magnified view
the on-screen keyboard will not be fully visible, so you will have
to pan the magnified view to access all of the keys. This will slow
down your typing speed as well as productivity. Therefore, we
recommend connecting a physical keyboard when you need to
perform large amounts of typing.
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Using the ZoomText Touch Icon

ZoomText provides a special ZoomText Touch Icon that allows you to
instantly access key ZoomText features using touch gestures. These
features include zooming in and out, scrolling the magnified view and
using ZoomText’s AppReader and Speaklt tools. Here’s how it works...

By default, when you install ZoomText on a touch screen device, the
ZoomText Touch Icon will appear on one edge of the screen. This
floating icon remains visible even when you zoom in and out or scroll
the magnified view. You can move the icon to several anchor points
along the edges of your screen. This lets you position the icon where
you want it and move it if it is covering an item you need to see.

Note: Use of the ZoomText Touch Icon and associated gestures requires
a 5-point (or greater) multi-touch display.

The ZoomText Touch Icon has two modes of operation: Windows Touch
Mode and ZoomText Touch Mode.

e Windows Touch Mode passes all touch gestures to Windows and
applications that are open on the screen, just as if ZoomText was
not running on the system. This is the mode you need to be in
when you want to interact with your desktop or applications
using touch gestures, including the ZoomText toolbar. When
Windows Touch Mode is active, the icon appears as a group of
Windows 8.1 Start Screen tiles with a pointing finger at the
bottom.

=0
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e ZoomText Touch Mode passes all touch gestures to ZoomText.
This is the mode you need to be in when you want to access the
ZoomText features that are supported by gestures. When in
ZoomText Touch Mode, the icon appears as a ZoomText logo with
a pointing finger at the bottom. This icon will also pulse to let you
know that ZoomText Touch Mode is active.

Enabling and Operating the ZoomText Touch Icon

In this section you will learn how to enable and operate the ZoomText
Touch Icon.

= To enable and disable the Touch Icon

In the ZoomText menu, choose Touch Screen Support > Enable
Touch Icon.

When enabled, the Touch Icon appears on one edge of the screen. When
disabled, the icon is hidden. Note: The Touch Icon is also hidden when
ZoomText is disabled.

= To adjust the size of the Touch Icon

In the ZoomText menu, choose Touch Screen Support > Touch Icon
Size {size}.

The Touch Icon resizes according to the selected size.
= To select a color scheme for the Touch Icon

In the ZoomText menu, choose Touch Screen Support > Touch Icon
Color {color}.

The Touch Icon changes to the selected color.



= To move the Touch Icon around the screen

Press and hold one finger on the icon and drag it to a desired location
anywhere along the edge of the screen.

When you remove your finger from the icon, the icon will
automatically snap to the nearest anchor point.

= To switch between Windows Touch Mode and ZoomText Touch
Mode

Double-tap the Touch Icon with one finger.

When in Windows Touch Mode, the icon appears as a group of
Windows 8.1 Start Screen tiles. When in ZoomText Touch Mode, the
icon appears as a ZoomText logo.

Tip! You can momentarily switch touch modes by holding one finger on
the touch icon. When you move your finger off of the icon, the
previously active touch mode is automatically restored. This means that
when Windows Touch Mode is active, you can momentarily switch to
ZoomText Touch Mode to pass a gesture to ZoomText, automatically
returning to Windows Touch Mode when you move your finger off of
the icon. Conversely, when in ZoomText Touch Mode, you can
momentarily switch to Windows Touch Mode to pass a gesture to an
application, automatically returning to ZoomText Touch Mode when
you move your finger off of the icon.



Chapter 4—The ZoomText User Interface 55

Accessing ZoomText Features with Touch
Gestures

In this section you will learn how to use the ZoomText Touch Icon and
gestures to access and operate key ZoomText features. Remember that
the Touch Icon must be in ZoomText Touch Mode when performing
these gestures.

= To display the ZoomText user interface
Double-tap with four fingers.
= To adjust the magnification level (zoom in and out)

Double-tap and hold three fingers, then drag up to zoom in and drag
down to zoom out.

= To pan the magnified view
Drag three fingers to move around the screen.
= To adjust the size and location of a zoom window

1. On the Magnifier toolbar tab, choose Window > Zoom Windows
Adjust Tool.

The Adjust tool becomes active and sizing handles appear on the zoom
window frame.

2. To resize the window, hold one finger on a sizing handle and drag
it until it’s the size you prefer.

3. To move the window, hold one finger inside the zoom window
and drag it around.

4. To exit the Adjust tool, double-tap with three fingers.
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= To use View Mode
1. Double-tap with three fingers.
Magnification is temporarily turned off and the view locator appears.

2. To move the view port, hold one finger inside the view port and
drag it to the desired location.

3. To exit View Mode and be moved to the new viewport location,
double-tap with one finger.

4. To exit View Mode and move to the previous viewport location,
double-tap with three fingers.

= To use the SpeaklIt Tool
1. On the Reader toolbar tab, choose SpeaklLt.

The Speaklt tool becomes active and sizing handles appear on the zoom
window frame.

2. To speak a single word, tap on the word.

3. To speak a block of words, drag diagonally with one finger to
highlight the words you want to have spoken. When you complete
the drag, all highlighted text will be spoken.

4. To exit the Speaklt tool, double-tap with three fingers.
= To use AppReader

1. Open the document, web page or email that you wish to read.
2. Start AppReader using one of the following two methods:
e To start reading at any word: Double-tap with one finger on
the word where you want to start reading.
e To start reading from the location of the text cursor, double-

tap with two fingers.

AppReader begins reading.
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. To start and stop reading or navigate/read by word, line, sentence
and paragraph, use the AppReader Reading Gestures listed in the
table below.

. To speak a block of words, drag diagonally with one finger to
highlight the words you want to have spoken.

When you complete the drag, all highlighted text will be spoken
. To exit AppReader, double-tap with three fingers.

When AppReader exits, the cursor is automatically positioned at the
last word that was highlighted in AppReader (if a cursor exists in the
application).
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AppReader Reading Gestures

Command Gesture

Toggle Reading 2-finger single-tap
(Play/Pause)

Read from new location 1-finger single-tap.
Say Next Word 1-finger swipe right
Say Previous Word 1-finger swipe left
Say Current Word 1-finger double-tap

Note: Repeating this gesture on the same word
within two seconds or less will cycle through
the following options: say/spell/military spell.
Resets after a lapse of more than two seconds.

Say Word Below 1-finger swipe down
Say Word Above 1-finger swipe up
Say Next Sentence 2-finger swipe right
Say Previous Sentence 2-finger swipe left
Say Next Paragraph 2-finger swipe down
Say Previous Paragraph 2-finger swipe up
End of Document 4-finger swipe down

Beginning of Document 4-finger swipe up




Chapter 5
Magnifier Features

"Magnifier Features" represent all of the visual enhancements that are
available in ZoomText Magnifier and ZoomText Magnifier/Reader.
These features include selection of the zoom level, zoom window types,
screen enhancements, and navigation options.

e The Magnifier Toolbar Tab

e Zooming In and Out

e Using Zoom to 1x

e Scrolling the Magnified View

e Zoom Windows

e Screen Enhancements

e Navigation Settings
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The Magnifier Toolbar Tab

The Magnifier toolbar tab provides quick-action buttons for enabling
and adjusting all of ZoomText's Magnifier features. Many of these
buttons are split-button controls that allow you to toggle the feature on
and off and open a menu of related settings. The buttons are grouped by
category and have intuitive icons and labels for easy identification.

ZoornText MagnifierfReader - X

ZoomText hagnifier Feader Tools

: 3 Ak D=

Zoom Level Window Color  Pointer  Cursor Focus Mavigation
I e A v e A A
oo Windows E Screen Enhancerments |_'g Mawigation

The Magnifier toolbar tab

e Zoom Level. Sets the magnification level from 1x to 60x.

e Window. Selects the zoom window type for the magnified view.
The types of zoom windows that are available depend on whether
you are running your system with one monitor or multiple
monitors that are set to "Extend these displays".

e Color. Toggles the color enhancements on and off, and displays a
menu of color enhancement settings. Color enhancements improve
screen clarity for easier viewing and reduced eyestrain. You can
choose from a variety of preset color schemes or configure your
own custom color settings.

e Pointer. Toggles the pointer enhancements on and off, and selects
mouse pointer enhancement settings. Pointer enhancements make
it easy to locate and follow the mouse pointer. You can choose
from a variety of preset pointer enhancement schemes or
configure your own custom pointer enhancements.
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e Cursor. Toggles the cursor enhancements on and off, and selects
cursor enhancement settings. Cursor enhancements make it easy
to locate and follow the text cursor. You can choose from a variety
of preset cursor enhancement schemes or configure your own
custom cursor enhancements.

e Focus. Toggles the focus enhancements on and off, and selects
focus enhancement settings. Focus enhancements make it easy to
locate and follow the control focus when you tab and arrow key
through menus, dialogs and other application controls. You can
choose from a variety of preset focus enhancement schemes or
configure your own custom focus enhancements.

e Navigation. Displays a menu that opens the Navigation Settings
dialog where you can adjust how ZoomText will scroll the zoom
window to keep moving objects in view, including the mouse
pointer, text cursor, keyboard focus and other objects that appear
and move about the screen.
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Zooming In and Out

ZoomText provides a wide range of zoom levels allowing you to adjust
the magnified view according to your needs. Zoom levels include:

1x to 8x in steps of 1

10x to 16x in steps of 2

20x to 36x in steps of 4

42x to 60x in steps of 6

Fractional powers of 1.2x, 1.4x, 1.6x, 1.8x, 2.5x, 3.5x and 4.5x.

You can zoom in and out at any time using the Zoom In and Zoom Out
hotkeys, Mouse Wheel Zooming, or the Zoom Level spin box on the
Magnifier toolbar tab.

Note: When using multiple monitors with the zoom window type set to
MultiView Local or MultiView Global, each view (on each display) has
its own zoom level. The zoom level commands and controls always
adjust and reflect the zoom level for the active view. You can force the
active and inactive views to zoom in and out together by enabling Keep
views at the same magnification level in the Multiple Monitor Options
dialog box.

= To zoom in and out using hotkeys

e Press the Zoom In and Zoom Out hotkeys:
o To Zoom In, press Caps Lock + Up

o To Zoom Out, press Caps Lock + Down
= To zoom in and out using mouse wheel zooming

e Hold down Caps Lock + Shift and roll the mouse wheel to zoom
in and out.
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= To zoom in and out using the Zoom Level spin box

e On the Magnifier toolbar tab, adjust the level in the Zoom Level

spin box by clicking the up and down button or by pressing the
Up and Down keys (when the spin box has focus).

Choosing a Set of Zoom Levels

ZoomText provides three sets of zoom levels for zooming in and out.
You can zoom in and out using All Zoom Levels, Favorite Zoom Levels
Only or Whole Power Levels Only.

e All Zoom Levels uses the complete set of zoom levels for zooming

in and out. This is the default mode.

Favorite Zoom Levels uses a custom set of user-defined zoom
levels for zooming in and out. You can choose any combination of
zoom levels to define your favorite zoom levels.

Whole Power Levels excludes all of the fractional powers when
zooming in and out.

= To choose a set of zoom levels and customize the Favorite
Zoom Levels

1.

On the Magnifier toolbar tab, select the Zoom Windows button,
which appears in the lower-right corner of the Zoom Windows

group.
The Zoom Windows Settings dialog appears.

Select the Magnification tab.

In the Use these zoom levels combo box, choose the set of zoom
levels that you want to use.

If you selected Favorite Zoom Levels Only, go to the Favorite
Zoom Levels list box and check the zoom levels that you want to
use and uncheck the zoom levels you do not want to use.

Click OK.
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Zoom Window Settings
M agnification window Freeze Wiew Locator
Zoom Levels
Current Zoom Level Ize these zoom levels

n : all Zoom Levels w

Favarite Zoom Levels

] Favorite Zoom Levels allow vou bo zoom in

1.2 L] -

(1.4 and out using only the levels vou choose, To
' enable this option, choose 'Favorite Zoom

1.6 Lewels'in the 'Use these zoom levels' combo

1.8 b, then select the desired levels in the

2z 'Favarite Zoom Levels' lisk box,

[1z.z25

2.5

[1z.75 v

Mause Wheel Zooming

Modifier Keys
shift

[k
[kl
Zaps Lock,

Enable mouse wheel zooming

Cancel Help

The Magnification tab

Setting Description

Zoom Levels

Current Zoom Level Sets the magnification level. Magnification
levels include: 1x to 8x in steps of 1, 10x to 16x in
steps of 2, 20x to 36x in steps of 4, 42x to 60x in
steps of 6, and fractional powers of 1.2x, 1.4x,
1.6x, 1.8x, 2.5x, 3.5x and 4.5x.

Use these zoom levels Selects the set of magnification levels that
ZoomText will use for zooming in and out.
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Favorite zoom levels A list of checkboxes for selecting the favorite

zoom levels. The change these selections you
must choose Favorite Zoom Levels Only in the
Use these zoom levels combo box.

Customizing Mouse Wheel Zooming

Many applications use the mouse wheel to scroll documents and
perform other actions. ZoomText combines modifier keys with the

mouse wheel to avoid interfering with these applications. By default,
ZoomText's Mouse Wheel Zooming uses Caps Lock + Shift for the
modifiers. If necessary you can choose a different combination of

modifiers or disable mouse wheel zooming altogether.

= To configure mouse wheel zooming

1.

On the Magnifier toolbar tab, select the Zoom Windows button,
which appears in the lower-right corner of the Zoom Windows

group.
The Zoom Windows Settings dialog appears.
Select the Magnification tab.
Make sure the Enable wheel zooming box is checked

Select the modifier key (or keys) that must be pressed in order for
the mouse wheel to be used for zooming.

Click OK.
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Zoom Window Settings
M agnification window Freeze Wiew Locator
Zoom Levels
Current Zoom Level Ize these zoom levels

n : all Zoom Levels w

Favarite Zoom Levels

] Favorite Zoom Levels allow vou bo zoom in

1.2 L] -

(1.4 and out using only the levels vou choose, To
' enable this option, choose 'Favorite Zoom

1.6 Lewels'in the 'Use these zoom levels' combo

1.8 b, then select the desired levels in the

2z 'Favarite Zoom Levels' lisk box,

[1z.z25

2.5

[1z.75 v

Mause Wheel Zooming

Modifier Keys
shift

[k
[kl
Zaps Lock,

Enable mouse wheel zooming

Cancel Help

The Magnification tab

Setting Description

Mouse Wheel Zooming

Enable wheel zooming | Enables use of the mouse wheel to change the
magnification level.

Modifier Keys Selects the key combination to be used for mouse
wheel zooming. The selected keys must be held
down while rotating the mouse wheel in order to
change the magnification level.




Chapter 5—Magnifier Features 67

Using Zoom to 1x

Zoom to 1x feature lets you instantly switch between zoomed and 1x
views, without having to zoom out and zoom back in one zoom level at
a time. When you Zoom to 1x, all of ZoomText's other magnifier and
reader features remain active, so you can still use ZoomText's other
features even while the screen is unmagnified.

= To use Zoom to 1x
Do one of the following;:

e Press the Zoom to 1x hotkey: Caps Lock + Enter

e On the Magnifier toolbar tab, click the Zoom to 1x button beneath
the Zoom Level spin box, or navigate to the Zoom Level spin box
and press Enter.

With each press of the hotkey toggles between the current zoom level
and 1x.

g

The Zoom to 1x button

Note: When you Zoom to 1x you can also use the Zoom In
commands and controls to zoom back in.
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Scrolling the Magnified View

ZoomText's magnified views automatically scroll to follow movement of

the mouse, text cursor and application focus. You can also use the Scroll

Commands to scroll in any direction and to any area of the screen. The

smooth scrolling behavior of the Scroll Commands is particularly
helpful when you want to scroll and read at the same time. The Scroll
Commands also allow you to jump instantly to any edge, jump to the
center of the screen, and save and restore a view of any location on the

screen.

= To scroll the zoom window

While holding down the Caps Lock + Shift keys:

1.

Press the arrow key that corresponds to the desired scroll
direction: Left, Right. Up or Down.

To increase the scrolling speed, press the same arrow key. Each
press will increase the speed.

To decrease the scrolling speed, press the opposite arrow key.
Each press will decrease the speed until scrolling stops.

To scroll in a different direction, press the arrow key that
corresponds to the new direction.

To stop scrolling, press Enter or release the Caps Lock + Shift
keys.

= To jump to an edge or the center of the screen

While holding down the Caps Lock + Ctrl keys:

e Press the arrow key that corresponds to the desired edge: Left,

Right. Up or Down.

e Press Home to jump to the center of the screen.



Chapter 5—Magnifier Features 69

= To save and restore a specific view of the screen

The current view can be saved and then restored at a later time using
the following hotkeys:

e To save the view, press Caps Lock + Ctrl + Page Down

e To restore the view, press Caps Lock + Ctrl + Page Up
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Zoom Windows

A zoom window displays a magnified view of the computer screen. You

can think of a zoom window as a magnifying glass held in front of the
screen. A zoom window can only display a portion of the screen at any
one time, but by scrolling the magnified contents, any area of the screen

can be viewed. The magnified view automatically tracks and scrolls to
follow all on-screen activity, including movement of the mouse pointer,
text cursor, and the keyboard focus.

Running with One or Multiple Monitors

Selecting a Zoom Window

Adjusting Zoom Windows

Freeze View

Overview Mode

Managing Multiple Monitors
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Running with One Monitor or Multiple Monitors

When your system is running with one monitor, or with two monitors
set to "Duplicate these displays", you can set the magnified view to any
of the following zoom window types: Full, Overlay, Lens, Line and four
Docked positions; Top, Bottom, Left and Right.

When your system is running with multiple monitors set to "Extend
these displays", you can set the magnified view to any of the following
zoom window types: Span, Clone, Zoom with 1x, MultiView Local and
MultiView Global.
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Selecting Zoom Windows

You can select a different zoom window at any time while ZoomText is
active. The types of zoom windows that are available depend on
whether your system is configured with one monitor or multiple
monitors that are configured with extended desktops.

Note: This section provides descriptions and instructions for using the
multiple monitor zoom windows types and options. For additional
information on using ZoomText’s multiple monitor support, including
supported hardware, recommended configurations and
troubleshooting, see Managing Multiple Monitors.

= To select a z-oom window

1. On the Magnifier toolbar tab, select the Window button.

2. Select One Monitor or Multiple Monitors according to your
current monitor configuration.

3. Select the desired zoom window type.

The magnified view on your monitors will change according to the
selected zoom window type.

Tip! You can also cycle through the available zoom window types by
pressing the Zoom Window Type hotkey: Caps Lock + Z

A zoom window type can also be selected in the Zoom Windows dialog,
as follow:

1. On the Magnifier toolbar tab, select Window > Settings.
The Zoom Windows dialog appears with the Window tab displayed.

2. Select the desired zoom window type.

3. Click OK.
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Zoom Window Sethi
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The Window tab (when using one monitor)
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Zoom Windo
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The Window tab (when using multiple monitors)
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\ Description

Settings for one monitor (or a single active display)

Window type Selects the zoom window type when using one monitor
or a single display duplicated across multiple monitors.

Full. Displays a zoom window that occupies the entire
screen.

Overlay. Displays a zoom window that lies on top of the
normal screen and can be sized and moved to occupy
any area.

Lens. Displays a zoom window that moves over the
normal screen like a magnifying glass, displaying what
is directly beneath it. The lens automatically follows as
you move the mouse pointer, type text and navigate
through your programs.

Line. Displays a zoom window that moves up and
down the screen like a magnitying ruler, displaying
what is directly beneath it. The line automatically
follows as you move the mouse pointer, type text and
navigate through your programs.

Docked. Splits the screen in half, displaying a magnified
'docked' view on one side and a normal (unmagnified)
view on the other. The magnified view can be docked
against any edge of the screen: top, bottom, left, or right.

For information on adjusting zoom windows, see
Adjusting a Zoom Window.

Set window As the text cursor moves through larger or smaller text,
height to cursor | the height of the Line window increases or decreases, so
height that only the current line of text is displayed.
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Settings for multiple monitors (with extended displays)

Window type: Selects the zoom window type when using multiple
monitors that are configured with extended displays.

Lens. Displays a zoom window that moves over the
normal screen like a magnifying glass, displaying what
is directly beneath it. The lens automatically follows as
you move the mouse pointer, type text and navigate
through your programs. When using multiple monitors
the Lens will move from one monitor to another to
another to follow the mouse pointer, text cursor and all
other on-screen activity that is being tracked.

Span. Displays a single contiguous magnified view that
spans across all of your monitors. The magnified view
tracks and scrolls to follow activity across the entire
extended display.

Span view is designed for users that want to use two monitors
to create one larger magnified view.

Clone. Displays the same magnified view on two or
more monitors. The magnified view tracks and scrolls to
follow activity across the entire extended display. Note:
Clone view is only available when the displays are set to
the same screen resolution and to the same orientation;
Portrait or Landscape.

Clone view is designed for situations where two or more users
need to see the same magnified view on separate monitors.

Zoom with 1x. Displays a magnified view on your main
display and a non-magnified (1x) view on your
secondary display. Both views (magnified and 1x) track
and scroll to follow activity across the entire extended
display.
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Note: When using multiple monitors configured with
extended displays, Windows designates one of the
display devices as the "main display"”, which is where
the desktop icons, taskbar with Windows menu, and
Task Switcher appear. You can select which display is
your main display in the Screen Resolution dialog box,
which can be accessed by right-clicking any empty area
of your desktop and then clicking Screen resolution.

Zoom with 1x view is designed for users that want to see both
a magnified view and a normal (bird’s-eye) view of their
workspace. Zoom with 1x is also ideal for situations where a
low-vision user and normal-sighted user are working together
on the same system. The low-vision user sees the magnified
view while the normal-sighted user sees the unmagnified view.

MultiView Local. Displays separate magnified views on
each monitor, with each monitor’s view limited to its
own desktop area. In other words, monitor 1 will only
show desktop 1 and monitor 2 will only show desktop 2,
and so on.

When using MultiView Local:

¢ Only one magnified view is active and moving at a
time.

e When the mouse pointer or application focus move
from one desktop to another, the active view
automatically switches monitors to follow along.
You can switch the active view at any time by
pressing the Active View hotkey: Caps Lock + V.
When you hold down the Active View hotkey the
magnified views will lock in place. In this locked
state you can move the mouse pointer and any
objects that you are dragging with the mouse from
the magnified view on one monitor directly into the
magnified view on another monitor.
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e By default, each view has its own magnification
level, which is adjustable only when the view is
active. The Zoom In and Zoom Out hotkeys, mouse
wheel zooming and Power controls always reflect
and adjust the magnification level in the active view.
You can force the active and inactive views to zoom
in and out together by enabling "Keep views at the
same magnification level" in the Multiple Monitor
Options dialog box.

MultiView Local is designed for users that want separate
magnified views of each desktop, with each view constrained
so that it never scrolls outside of its own desktop.

MultiView Global. Displays separate magnified views
on each monitor, with each monitor’s view able to scroll
and track activity across all desktop areas. In other
words, each monitor’s magnified view can show its own
desktop as well as the other monitor’s desktop.

When using MultiView Global:

¢ Only one magnified view is active and moving at a
time and that active view scrolls from one desktop to
another to follow the mouse pointer and application
focus. To switch the active view, press the Active
View hotkey: Caps Lock + V. When you hold down
the Active View hotkey the magnified views will
lock in place. In this locked state you can move the
mouse pointer and any objects that you are dragging
with the mouse from the magnified view on one
monitor directly into the magnified view on another
monitor.

e By default, each view has its own magnification
level, which is adjustable only when the view is
active. The Zoom In and Zoom Out hotkeys, mouse
wheel zooming and Power controls always reflect
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and adjust the magnification level in the active view.
You can force the active and inactive views to zoom
in and out together by enabling "Keep views at the
same magnification level" in the Multiple Monitor
Options dialog box.

MultiView Global is designed for users that want to view two
locations within the same application window or desktop.

Multiple Opens the Multiple Monitor Options dialog box, where
Monitor you can select and configure options for ZoomText's
Options multiple monitor views.

Windows Opens the Windows Control Panel to the Display
Display Settings | Settings, where you can adjust the configuration of your

monitors.
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Adjusting Zoom Windows

ZoomText provides a choice of zoom window types that occupy the full

screen or a portion of the screen. Zoom window types that occupy a
portion of the screen include: Overlay, Lens, Line and Docked. When

using a partial-screen zoom window, you can size and/or move the

zoom window to occupy a different portion or location on the screen.

= To size and move a zoom window

1.

6.

On the Magnifier toolbar tab, click the arrow next to Window or
navigate to Window and press the down arrow key.

In the Window menu, choose Zoom Window Adjust Tool.

The Adjust tool becomes active and sizing handles appear on the zoom
window frame.

To size the window, drag any handle.
To move the window, drag inside the window frame.

To scroll the contents of the window, hold down Ctrl, and then
drag inside the window frame.

To exit the Adjust tool, right-click or press Esc.

Note: You can also activate the Zoom Windows Adjust Tool by pressing
the Zoom Windows Adjust Tool hotkey: Caps Lock + A
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Freeze View

In a magnified view, it is impossible to see the entire screen at once. As a
result, you may not be able to view multiple items of interest at the same
time, such as information located at opposite edges of the screen. The
Freeze View solves this problem by allowing you to monitor a selected
area of the screen, while you simultaneously view and work in other
areas of the screen. Here's how it works...

Using the Freeze tool, you select an area of the screen that you want to
monitor. When you've completed your selection, the Freeze View
automatically appears on top of the Full zoom window displaying the
selected area. The Full zoom window continues to operate normally,
tracking all on-screen activity and allowing you to navigate and work in
all areas of the screen.

= To set up a Freeze View

1. Set the zoom window type to Full.

2. On the Magnifier toolbar tab, click the arrow next to Window or
navigate to Window and press the down arrow key.

3. In the Window menu, choose Freeze View > New Freeze View.
The Freeze tool becomes active.
4. Move the mouse pointer until the area you want to freeze is
scrolled into view.
5. Hold down the left button and drag a selection rectangle around

the desired freeze area and release the button.

When you complete the drag, the Freeze View will appear with sizing
handles on the frame.

6. To size the window, drag any handle. To move the window, drag
inside the window frame. To scroll the contents of the window,
hold down Ctrl and drag inside the window frame.
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7. To exit the Freeze tool, right click or press Esc.

Note: The Freeze View can be resized or moved using the Adjust
tool.

= To enable and disable the Freeze window
Do one of the following;:

¢ On the Magnifier toolbar tab, choose Window > Freeze View >
Enable (or Disable).

e Press the Freeze View On/Off hotkey: Caps Lock + E

= To adjust the Freeze window options

1. On the Magnifier toolbar tab, select the Zoom Windows Settings
button, which appears in the lower-right corner of the Zoom
Windows group.

The Zoom Windows Settings dialog appears.

2. Select the Freeze tab.

3. Adjust the Freeze View settings as desired.
4. Click OK.
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Description

Freeze View Settings

Enable freeze view

Enables the Freeze View (when the zoom
window type is set to Full).

Use full zoom
magnification level

Sets the Freeze View to use the same
magnification level as the Full zoom window.

Use the magnification
level below

Allows the Freeze View to use its own
magnification level (set using the Zoom Level
spin box).

Zoom Level

Sets the Freeze View's magnification level.
Magnitfication levels include: 1x to 8x in steps of
1, 10x to 16x in steps of 2, 20x to 36x in steps of
4x, 42x to 60x in steps of 6, and fractional
powers of 1.2x, 1.4x, 1.6x, 1.8x, 2.5x, 3.5x and

4 .5x.

New Freeze View

Activates the Freeze Tool.
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Using Overview Mode and the View Locator

Overview mode shows you the area of the screen that is currently being
magnified and allows you to select a new area to zoom in on. When
Overview mode is activated, magnification turns off and the view
locator appears in the normal screen. By moving the view locator, you
can select a new area to zoom in on.

= To use Overview Mode
1. Do one of the following:
¢ On the Magnifier toolbar tab, choose Window > Overview

Mode.
e Press the Overview Mode On/Off hotkey: Caps Lock + O

Magnification is temporarily turned off and the view locator appears.
2. Move the view locator to the desired screen location.
3. Click to zoom-in on the new location.

Magnification is restored with the selected screen area displayed.

You can configure the view locator to appear in a variety of shapes and
colors. The view locator can also be enabled to appear in unmagnified
portions of the screen when using Overlay or Docked zoom windows.

= To enable and configure the view locator

1. In the Magnifier menu, choose View Locator
The Zoom Window dialog appears with the View Locator tab
displayed.

2. Make sure the Enable view locator box is checked.

3. Adjust the locator options as desired.

4. Click OK.

Note: The view locator can be enabled and disabled using the
Locator command: Caps Lock + L.
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Setting Description

View Locator Settings

View Locator Selects the type of view locator that is displayed:
Block, Inverted Block, Frame or Cross.

Color Selects the color that the view locator will
appear in.
Transparency Sets the level of transparency for the view

locator. The transparency level controls the
amount of the desktop image that is visible
through the view locator.

Display view locator in Enables the display of the view locator in the 1x

Overlay, Docked and portion of the screen when using the Overlay,
Zoom with 1x views Docked or Zoom with 1x zoom windows.
Blink view locator Turns locator blinking on or off.

Blink Rate Sets the blink rate for the view locator in

seconds (from .5 to 5, in increments of .5).
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Managing Multiple Monitors

In the "Zoom Windows" section you learned about the types of zoom
windows that are available and how to select a zoom window.

This section provides information on how to configure ZoomText's
multiple monitor options, how to best configure a system with multiple
monitors to work with ZoomText, and how to troubleshoot problems
related to ZoomText’s multiple monitor support.

ZoomText’s multiple monitor support currently works with two
extended displays. Support for three or more extended displays will be
added in a future release.

Note: For information on setting up your system with multiple display
devices, search the Microsoft website for instructions that pertain to
your version of Microsoft Windows.

e Multiple Monitor Options

e Support Hardware

¢ Recommended Configurations

e Configuring Displays

e Automatic Adjustments

e ZoomText Feature Behaviors

e Troubleshooting
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Multiple Monitor Options

Multiple Monitor Options provide a variety of settings for customizing
how the zoom windows behave when using multiple monitors. These
behaviors include how the mouse pointer moves between desktops and
monitors, and how magnification and screen enhancements are applied
and adjusted in each monitor’s view.

Note: For descriptions of the zoom window types available in multiple
monitor support, see Selecting Zoom Windows.

= To configure the Multiple Monitor Options

1. On the Magnifier toolbar tab, click the arrow next to Window or
navigate to Window and press the down arrow key.

2. In the Window menu, choose Settings.
The Zoom Window Settings dialog box appears.

3. Choose the Window tab.
4. Choose Multiple Monitor Options...

The Multiple Monitor Options dialog box appears.

5. Adjust the multiple monitor settings as desired.

6. Click OK.
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hultiple Maonitor Options

When the pointer crosses between deskiops

[ Jkeep the poinker From crossing the border For: 2 seconds

Display a border marker between the desktops: Blways w
Play sound cues when the pointer touches and crosses the border

Use these sounds: | Sound Set 1 ~

Sound cue volume; | Low w

When using Mulkibiew

[Jkeep views at the same magnification level

Switch the active view by pressing: | Caps Lock + ¥

When pressing and holding this hotkey each monitor's view is momentarily
frozen. While the views are frozen the mouse pointer can be moved directly
bebween each view. Y¥ou can modify this hotkey in the ZoomText Command
Kews dialog bo,

Cther Setkings

Shaow khe screen enhancements on: &l Displays W

Mote: Screen enhancements appear on all monitors when the view bype is
sek ko Span’

Goncel | |t

The Multiple Monitor Options dialog box

Setting \ Description

When the pointer crosses between desktops

Keep the pointer from | Keeps the mouse pointer from crossing between
crossing the border desktops until the pointer presses against the

for: border for the amount of time selected in the
neighboring combo box. Note: When this option
is enabled, you can cross the pointer immediately
by tapping the border twice (quickly).

Display a border Displays a border marker on the border between
marker between the desktops according to the style selected in the
desktops: neighboring combo box. The border marker helps

you to stay oriented in the extended displays.
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Play sound cues when
the pointer touches
and crosses the border

Plays a pair of sound cues to make you aware of
when the mouse pointer has bumped the border
between desktops and crossed over between
desktops.

Use these sound cues:

Selects the sounds that will be played when the
pointer touches and crosses the border between
desktops. There are four sets of sound cues to
choose from.

Sound cue volume:

Sets the volume level for the sound cues.

When using MultiView

Keep views at the
same magnification
level

When using the MultiView Local or MultiView
Global zoom windows; this setting forces the
active and inactive views to zoom in and out
together at the same magnification level across all
of the monitors. When adjusting the
magnification level in the active view, the
magnification levels on the other monitors will
also adjust to the same level.

Switch the active view
by pressing:

Displays the assigned hotkey for switching the
active view when using the MultiView Local or
MultiView Global zoom windows.

Other Settings

Show the screen
enhancements on:

Sets the monitors that screen enhancements will
be applied to.
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Supported Multiple Monitor Hardware

ZoomText’s multiple monitor support will work with most display
technologies that are designed for the Windows operating system. These
supported technologies include video cards, display monitors and
projectors, and display connections, including VGA, DVI, HDMI and
DisplayPort. In most cases, if your system is already running with
multiple display devices that are set to: "Extend these displays",
ZoomText’s multiple monitor support will also run on that system. If
you encounter a problem with ZoomText’s multiple monitor support,
see "Multiple Monitor Troubleshooting" in this chapter, or contact
Freedom Scientific or your local dealer for assistance.
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Recommended Monitor Configurations

ZoomText’s multiple monitor support will work with most makes and
models of computer monitors and projectors, including a set of monitors
that have different physical sizes and display resolutions. However, the
following recommendations should be observed to achieve the highest
level of display quality, viewing comfort and productivity from your
multiple monitor system.

Monitor sizes, orientation and alignment

For best viewing, we recommend using a matched set of monitors that
are physically oriented and aligned in a perfect side-by-side or stacked
arrangement on your desk. Then, when you have arranged the displays
in the Screen Resolution dialog box in the same orientation as the
monitors on your desk, you will be able to intuitively move the mouse
pointer from one monitor to another, as if it were one seamless screen.
For instructions on arranging displays, see Configuring Displays for
Multiple Monitor Support.

These factors—size, orientation and alignment—are particularly
important when using the Span zoom window, where your screens
display a contiguous magnified view across multiple screens. If the
monitors are mismatched in size, orientation or alignment, the
magnified view displayed in the Span zoom window may be confusing
to look at.

Display resolutions

For the clearest magnified views, we recommend always setting the
screen resolution for each monitor to its native resolution. Running
monitors in non-native resolutions degrades the image quality that
appears in a normal view, which is further degraded when magnified.
Note: This recommendation also applies when only using one monitor.



94

Configuring Displays for Multiple Monitor
Support

To use ZoomText's multiple monitor support your system must have
multiple monitors connected, enabled, and configured with the
following settings:

e The monitors must be set to "Extend these displays" in the Screen
Resolution dialog box.

e The monitors must be perfectly aligned on one side in the Screen
Resolution dialog box.

e The extended displays should be arranged to closely match the
physical arrangement of the monitors on your desk.
Instructions for making all of these adjustments are provided below.
» To set your monitors to "Extend these displays”
You can set your monitors to "Extend these displays" using the
following methods:
Method 1: Use the Display Switch shortcut: Windows + P
e When you press the Windows + P shortcut the Display Switch bar
will appear on your screen. When the Display Switch bar is
visible, press the Windows + P shortcut or the left and right arrow
keys to cycle through the multiple monitor options in the Display
Switch bar. Once you have cycled to the Extend option, press the
Enter key.
Method 2: Select in the Screen Resolution dialog box.

1. Right-click any empty area of your desktop, and then click Screen
resolution.

The Screen Resolution dialog appears.
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2. Click the Multiple displays drop-down list and select Extend these
displays. A dialog may appear asking if you want to keep the
adjusted display settings. Choose Keep Changes.

Note: ZoomText’s multiple monitor support also works when
using a combination of monitor and projector that are set to
"Extend these displays".

= To arrange and align your extended displays

Arranging and aligning your extended displays can be performed as
follows:

1. Right-click any empty area of your desktop, and then click Screen
resolution.

The Screen Resolution dialog appears. This dialog displays an
illustrative representation of how your extended displays are currently
arranged and aligned.

2. Using the mouse, drag the displays so that they are arranged to
closely match the physical arrangement of the monitors on your
desk, and then perfectly align the same edges of the monitors
according to the following alignment rules.

o If the displays are positioned side by side, either the top edges
or bottom edges of the displays must be aligned.

o [f the displays are positioned in a vertical stack, either the left
edges or right edges of the displays must be aligned.

3. Click the Apply or OK button. A dialog may appear asking if you
want to keep the adjusted display settings. If this dialog appears,
choose Keep Changes.
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Automatic Adjustment to Display Changes

ZoomText automatically detects all changes that are made to your
display devices, including the following:

Adding and removing display devices

Enabling and disabling display devices

Changing the screen resolution for display devices

Changing the relative position and orientation of display devices

Changing the presentation of the display devices—i.e. Extend
these displays, Duplicate these displays, Show only on {n}

These changes are detected when ZoomText starts up and while
ZoomText is running. When a change is detected, ZoomText

automatically adjusts to the settings you previously used for that

display configuration. If you had not previously used that display
configuration, ZoomText will use default settings. Here are a few
examples of how ZoomText detects and adjusts for display changes:

When ZoomText detects a switch from one monitor to multiple
monitors with extended displays, ZoomText will automatically
switch to the last window type used for multiple monitors. When
multiple monitors with extended displays are detected for the first
time, ZoomText enables the default zoom window type for
multiple monitors, which is MultiView Local.

When ZoomText detects a switch from multiple monitors with
extended displays to one monitor, or to multiple monitors set to
"Duplicate these displays", ZoomText will automatically switch to
the last zoom window type used for one monitor. When only one
monitor is detected for the first time, ZoomText enables the
default zoom window type for one monitor, which is Full zoom.
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Feature Behaviors in Multiple Monitors

When using ZoomText’s multiple monitor support the behavior of some
of ZoomText features will work as described below.

Feature \ Current Behavior

AppReader When using the Span, Clone, Zoom with 1x or
MultiView Global zoom windows; the active
magnified view always scrolls to follow
AppReader’s word highlight, regardless of which
desktop the target application is on.

When using the MultiView Local zoom window, if
the target application is on the inactive view’s
desktop, the inactive view becomes active and
scrolls to follow AppReader’s word highlight.

Reading Zones When using the Span, Clone, Zoom with 1x or
MultiView Global zoom windows, the active
magnified view scrolls to bring the triggered
reading zone into view, regardless of which
desktop the reading zone is on.

When using the MultiView Local zoom window, if
the triggered reading zone is on the inactive
view’s desktop, the inactive view becomes active
and scrolls to bring the reading zone into view.

Touch Screen This feature is currently not supported when using
multiple monitors.

ZoomText Camera This feature is currently not supported when using
multiple monitors.

Support for third-party | This feature is currently not supported when using
USB CCTVs multiple monitors.
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Troubleshooting Multiple Monitors

This topic provides steps for troubleshooting problems that can occur
when using ZoomText’s multiple monitor support.

Problem: Your system has three or more monitors (configured with
extended displays) and when you attempt to start ZoomText a message
appears saying: "ZoomText multiple monitor support requires that you
have only one extended display enabled. Please disable all but one
extended display, and then try enabling multiple monitors again."

Solution: ZoomText’s multiple monitor support currently works with
two extended displays. Support for three or more extended displays will
be added in a future release.

Problem: When using Span View the left half of the magnified view is
on the right and vice versa.

Solution: The orientation of your extended displays is reversed from the
physical arrangements of your monitors. To resolve this problem,
reverse the arrangement of the displays in the Screen Resolution
settings, which can be accessed by right-clicking any empty area of your
desktop, and then clicking Screen resolution.

Problem: The mouse won’t move between my monitors but wraps
around from the outside edges.

Solution: The orientation of your extended displays is reversed from the
physical arrangements of your monitors. To resolve this problem,
reverse the arrangement of the displays in the Screen Resolution
settings, which can be accessed by right-clicking any empty area of your
desktop, and then clicking Screen resolution.
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Problem: ZoomText only magnifies and scrolls across half of the display
area.

Solution: ZoomText's multiple monitor support is enabled and you are
only looking at one of your monitors. The other half of the display area
is displayed on the second monitor.
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Screen Enhancements

Screen enhancements improve the legibility of objects that appear on the
screen. With these settings you can; enhance the screen colors for
improved contrast and clarity; enhance the appearance of the mouse
pointer, text cursor and keyboard input focus so that they're easier to see
and follow.

e (Color Enhancements

e Pointer Enhancements

e Cursor Enhancements

e Focus Enhancements

e Using Smart Invert
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Color Enhancements

Color enhancements improve the clarity of text and graphics, providing
easier viewing and reduced eyestrain. The color enhancement options
consist of a variety of filter effects that adjust color, contrast and
brightness. You can choose from preset color schemes or create your
own custom color settings.

Tip! When using the Invert Brightness and Invert Color effects in
Internet Explorer 11 (and soon other browsers), enabling ZoomText's
Smart Invert feature will reverse the invert effect on photos so that they
are displayed in their natural colors. For more information on this
feature, see Using Smart Invert.

The color enhancement options are enabled and set using the Color
split-button control located on the Magnifier toolbar tab. The top
portion of this button toggles the color enhancements on and off, while
the bottom portion opens the color menu.

= To toggle the color enhancements on and off
Do one of the following:

¢ On the Magnifier toolbar tab, select the Color button.
e Press the Enhance Colors On/Off hotkey: Caps Lock + C

= To choose a preset color scheme

1. On the Magnifier toolbar tab, click the arrow next to Color or
navigate to Color and press the down arrow key.

2. In the Color menu, choose Scheme.

3. In the Scheme menu, choose the desired color scheme.
= To create a custom color scheme

1. On the Magnifier toolbar tab, click the arrow next to Color or
navigate to Color and press the down arrow key.
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2. In the Color menu, choose Settings.

The Screen Enhancements Settings dialog box appears with the Color
tab displayed.

3. Choose Custom...

4. Adjust the custom settings as desired.

5. Click OK.

Screen Enhancement Settings

Calar Pairter Curzar Focus Fant

Color Enhancement

) Mormal

() Seheme: Irrvert Brightness Cuskamize

Custom Setkings

apply color enhancements to Zoom window and background -

Brightness and Contkrast Sektings

Brightness
0% . 100%: Restore Marmal Settings
Cankrast
0% A 100%
Effect Setkings
Effect
Mone e

Cancel Help

The Color tab
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Setting Description

Color Enhancement

Normal Disables all color enhancements.

Scheme Activates a preset color scheme (selected in the
neighboring combo box).

Custom Activates the Custom Settings, allowing you to
create your own custom color scheme.

Customize Activates and configures the Custom Settings to
match the selected preset color scheme. This
allows you to use a preset scheme as the starting
point for a custom scheme.

Custom Settings
Apply color Determines whether color enhancements are
enhancements to applied to the zoom window, background

(normal screen) or both.

Brightness and Contrast Settings

Brightness Increases or decreases the brightness of the
screen image from 0% to 100%. Normal
brightness is 50%.

Contrast Increases or decreases the contrast of the screen

image from 0% to 100%. Normal contrast is 50%.

Restore Normal Restores Brightness and Contrast to 50%
Settings (normal).

Effect Settings
Effect Selects the type of color effect and activates the

associated settings.

None. No filtering is applied.
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Invert Brightness. Inverts the brightness of all
screen colors. Light colors become dark and
vice-versa.

Invert Colors. Inverts all screen colors.

Dyed. Transforms all screen colors to a single
hue while preserving their light and dark
values. When the Dye effect is selected, a Color
combo box appears, allowing you to select the
dye color.

Two-Color. Transforms all screen colors to a
two-color spectrum. When the Two-Color effect
is selected, Foreground Color and Background
Color combo boxes appear, allowing you to
define the two-color spectrum.

Replace Color. Replaces one screen color with
another. When the Replace Color effect is
selected, Replace and With combo boxes appear,
allowing you to choose the color to replace and
replacement color. A bandwidth slider also
appears allowing you to expand the range of
color replace to hues close to the selected color.
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Pointer Enhancements

Pointer enhancements make it easy to locate and follow the mouse
pointer. You can adjust the size and color of the pointer and activate a
locator that emphasizes the pointer's position on the screen. You can
choose from preset pointer schemes or create your own custom pointer
settings.

The pointer enhancement options are enabled and set using the Pointer
split-button control located on the Magnifier toolbar tab. The top
portion of this button toggles the pointer enhancements on and off,
while the bottom portion opens the pointer menu.

= To toggle the pointer enhancements on and off
Do one of the following;:

e On the Magnifier toolbar tab, select the Pointer button.
e Press the Enhance Pointer On/Off hotkey: Caps Lock + P

= To choose a preset pointer scheme

1. On the Magnifier toolbar tab, click the arrow next to Pointer or
navigate to Pointer and press the down arrow key.

2. In the Pointer menu, choose Scheme.

3. In the Scheme menu, choose the desired pointer scheme.
= To create a custom pointer scheme

1. On the Magnifier toolbar tab, click the arrow next to Pointer or
navigate to Pointer and press the down arrow key.

2. In the Pointer menu, choose Settings.

The Screen Enhancements Settings dialog box appears with the
Pointer tab displayed.

3. Choose Custom...



106

4. Adjust the custom settings as desired.

5. Click OK.

screen Enhancerment

|. Fed e

Clear

Displaw the pointer locakar
(®) Always
O When pointer is stationary
O When painker is mosving
() wehen modifier kev is pressed

Modifier Keys

Shift
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Chrl
Win

Caricel

Color Fainter Cursar Focus Faont
Painter Enhancement
) Mormal
Large ellow Zuskornize
Cuskom Setkings
Painter
IJse ZoomText smooth pointers
Size Color
Large e ||:| el
Painter Locakar
Tvpe Thickness
Mone e Thin
olor Transparency

Solid

Help

The Pointer tab
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Setting Description

Pointer Enhancement
Normal Disables all pointer enhancements.
Scheme Enables a preset pointer scheme (selected in the
neighboring combo box).
Custom Activates the Custom Settings, allowing you to
create your own custom pointer scheme.
Customize Activates and configures the Custom Settings to
match the selected preset pointer scheme. This
allows you to use a preset scheme as the starting
point for a custom scheme.
Custom Settings
Pointer
Use ZoomText Enables ZoomText’s smooth-edge mouse
smooth pointers pointers in the custom pointer scheme.
Size Sets the size of the enhanced mouse pointer to
standard (1x), large (2x) or extra-large (4x) sizes.
Color Sets the color for the mouse pointer.
Pointer Locator
Type Selects the type of pointer locator:
Circle. Displays a circle that is centered over the
pointer's hot spot.
Sonar. Displays animated circles that radiate
inward toward the pointer's hot spot.
Full Cross. Displays a set of crosshairs that
extend across the entire zoom window and
intersect the pointer's hot spot.
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Crosshairs. Displays a set of crosshairs that are
centered over the pointer's hot spot.

Color Sets the color for the pointer locator.

Thickness Sets the thickness of the pointer locator: Thin,
Medium or Thick.

Transparency Sets the level of transparency for the pointer

locator. The transparency level controls the
amount of the desktop image that is visible
through the pointer locator.

Display the pointer locator

Always

The pointer locator is always displayed.

When pointer is
stationary

The pointer locator is only displayed when the
pointer is stationary (not moving).

When pointer is

The pointer locator is only displayed when the

moving pointer is moving.

When modifier key is | The pointer locator is only displayed when the
pressed pointer modifier keys are held down.

Modifier Keys Selects a key or combination of keys that, when

pressed, will display the pointer locator.

Note: The Display the pointer locator option
must be set to When modifier key is pressed.
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Cursor Enhancements

Cursor enhancements make it easy to locate and follow the text cursor.
A choice of high visibility locators marks the cursor’s position without
obscuring the surrounding text. You can choose from preset cursor
schemes or create your own custom cursor settings.

The cursor enhancement options are enabled and set using the Cursor
split-button control located on the Magnifier toolbar tab. The top
portion of this button toggles the cursor enhancements on and off, while
the bottom portion opens the cursor menu.

= To toggle the cursor enhancements on and off

Do one of the following:

e On the Magnifier toolbar tab, select the Cursor button.
e Press the Enhance Cursor On/Off hotkey: Caps Lock + R

= To choose a preset cursor scheme

1. On the Magnifier toolbar tab, click the arrow next to Cursor or
navigate to Cursor and press the down arrow key.

2. In the Cursor menu, choose Scheme.

3. In the Scheme menu, choose the desired cursor scheme.

= To create a custom cursor scheme

1. On the Magnifier toolbar tab, click the arrow next to Cursor or
navigate to Cursor and press the down arrow key.

2. In the Cursor menu, choose Settings.

The Screen Enhancements Settings dialog box appears with the Cursor
tab displayed.

3. Choose Custom...
4. Adjust the custom settings as desired.

5. Click OK.
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Screen Enhancernent Settings

Color Puainter Cursor Focus Faont

Cursor Enhancement

() Mormal

BElue Wedge Cuskomize

Preview: | Click here to preview

Cuskom Setkings

Cursor Locakor

Type Size
Wedges e Mediurm W
Calor Transparency
|. Blue 1 Clear . Solid
Displaw the cursar locakar
(®) always Modifier Keys
() When cursor is stationary Shift
O When cursor is moving Al
() when modifier key is pressed Clrl
Win

Cancel Help

The Cursor tab

Setting Description

Cursor Enhancement

Normal Disables all cursor enhancements.

Scheme Activates a preset cursor scheme (selected in the
neighboring combo box).
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Custom Activates the Custom Settings, allowing you to
create your own custom cursor scheme.

Customize Activates and configures the Custom Settings to
match the selected preset cursor scheme. This
allows you to use a preset scheme as the starting
point for a custom scheme.

Preview When you click in the Preview box a text cursor
appears with the selected cursor enhancement
settings.

Custom Settings
Cursor Locator

Type Selects the type of cursor locator:
Wedges. Displays triangular wedges above and
below the cursor.
Circle. Displays a circle around the cursor.
Frame. Displays a rectangular frame around the
Cursor.

Size Sets the size of the cursor locator: Thin, Medium
or Thick.

Color Sets the color for the cursor locator.

Transparency Sets the level of transparency for the cursor
locator. The transparency level controls the
amount of the desktop image that is visible
through the cursor locator.

Display the cursor locator

Always The cursor locator is always displayed.
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When cursor is
stationary

The cursor locator is only displayed when the
cursor is stationary (not moving).

When cursor is

The cursor locator is only displayed when the

moving cursor is moving.

When modifier key is | The cursor locator is only displayed when the
pressed cursor modifier keys are held down.

Modifier Keys Selects a key or combination of keys that, when

pressed, will display the cursor locator.

Note: The Display the cursor locator option
must be set to When modifier key is pressed.
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Focus Enhancements

Focus enhancements make it easy to locate and follow the control focus
when you tab and arrow key through menus, dialogs, tool bars, and
other application controls. When enabled, a choice of high visibility
locators marks the position of the control with focus without obscuring
any surrounding text. You can choose from preset focus schemes or
configure your own custom focus settings.

The focus enhancement options are enabled and set using the Focus
split-button control located on the Magnifier toolbar tab. The top
portion of this button toggles the focus enhancements on and off, while
the bottom portion opens the focus menu.

= To toggle the focus enhancements on and off
Do one of the following:

e On the Magnifier toolbar tab, select the Focus button.
e Press the Enhance Focus On/Off hotkey: Caps Lock + F

= To choose a preset focus scheme

1. On the Magnifier toolbar tab, click the arrow next to Focus or
navigate to Focus and press the down arrow key.

2. In the Focus menu, choose Scheme.

3. In the Scheme menu, choose the desired focus scheme.
= To create a custom focus scheme

1. On the Magnifier toolbar tab, click the arrow next to Focus or
navigate to Focus and press the down arrow key.

2. In the Focus menu, choose Settings.

The Screen Enhancements Settings dialog box appears with the Focus
tab displayed.
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3. Choose Custom...

4. Adjust the custom settings as desired.

5. Click OK.

Screen Enhancernent Settings

Colar Fointer Curgor Focus Font

Focus Enhancement
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Cancel Help

The Focus tab

Setting Description

Focus Enhancement

Normal Disables all focus enhancements.
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Scheme Activates a preset focus scheme (selected in the
neighboring combo box).

Custom Activates the Custom Settings, allowing you to
create your own custom focus scheme.

Customize Activates and configures the Custom Settings to
match the selected preset focus scheme. This
allows you to use a preset scheme as the starting
point for a custom scheme.

Custom Settings

Focus Locator

Type

Selects the type of focus locator:

Block. Displays a block over the control that has
focus.

Underline. Displays a line beneath the control
that has focus.

Frame. Displays a rectangular around the
control that has focus.

Color

Sets the color for the focus locator.

Thickness

Sets the thickness of the focus locator: Thin,
Medium or Thick.

Transparency

Sets the level of transparency for the focus
locator. The transparency level controls the
amount of the desktop image that is visible
through the focus locator.

Note: This setting is not available when the
locator color is set to 'Invert'.

Margin

Increases or decreases the space between the
control with focus and the focus locator.
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Display the focus locator

Continuously The focus locator is always displayed
(when a control has focus).
Briefly The focus locator is for 1.5 seconds when a
control receives focus.
When modifier key is | The focus locator is only displayed when the
pressed focus modifier keys are held down.
Modifier Keys Selects a key or combination of keys that, when

pressed, will display the focus locator.

Note: The Display the focus locator option
must be set to When modifier key is pressed.
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Using Smart Invert

The use of filter effects to invert the screen brightness and colors is
popular among low-vision computer users, providing reduced glare,
improved legibility of on-screen text, less eyestrain and increased
comfort. However, these effects also result in photo images that look like
tilm negatives, which are unappealing and often unusable to look at.

By enabling ZoomText's Smart Invert feature, when using ZoomText's
Invert Brightness and Invert Color effects (in the Color Enhancement
feature), ZoomText will reverse or undo the inverted effect on photos so
that they are displayed in their natural colors.

Note: This feature is currently available in Internet Explorer 11 and
Google Chrome, but will soon be added to other web browsers and
applications.

= To enable and disable the Smart Invert in the Color menu

1. On the Magnifier toolbar tab, click the arrow next to Color or
navigate to Color and press the down arrow key.

2. In the Color menu, choose Use Smart Invert.
= To enable and disable the Smart Invert by hotkey

Press the Enhance Smart Invert On/Off hotkey: Caps Lock +1

Note: Smart Invert can only be enabled and disabled when either Invert
Brightness or Invert Colors is enabled.
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Navigation Settings

Navigation settings control how ZoomText will scroll the zoom window
to keep moving objects in view, including the mouse pointer, text
cursor, keyboard focus and other objects that appear and move about
the screen. With these settings you can: choose the objects and events
ZoomText will track in the zoom window, choose how tracked objects
and events will be positioned in the zoom window, automatically route
the mouse pointer into the magnified view or to the active control, and
constrain the movement of the mouse pointer.

Tracking
Alignment

e Mouse

Panning
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Tracking

As you move the mouse, type text, and navigate menus, dialogs and
other program controls, the zoom window automatically scrolls to keep
the focus in view. This behavior is driven by ZoomText's tracking
options, which allow you to choose the items that you want ZoomText
to track when they become active. You can also limit tracking to a
selected area of the screen.

= To adjust the tracking settings

1. On the Magnifier toolbar tab, select the Navigation button.

2. In the Navigation menu, choose Tracking.

The Navigation Settings dialog appears with the Tracking tab
displayed.

3. Adjust the tracking settings as desired.
4. Click OK.

Mawvigation Settings

Tracking Alignment Mouze Fanning

Track on these items

Maouse Pointer Controls [ alerts
Text Cursor [ ]Tool Tips
Menus Wirdos

Cancel Help

The Tracking tab
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Description

Track on these items

Mouse Pointer

Enables tracking of the mouse pointer.

Text Cursor

Enables tracking of the text cursor.

Menus Enables tracking of menu items when they
receive keyboard focus.

Controls Enables tracking of controls when the receive
keyboard focus.

Tool Tips Enables tracking on tool tips when they appear.

Windows Enables tracking on windows when they
become active.

Alerts Enables tracking on alert pop ups when they

appear.
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Alignhment

121

Alignment options control how the zoom window scrolls to keep

tracked items in view. There are two general types of alignment; edge

and center. With edge alignment, the zoom window scrolls only as
needed to keep the tracked object in view. With center alignment, the

zoom window scrolls as needed to keep the tracked object in the center
of the zoom window. A third alignment type, "smart alignment", scrolls
a control and the maximum portion of its parent menu or window into

view.

= To adjust the alignment settings

1. On the Magnifier toolbar tab, select the Navigation button.

2. In the Navigation menu, choose Alignment.

The Navigation Settings dialog appears with the Alignment tab

displayed.

3. Adjust the alignment settings as desired.

4. Click OK.

Mavigation Settings

Tracking Aligrrment Mouze

Maouse painker alignment
(®)3ithin edge margins:
() Centered within the zoom window

Texk cursor alignment
(@) within edge margins

() Centered within the zoom window

Control and menu ikem alignment

() Centered within the zoom window

(®) Smart alignment with parent window

Fanning

Edage Margin

15%

Edge Margin

15%:

Cancel Help

The Alignment tab
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Description

Within edge margins

The zoom window scrolls only as needed to
bring the tracked object within the edge
margins.

Centered within the zoom
window

The zoom window scrolls to keep the tracked
object centered in the magnified view.

Edge Margins

Defines how close to the edge of the zoom
window a tracked object can move before the
window begins to scroll. The edge margin can
be set from 0% to 50%; half the width and height
of the zoom window.

Smart alignment with
parent window

The zoom window scrolls to bring the tracked
control or menu item and the maximum portion
of its parent window or menu into view.
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Mouse

The Mouse navigation options, pointer positioning and pointer
constraints, make it easy to explore and move about the screen. With
pointer positioning, the mouse pointer is always brought into view
when you need it. With pointer constraints, you can limit mouse pointer
movement to horizontal or vertical directions, or within the active
window.

= To adjust the mouse navigation settings

1. On the Magnifier toolbar tab, select the Navigation button.

2. In the Navigation menu, choose Mouse.
The Navigation Settings dialog appears with the Mouse tab displayed.
3. Click OK.

4. Adjust the mouse navigation settings as desired.

Mawvigation Settings

Tracking Alignrment Mousze Patining

Poinkter Positioning

Enute poinker inko view when it is moved:

] Route pointer over the ackive control

Painker Constraint
[ JHold shift key to move only horizonkally or vertically
[ ]Hold Ctrl ke ko skay within the active window

Cancel Help

The Mouse tab
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Setting Description

Route pointer into view Automatically moves the pointer to the center of
when it is moved the magnified view, whenever the pointer
moves while located outside the view.

Route pointer over the Automatically moves the pointer to menu items
active control and dialog controls when they receive focus.
Hold Shift key to move While holding down the Shift key, the mouse
only horizontally or pointer moves horizontally or vertically only,
vertically depending on the initial direction of mouse

movement. This constrained movement
provides smoother scrolling through rows and
columns of information.

Hold Ctrl key to stay While holding down the Ctrl key, the mouse
within the active window | pointer moves horizontally or vertically only,
depending on the initial direction of mouse
movement. This constrained movement
provides smoother scrolling through rows and
columns of information.
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Panning

Smooth panning provides a more natural panning motion when the
magnified view scrolls to keep the focus in view. As you type text and
navigate menus, dialogs and other program controls the magnified view
smoothly pans across the screen, rather than jumping in an abrupt
manner.

= To enable and adjust the smooth panning settings

1. On the Magnifier toolbar tab, select the Navigation button.

2. In the Navigation menu, choose Panning.

The Navigation Settings dialog appears with the Panning tab
displayed.

3. Adjust the smooth panning settings as desired.
4. Click OK.

Mawvigation Settings

Tracking Alignment b ouze Fanning

[~]Enable smooth panning:

Panning Speed

Slower . Faster

[ ]Use smooth panning in AppReader {App Wiew)

Cancel Help

The Panning tab
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Description

Enable smooth panning

Enables ZoomText’s smooth panning feature.

Panning Speed

Controls how fast ZoomText pans from one
location to another.

Use smooth panning in
AppReader

Enables smooth panning between highlighted
words in AppReader.




Chapter 6
Reader Features

"Reader Features" represent the core screen reading and document
reading features in ZoomText Magnifier/Reader. These features include
the ZoomText voice; typing, mouse and program echo; the AppReader
and Reading Zones tools, and the Text Cursor and Say Commands.

Note: The Reader Features are not available in ZoomText Magnifier.

e The Reader Toolbar Tab

e The ZoomText Voice

e Echo Features

e AppReader
e Reading Zones

e Reading with the Text Cursor

e Say Commands
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The Reader Toolbar Tab

The Reader toolbar tab provides quick-action buttons for enabling and

adjusting all of ZoomText's Reader features. Many of these buttons are
split-button controls that allow you to toggle the feature on and off and
open a menu of related settings. The buttons are grouped by category

and have intuitive icons and labels for easy identification.

ZoornText MagnifierfReader - X

bagnifier Reader Tools

w02 @) 6 % G

Yoice Rate Keyboard Mouse ‘“erbosity  AppReader Zones
w - - - - -
Waice |_'y Echo |_'y Reading Tools
The Reader toolbar tab

Note: The Reader toolbar tab only appears in ZoomText
Magnitier/Reader.

Voice. Enables and disables speech output for screen reading, and
allows you to open the Voice Settings dialog box where you can
select and customize different voices.

Rate. Controls how fast ZoomText speaks.

Keyboard. Toggles the keyboard echo on and off, and selects
keyboard echo settings. Keyboard echo provides immediate
feedback of the keys and words that you type.

Mouse. Toggles the mouse echo on and off, and selects mouse
echo settings. Mouse echo automatically reads text beneath the
pointer.

Verbosity. Selects a verbosity level. Verbosity allows you to adjust
the amount of information spoken when a program item receives
focus.
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e AppReader. Launches AppReader to read text from the last active
application. AppReader provides continuous reading of
documents, web pages and email, within the parent application.

e Zones. Allows you to create, edit and navigate reading zones.
Reading zones let you instantly see and hear selected locations in
an application window.
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The ZoomText Voice

ZoomText allows you to select and customize the voice to fit your
personal preference. You can choose a male or female voice, adjust how
fast and loud the voice speaks, and customize the reading style and
audible cues. You can also enable and disable the voice as needed.

e Enabling and Disabling the Voice

e Adjusting the Voice Rate

e Choosing a Voice

e Configuring Text Processing

e Configuring Hints
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Enabling and Disabling the Voice

You can turn the voice on and off at any time without disabling the
magnification features.

= To enable and disable the voice
Do one of the following;:

¢ On the Reader toolbar tab, select Voice > Enable (or Voice
> Disable).

e Press the Voice On/Off hotkey: Caps Lock + Alt + Enter
Note: AppReader will still speak when the voice is disabled.

There may be times when you want to terminate the voice output while
it is occurring. For example, when ZoomText is reading a message box
that you are already familiar with. You can force ZoomText to stop
speaking this text without turning the voice off altogether.

= To terminate speech output as it occurs
Press and release the Ctrl key.

The information that is currently being spoken is terminated.



132

Adjusting the Voice Rate

The Voice Rate allows you to control how fast ZoomText speaks.
= To adjust the speech rate

Do one of the following;:

e On the Reader toolbar tab, adjust the level in the Rate spin box.
e Press the Voice Faster and Voice Slower hotkeys

o Voice Faster: Caps Lock + Alt + Up

o Voice Slower: Caps Lock + Alt + Down

Note: The voice rate can also be adjusted in the Voice Settings dialog
box. For more information, see Voice Settings.

A separate voice rate is available for AppReader. This setting is located
in the AppReader dialog box (Shared Settings tab). For more
information, see AppReader Shared Settings.
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Voice Settings

Voice settings let you select and customize the ZoomText voice. You can
select from a variety of male and female voices, and adjust their
speaking rate, pitch and volume.

= To adjust the voice settings

1.

On the Reader toolbar tab, click the arrow next to Voice or
navigate to Voice and press the down arrow key.

In the Voice menu, choose Settings.
The Voice Settings dialog appears.

Choose the Voice tab.
Make sure the Enable voice output box is checked.

Choose the desired Language, Synthesizer and Voice, and then
adjust the Rate, Pitch and Volume.

To preview the synthesizer settings, type some text in the Sample
Text edit box, and then click Speak Sample.

Click OK.
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Woice Settings

Yoice Text Processing Hirits

["|Enable vwoice output

Langquage English i
Synthesizer  yocalizer Expressive >
Voice Tarm Compact, United States i

Dovenload Mare Yoices. .

Voice Settings

Fuake (WP PFitch Yolume
oo S 0% TS Optians...
Sample Texk
Type any kext here and click the Speak, Speak Sample

Sample button to hear how it will be spoken
by the selected woice and voice settings,

Cancel Help

The Voice tab
Setting Description
Enable voice output Enables or disables speech output for screen
reading.
Language Displays a list of speech synthesizer languages

that are available on your system.

Synthesizer Displays a list of speech synthesizers available
on your system.

Note: ZoomText supports SAPI 4 and SAPI 5
based speech synthesizers.




Chapter 6—Reader Features 135

Voice

Displays a list of voices available in the selected
synthesizer.

Download More Voices

Opens the default web browser to the Voice
Synthesizer page on the Freedom Scientific
website, where you can preview and download
additional Vocalizer Expressive voices to install
for use with ZoomText.

Voice Settings
Rate Controls how fast ZoomText speaks.
A separate reading rate is available for
AppReader. * For more information, see
Reading Options.
Pitch Selects the pitch of the current voice. Pitches
range from 5% to 100%, in steps of 5%.
Volume Selects the volume of the current voice. Volumes
range from 5% to 100%, in steps of 5%.
Options... Displays optional settings for the selected
speech synthesizer, including the synthesizer's
pronunciation manager. If the speech device is
not pronouncing a word properly, you can
adjust the pronunciation by supplying the
phonetic spelling.
Sample Text
Sample Text / Speak Allows you to test particular speech settings.
Sample Text can be typed into the Sample Text box and

spoken by clicking the Speak Sample button.

The current speech settings are used to speak
the sample text, including settings in the Text
Processing and Hints tabs.
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* It AppReader is set to use its own voice rate, this rate setting will be
grayed out (disabled) when opening the Voice Settings dialog from the
AppReader's Text View toolbar.

Adding Voices

ZoomText Magnifier/Reader includes a library of Vocalizer Expressive
voices for the most commonly spoken languages and dialects from
around the world. When you install ZoomText, one male and/or female
voice matching the language of your Windows operating system is
automatically installed. You can preview and download additional
voices in the Vocalizer Expressive library from the Voice Synthesizer
page on the Freedom Scientific website.

= To download additional Vocalizer Expressive voices

1. On the Reader toolbar tab, click the arrow next to Voice or
navigate to Voice and press the down arrow key.

2. In the Voice menu, choose Settings.
The Voice Settings dialog appears.
3. Choose the Voice tab.

4. Choose Download More Voices...

Your web browser will open to the Voice Synthesizer page on the
Freedom Scientific website.

5. Download the installers for the desired voices.

6. Double-click on each download to install the voice.

Note: ZoomText also supports SAPI 4 or SAPI 5 based synthesizers from
other providers that have open licensing and are compatible with
ZoomText.
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Text Processing

Text processing modifies how numbers, punctuations and mixed case

words are spoken, so that they are pronounced in the proper context or
desired format. With these settings you can create a reading style that
clarifies complex words and numbers.

= To adjust the text processing settings

1.

On the Reader toolbar tab, click the arrow next to Voice or
navigate to Voice and press the down arrow key.

In the Voice menu, choose Settings.
The Voice Settings dialog appears.

Choose the Text Processing tab.

Adjust the settings as desired.
Click OK.
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Ve
Walce

Zettings

Yoice Text Proceszing Hints

Texk
Repeat Count

[]5peak mixed case as separate words: li -
3

Filter out repeated characters

-

Murnbers
(®) Speak numbers according to synthesizer settings
() speak numbers using their full word representation
() speak numbers as single digits
() speak numbers as digit pairs

Punctuation

(®) Speak punctuation according to synkhesizer settings
() speak all punctuation
() speak embedded punctuation only

Cancel Help

The Text Processing tab

Setting Description

Text

Speak mixed case as Breaks mixed case words into separate words

separate words for more accurate pronunciation by the speech
synthesizer. For example, the word 'ZoomText'
is broken apart and spoken as "Zoom Text".

Filter out repeated Limits the number of times that repeated

characters characters are spoken. This is useful when
encountering a string of repeated characters
used in formatting.
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Repeat Count

Sets the maximum number of times a repeated
character is spoken. The repeat count range is
from 2 to 10.

Numbers

Speak numbers
according to synthesizer
settings

Numbers are spoken according to the
synthesizer's built-in settings.

Speak numbers using
their full word
representation

Numbers are spoken using their full-word
representation. For example, the number '1995'
is spoken "one thousand nine hundred and
ninety five".

Speak numbers as single
digits

Numbers are spoken as individual digits. For
example, the number '1995' is spoken "one nine
nine five".

Speak numbers as digit
pairs

Numbers are spoken as digit pairs. For example,
the number '1995' is spoken "nineteen ninety
five".

Punctuation

Speak punctuation
according to synthesizer
settings

Punctuation characters are spoken according to
the synthesizer's built in settings.

Speak all punctuation

All punctuation characters are spoken.

Speak embedded
punctuation only

Only punctuation characters embedded within
words are spoken. For example,
sales@freedomscientific.com is spoken "sales at
Freedom Scientific dot com".
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Hints

Hints provide audible cues when you encounter capital letters,
hypertext links, or the start or end of a document. Hints can be heard as
a momentary pitch change while the item is read or a verbal

announcement such as "Cap" or "Link" prior to the item being read.

= To adjust the hints settings

1.

On the Reader toolbar tab, click the arrow next to Voice or
navigate to Voice and press the down arrow key.

In the Voice menu, choose Settings.
The Voice Settings dialog appears.

Choose the Hints tab.

Adjust the settings as desired.
Click OK.
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Woice Settings

Yaice Text Proceszing Hints

Capital Letters

(®) Mo hints For capitals:
() Change pitch when reading a capital -10%: :

() 5ay "Cap" before reading a capital

Hypertext Links
(®) Mo hints For links

() Change pitch when reading a link 0% :

() Sav "Link" before reading a link

Cancel Help

The Hints tab

Setting Description

Capital Letters
No hints for capitals No hint is applied when a capital letter is read.
Change pitch when The synthesizer pitch is changed when a capital
reading a capital letter is read.
Say "Cap" before The word "cap" is spoken before a capital letter
reading a capital is read.
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Pitch Change A percentage change to the voice pitch occurs
(Capital Letters) when a capital letter is read. Pitch change ranges
from -50% to +50% in steps of 10%.
Hypertext Links

No hints for links

No hint is applied when a hypertext link is read.

Change pitch when
reading a link

The synthesizer pitch is changed when a
hypertext link is read.

Say "Link" before a link
is read

The word "link" is spoken when a hypertext link
is read.

Pitch Change
(Hypertext Links)

A percentage change to the voice pitch occurs
when a hypertext link is read. Pitch change
ranges from -50% to +50% in steps of 10%.
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Echo

Echo settings control how ZoomText speaks as you use type on the
keyboard, use the mouse, and navigate your applications. These settings
allow you to increase or decrease the amount of detail spoken to fit your
personal needs.

e Kevyboard Echo

e Mouse Echo

e Program Echo

e Verbosity




144

Keyboard Echo

Keyboard echo allows you to hear the keys and words that you type.
You can choose to have individual keys, words, or both keys and words
spoken. Typed words are spoken upon completion when you type a
space or punctuation character. You can also choose which groups of
printed and non-printed keys are spoken.

= To cycle the keyboard echo mode
Do one of the following;:

e On the Reader toolbar tab, select the Keyboard button.
e Press the Echo Keyboard Mode hotkey: Caps Lock + Alt + K

= To adjust the keyboard echo settings

1. On the Reader toolbar tab, click the arrow next to Keyboard or
navigate to Keyboard and press the down arrow key.

2. In the Keyboard menu, choose Settings.
The Echo Settings dialog box appears with the Keyboard tab displayed.

3. Adjust the keyboard echo settings as desired.
4. Click OK.



Chapter 6—Reader Features 145

Echo Settings

F.epboard b ouze Program Yerbosity

kevboard Echo
(Mo Echa

() Kevs and Waords

Printable Keys Function Kewvs Mulktimedia Keys
Mavigation Kews Modifier Keys Qther Keys
Editing Kevs Locking Kevs

Cancel Help

The Keyboard tab
Setting Description
Keyboard Echo

No Echo Disables all keyboard echo.

Keys Activates keyboard echo by keystroke. You can
select which keys are echoed using the settings
under Echo these keys when they are pressed.

Words Activates keyboard echo by word. Echoing
occurs only when a completed word appears on
the screen.

Keys and Words Activates keyboard echo by keystroke and by
word.
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Echo these keys when they are pressed

Printable Keys Echoes all printable characters: letters, numbers
and symbols.

Navigation Keys Echoes navigation keys: arrows, Home, End,
Page Up and Page Down.

Editing Keys Echoes text-editing keys: Backspace, Insert,

Delete, Escape and Enter.

Function Keys

Echoes the function keys: F1 through F12.

Modifier Keys Echoes the modifier keys: Alt, Ctrl, Shift and
the Windows key.

Locking Keys Echoes the locking keys and their state: Caps
Lock, Num Lock, and Scroll Lock.

Other Keys Echoes miscellaneous keys: Pause, Print Screen

and the Application Key.

Note: Selections under Echo these keys... are only available when
typing echo is set to Keys or Keys and Words.
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Mouse Echo

Mouse echo automatically reads text beneath the pointer. As you move
the pointer across the screen, single words or complete lines of text are
echoed instantly or after hovering briefly.

= To cycle the mouse echo mode
Do one of the following:

¢ On the Reader toolbar tab, select the Mouse button.
e Press the Echo Mouse Mode hotkey: Caps Lock + Alt + M

= To adjust the mouse echo settings

1. On the Reader toolbar tab, click the arrow next to Mouse or
navigate to Mouse and press the down arrow key.

2. In the Mouse menu, choose Settings.
The Echo Settings dialog box appears with the Mouse tab displayed.

3. Adjust the mouse echo settings as desired.

4. Click OK.
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Echo Settings

Kepboard

Maouse Echio

() Instant Echo
) Hower Echo

Echio the word only

Echo all vwords in the line or object

b ouze

Program Yerbogity

Cancel Help

The Mouse tab

Setting Description

Mouse Echo

No Echo

Disables all mouse echo.

Instant Echo

Enables instant mouse echo. Words are spoken
immediately when the mouse pointer is moved
over them.

Hover Echo

Enables delayed mouse echo. Words are spoken
after the mouse pointer hovers over them for the
selected hover time.

Hover Time (seconds)

The amount of time in seconds that the mouse
pointer must hover over an object before it is
spoken. This setting applies to Hover Echo only.
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When the mouse passes over a word

Echo the word only Only the word beneath the mouse pointer is
echoed.

Echo all words in the When the mouse pointer moves into a new line

line or object of text or over a new object, all words in the line

or object are spoken. Objects include: title bars,
menu items, dialog controls, desktop icons and
task bar buttons.

Note: When using mouse echo, holding down the Shift key toggles the
echo mode from Echo the word only to Echo all words in the line or
object (or vice-versa).
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Program Echo

Program echo determines what items are spoken as you navigate and
use your applications. These items include: window titles, menus,
dialogs, list views, tree views, and text that the cursor moves through.
The amount of detail that is spoken for these items can be adjusted

using the Verbosity Settings.

= To adjust the program echo settings

1.

Echo group.

Adjust the program echo settings as desired.
Click OK.

Echio Settings

K.eyboard b ouze Pragram Yerbozity

Echo these ikems when they become active

Text Cursor Tl Tips
Menus Window Titles
Coptrals alerts

whien the text cursor moves tooa new line

() Echo the word at the cursor
(®) Echo the entire line

Carcel

On the Reader toolbar tab, select the Echo Settings button, which
appears as a diagonal arrow icon in the lower-right corner of the

The Echo Settings dialog box appears with the Program tab displayed.

Help

The Program tab
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Setting Description

Echo these items when they become active

Text Cursor When the text cursor moves, text at the new
cursor location is spoken. The amount of text
that is spoken is in accordance with how far the
cursor has moved; by character, word, line,
sentence or paragraph.

Menus When you pull down a menu, its title is spoken
followed by each menu item that becomes
highlighted.

Controls As you navigate through dialog boxes, tree

views and list views, each item is spoken as it
becomes highlighted or selected.

Tool Tips When a tool tip appears, it is spoken.

Window Titles When a window becomes active, the contents of
its title bar are spoken.

Alerts When an alert popup appears, it is spoken.

When the text cursor moves to a new line

Echo the word at the When the text cursor moves to a new line, the
cursor word at the new cursor location is spoken.
Echo the entire line When the text cursor moves to a new line, the

entire line is spoken.
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Verbosity

Verbosity allows you to adjust the amount of information spoken about
program controls when they become active or highlighted. Program
controls include: application and document windows, menus, dialogs,
buttons, icons, and more.

Three verbosity levels — Low, Medium and High — allow you to quickly
increase or decrease the verbosity. High verbosity provides more
information, while Low verbosity provides less information. Each of
these verbosity levels can be fully customized according to your
personal needs.

= To cycle the verbosity level
Do one of the following;:

e On the Reader toolbar tab, select the Verbosity button.
e Press the Echo Verbosity Level hotkey: Caps Lock + Alt + B

= To adjust the verbosity settings

1. On the Reader toolbar tab, click the arrow next to Verbosity or
navigate to Verbosity and press the down arrow key.

2. In the Verbosity menu, choose Settings.
The Echo Settings dialog box appears with the Verbosity tab displayed.

3. Adjust the verbosity settings as desired.
4. Click OK.
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Echo Settings

Kevboard b ouze Program “erbasity

Yerbosity Level

(®) Low Yerbosity: Announce items with minimunn details:

() Medium Yerbosity: Announce items with moderate details

() High Yerbosity: Announce items with maximum details

Werbosity Settings

[ ] Control Access key "
Control Shake

[ ] Contral Type

Contral Yalue

[] bialog Group Mame W
< >

Select Al

Lnselect all

Announces the access key For the active control,

Cancel Help

The Verbosity tab
Setting Description
Verbosity Level

Low Verbosity Announces program echo items with minimum
details.

Medium Verbosity Announces program echo items with moderate
details.

High Verbosity Announces program echo items with maximum
details.

Verbosity Settings A list of checkboxes that define the verbosity
levels. The displayed settings reflect the current
verbosity level and automatically update when
a different verbosity level is selected.
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Select All Checks all items in the Verbosity Settings list
box.

Unselect All Unchecks all items in the Verbosity Settings list
box.
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AppReader

AppReader is a productivity tool that automatically reads documents,
web pages and email while you visually follow along or relax your eyes
and listen. AppReader can automatically read the text from beginning to
end, skim forwards and backwards through the text, or read specific
areas of text that you select by clicking and dragging with the mouse.
Whichever way you read, AppReader makes it easy.

e AppReader Reading Modes

e The Text View Environment

e Starting and Using AppReader

e App View Settings

e Text View Settings

e Shared Settings
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AppReader Reading Modes

Before you begin using AppReader you should understand the different
reading modes and their availability in different applications.
Understanding these features will help you utilize AppReader in the
most useful and productive way.

AppReader provides three unique reading modes: App View, Text View
and the SpeaklIt Tool.

e App View reads right in the source application. Your view of the
application and document is not changed, so entering and exiting
AppReader is seamless and smooth. App View is ideal for users
that want a reading experience that is seamless to the application,
or do not require the text enhancement features provided by Text
View.

e Text View reads in a special environment where text is
reformatted for easier reading. Text is presented in a single line of
text that scrolls horizontally, called Ticker View, or multiple
wrapped lines of text, called Prompter View. In both views you
can select your choice of fonts, high-contrast colors, word
highlighting, and magnification level. Text View is ideal for users
who want to visually read and desire an enhanced visual reading
environment. To learn about the Text View environment, see The
Text View Environment.

e Speaklt Tool reads selected areas of the screen by clicking and
dragging with the mouse. Any text that is visible on the screen can
be spoken, even if it is outside the active program. SpeaklIt tool is
ideal for spot reading random blocks of text with simple mouse
actions.

You can use AppReader in almost any application, however, the reading
modes that are available depend on the level of support that AppReader
has for the application: Full Support or Basic Support.
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e Full Support allows you to use all three reading modes: App
View, Text View and the SpeakIt Tool. Full Support is available in
most applications that display long passages of text, as you would
find in Microsoft Word, Microsoft Outlook, Adobe Reader and
Internet Explorer.

e Basic Support allows you to use the SpeaklIt Tool only. If you
attempt to start AppReader in App View or Text View and there is
only Basic Support for the application, AppReader will
automatically start up in the Speaklt Tool.

Products to meet
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Ai Squared has been a leader in the assistive technolc
ZoomText, is the world’s best magnification and readi
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AppReader highlighting the spoken word in Microsoft Word.
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The Text View Environment

AppReader's Text View is a special reading environment where text is
reformatted for easier reading. Text is presented in a single line of text
that scrolls horizontally, called Ticker View, or multiple wrapped lines
of text, called Prompter View. In both views you can select your choice
of fonts, high-contrast colors, word highlighting, and magnification
level.

Text View occupies the entire display with a toolbar at the top of the
screen and the document text below it. The document text is formatted
and displayed according to the current Text View settings.

ZoomText AppReader b4
D (=] 8 & 3
Play Zoom Level Rate Ticker  Prompter App View Settings

Ai Squared has been a leader in
the assistive technology field for
over M) years. Our flagship

product, ZoomText, is the world’s
best magnification and reading
software for the vision impaired.

AppReader Text View in Prompter Mode
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ZoomText AppReader b4
[ s % B 8 =
Flay Zoom Level Rate Ticker  Prompter App View Settings

AppReader Text View in Ticker Mode

The Text View toolbar provides the essential controls for operating Text
View, and provides access to dialogs for configuring the Text View

display.

ZoomText AppReader X
B »] &8 & @8 &
Flay Zoom Level Rate Ticker  Prompter App View Settings

The Text View toolbar

e Play/Pause. Starts and stops reading at the highlighted word.
When Play mode is executed, the Pause button appears on the
toolbar.

e Zoom Level. Sets the magnification level used by Text View, from
1x to 36x.

e Rate. Controls how fast ZoomText speaks.



160

Ticker. Displays a single line of text. When reading, text scrolls
horizontally like a ticker tape.

Prompter. Displays multiple wrapped lines of text that do not
exceed the width of the Text View screen. When reading, text
scrolls vertically like a teleprompter.

App View. Switches AppReader from Text View to App View.

Settings. Opens the AppReader dialog box to change the Text
View settings.
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Starting and Using AppReader

There are a variety of ways to launch AppReader into the various
AppReader modes, including menu selections or hotkeys. These
methods are described below, including the unique behaviors of each
mode.

= To launch AppReader using the Read from Pointer command

e Position the mouse pointer over the word where you want to start
reading, then press the Read from Pointer command: Caps Lock +
Alt + Left-Click

AppReader launches in the selected mode and begins reading at the
clicked on word. To stop reading, click or press Enter. To start reading,
double-click (on any word) or press Enter. For complete instructions
on reading with AppReader, see "Reading with AppReader” below.

= To launch AppReader directly into App View or Text View

e Choose Use App View or Use Text View menu item in the
AppReader button menu, or press one of the following hotkeys:

o Launch App View: Caps Lock + Alt + A
o Launch Text View: Caps Lock + Alt+ T

AppReader launches in the selected mode and begins reading from the
current text cursor position. If a text cursor does not exist, AppReader
starts reading at the first visible word that is inside of the magnified
view that is inside of the target window. Otherwise, AppReader starts
reading at the first visible word in the target application. For complete
instructions on reading with AppReader, see "Reading with
AppReader” below.

= To launch the SpeaklIt Tool

e Choose Use Speaklt Tool in the AppReader button menu, or
press the Launch SpeaklIt Tool hotkey: Caps Lock + Alt + S

The SpeakIt Tool becomes active.
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= To launch AppReader in the selected mode, (the mode selected
in the AppReader menu)

e On the Reader toolbar tab, select the AppReader button, or press
the Launch AppReader hotkey: Caps Lock + Alt + R

AppReader will launch in the selected AppReader mode.

Reading with AppReader
= To start and stop automatic reading

Press Enter or double-click on the word where you want to start or
resume reading.

= To skim read by word, line, sentence and paragraph
Use the AppReader navigation commands (listed below).
= To switch between App View and Text View
Press Tab.
= To exit AppReader
Right-click or press Esc.

When AppReader exits, the cursor is automatically positioned at the
last word that was highlighted in AppReader, if a cursor exists in the
application.
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AppReader Navigation Commands

The following hotkeys can be used to launch the AppReader.

Command Hotkeys

Launch AppReader from Caps Lock + Alt + Left-Click
Pointer

Launch App View Caps Lock + Alt+ A

Launch Text View Caps Lock + Alt+ T

Launch SpeaklIt Tool Caps Lock + Alt+S

Launch AppReader Caps Lock + Alt + R
(selected mode)

While the AppReader is active, the following modal keys can be used to
operate the AppReader.

Command Modal Keys

Next Word Ctrl + Right

Previous Word Ctrl + Left

Next Sentence Right

Previous Sentence Left

Next Paragraph Down

Previous Paragraph Up

Next Page Page Down

Previous Page Page Up

Current Word * Ctrl + Alt + Shift + Up
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Current Line Ctrl + Alt + Shift + Right
Current Sentence Ctrl + Alt + Shift + Down
Current Paragraph Ctrl + Alt + Shift + Left
First Word On Line Home

Last Word On Line End

Beginning of Document Ctrl + Home

End of Document Ctrl + End

Next Link L

Previous Link Shift + L

Execute Link Ctrl + Enter

* When using the Current Word command, repeated presses within two

seconds provides the following behavior:

e First press: speaks the word

e Second press: spells the word

e Third press: spells the word phonetically ("Alpha, Bravo, Charlie,

)
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App View Settings

The App View settings allow you to customize the appearance of word
highlighting in AppReader, including the highlight shape, color, and
transparency level.

= To adjust the App View settings

1. On the Reader toolbar tab, choose AppReader > App View
Settings.

The AppReader Settings dialog appears with the App View tab
displayed.

2. Adjust the App View settings as desired.
3. Click OK.
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SppReader Settings

App Wiew Text Visw Shared Settings

Options
Track and highlight words!
[ 1Exit &pp Yiew at end of document:

Highlight
Shape Thickness

Frarme ™~ Thin . Thick,

Color Transparency

| M red - Clear . Solid

Highlight Tracking
Edge '

Preview

Sample App View Text

Cancel Help

The App View tab

Setting Description

Options

Track and highlight Enables tracking and highlighting of words
words when AppReader is reading.

Exit App View at end of | When enabled, AppReader will automatically
document exit after reading to the end of the document.

Note: AppReader will not automatically exit
when manually navigating to the end of a
document.




Chapter 6—Reader Features 167

Highlight

Shape

Sets the shape used to highlight words: Block,
Underline, Frame, or Wedge.

Color

Sets the highlight color.

Thickness

Sets the thickness of the highlight shape.

Transparency

Sets the transparency of the highlight.

Note: This setting is not available when the
highlight color is set to 'Invert.".

Highlight Tracking

Sets the tracking type: Edge, Center or Jump
Ahead. With Edge alignment, the zoom window
only scrolls as needed to keep the highlighted
word in view. With Center alignment, the zoom
window scrolls as needed to keep the
highlighted word in the center of the zoom
window. With Jump Ahead, when the
highlighted word exits the magnified view, the
zoom window scrolls to bring the highlighted
word to the upper left corner.

Preview

Displays sample text with a preview of the
selected highlight settings.

Note: Additional settings for App View are available in the Shared

Options tab.
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Text View Settings

The Text View settings allow you to customize the appearance of text
and word highlighting in the Text View environment.

= To adjust the Text View settings

1. On the Reader toolbar tab, choose AppReader > Text View
Settings.

The AppReader Settings dialog appears with the Text View tab
displayed.

2. Adjust the Text View settings as desired.
3. Click OK.
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SppReader Settings

App View Tent Yiew Shared Settings
Fanks
Font Skyle
Calibri W Regular W

Document Colors

Texk Background
O white v| |l Black v

Format Marks
[]5how paragraph marks: 1
[ ]underline links
Highlight
shape
Block ~

Color
| . Magenta e

Highlight Tracking

Center w

Presview

Sam F:||E Text Wiew

Cancel Help

The Text View tab

Setting Description

Fonts
Font Sets the font type that the captured document
will be displayed in, such as Arial, Tahoma, or
Verdana.
Style Sets the font style that the captured document
will be displayed in, such as Regular, Bold or
Italic.
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Document Colors

Text Selects the text color that the captured
document will be displayed in. The text and
background cannot be set to the same color.

Background Selects the background color for the Text View.
The text and background cannot be set to the
same color.

Format Marks
Show paragraph marks | Displays paragraph marks where paragraphs

end in the source document.

Underline links

When selected, hypertext links are underlined in
the Prompter and Ticker view.

Highlight
Shape Selects the shape used for word highlighting:
Block, Underline, Frame, or Wedge.
Color Sets the color of the word highlight.
Thickness 1, 2 Sets the thickness of the word highlight.

Transparency 2

Sets the transparency of the word highlight.

Highlight Tracking

Sets the tracking type: Edge, Center or Jump
Ahead. With Edge alignment, The Text View
scrolls as needed to keep the highlighted word
in view. With Center alignment, Text View
scrolls as needed to keep the highlighted word
in the center of the zoom window. With Jump
Ahead, when the highlighted word exits the
view, Text View scrolls to bring the highlighted
word to the upper left corner.
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Preview Displays sample text using the selected font,
color and highlight settings.

1 This setting is not available when highlight shape is set to 'Block'.

2 This setting is not available when highlight shape is set to 'Block' or
highlight color is set to 'Invert'.

Note: Additional settings for Text View are available in the Shared
Options tab.
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Shared Settings

Shared Settings provide additional settings that are shared by App View
and Text View. You can set a special reading rate for AppReader and
enable special audible cues.

= To adjust the Shared Settings
1. On the Reader toolbar tab, choose AppReader > Shared Settings.

The AppReader Settings dialog appears with the Shared Settings tab
displayed.

2. Adjust the shared settings as desired.
3. Click OK.
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SppReader Settings

App View Teut Yiew Shared Settings

Reading R.ate

AppReader can use the global reading rate (selected on the
Reader toolbar) or the special reading rate chosen below,

[Juse special reading rate!

1a0

Cues

Say "Beqginning of document” and "End of document”

Cancel Help

The Shared Settings tab

Setting Description

Reading Rate

Use special reading rate | When selected, AppReader's reading rate is set
independent of the global Rate setting on the
Reader toolbar tab and in the Voice Settings
dialog box.

Rate Controls the reading rate for AppReader.

Note: This setting is disabled when Use special
reading rate is not enabled.
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Cues

Say "Beginning of
document" and "End of
document"

The words "beginning of document” and "end of
document" are spoken when App View and
Text View have navigated to the beginning or
end of a document.
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Reading Zones

Reading zones let you instantly see and hear selected locations in an
application window. For example; your database application may
display a dozen or more fields of information. In your normal work flow
you may be interested in only a few of these fields. With reading zones,
you can instantly see and/or hear these select fields with the press of a
hotkey.

You can create up to 10 reading zones for each of your applications. As
you open and switch applications, zones defined for the active
application are automatically loaded and ready to use.

e Creating, Editing and Deleting

e Using Reading Zones

e The Reading Zones Toolbar

e Reading Zones Settings
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Creating, Editing and Deleting Reading Zones

Creating a new reading zone is a straightforward process. For most new

zones, you simply define the zone area, type in a descriptive zone name,
and choose to have the zone displayed, spoken or both. You can always
edit or delete the zone later, so there's no need to worry about mistakes.

= To create a new reading zone

1.

Open the application in which you want to create a reading zone.
Make sure the desired application tab, view or window is
displayed.

Activate the Create Zone Tool by doing one of the following:
e Switch to the ZoomText user interface. On the Reader toolbar
tab, select Zones > New.
e Press the Create Zone hotkey: Caps Lock + Alt + C.

The Create Zone Tool becomes active and all existing zones for the
active application are displayed.

Move the mouse pointer to scroll the new zone area into view.

Hold down the left button, drag the selection rectangle over the
desired zone area and release the button.

When you complete the drag by releasing the mouse button, the
Reading Zones dialog appears. This dialog allows you to name the
zone and select zone options. For information on the Reading Zones
dialog, see Reading Zones Settings.

In the Zone Name box, type a descriptive name for the new zone.

When you navigate to the next dialog control, the new zone name will
appear in the Zones list.

Under Zone is relative to, select the zone's relative position within
the application window.

Under Zone Actions, select the desired options.
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8. To test the new zone, click Trigger.

The Reading Zones dialog is temporarily hidden while the zone is
displayed and/or spoken according to the selected settings.

9. To create additional zones, click New Zone and repeat steps 4
through 9.

10. When you're finished creating and editing zones, click OK.
= To edit a reading zone

1. Open the application that contains the reading zone that you want
to edit.
2. Activate the Edit Zones Tool by doing one of the following:
e Switch to the ZoomText user interface. On the Reader toolbar
tab, select Zones > Edit.
e Press the Edit Zones hotkey: Caps Lock + Alt + E.
The Edit Zones Tool becomes active and all existing zones for the

active application are displayed. The Reading Zones toolbar appears
over the active zone.

3. Move the mouse pointer to scroll the desired zone into view, or
click the Next or Previous buttons on the Reading Zones toolbar to
bring the desired zone into view.

Note: The Next and Previous buttons are grayed if only one zone
has been defined.

4. Click inside the zone to activate the sizing handles and toolbar,
then adjust the zone as follows:
e To size the zone, drag any handle.
e To move the zone, drag inside the zone frame.

e To test reading of the zone, click the Play button.
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5. To move to another zone, press the number of the desired zone, or
click the Next or Previous buttons.

6. To edit another zone, repeat steps 3 and 4.

7. To exit the Edit Zones tool, right-click or press Esc.
= To delete a reading zone
1. On the Reader toolbar tab, select Zones > Settings.
The Reading Zones dialog appears.

2. In the Show zones defined for combo box, select the application
that contains the zone you wish to delete.

The Zones list updates to display zones associated with the selected
application.

3. In the Zones list box, select the zone you wish to delete.

4. Click Delete.
The deleted zone is removed from the Zones list.

5. To delete another zone, repeat steps 2 through 4.
6. When you're finished deleting zones, click OK.
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Using Reading Zones

Once you've created reading zones for an application, you can use them
any time the application is active. You can trigger a single zone at a time
(via menu or hotkey), or enter a mode that allows you to navigate
through all of the reading zones.

= To trigger a specific reading zone
1. Open the application that contains the reading zones you want to
trigger.
2. To trigger the desired zone, do one of the following:
e Switch to the ZoomText user interface. On the Reader toolbar
tab, select Zones > Trigger > {zone number}.

e Press the Trigger Zone hotkey: Caps Lock + Alt + {Zone
number}.

e Press the List Zones hotkey: Caps Lock + Alt + L, then select
the desired zone from the menu.

e Use the Next and Previous Reading Zone hotkeys:

Next Zone: Caps Lock + Alt + N
Previous Zone: Caps Lock + Alt + P

The selected reading zone is displayed and/or spoken according to the
zone settings.

Each applications set of reading zones are numbered 1 through 10.
Reading zone hotkeys correspond to these numbers. For example,
the hotkey for reading zone 1 is Caps Lock + Alt + 1, reading zone
2 is Caps Lock + Alt + 2, and so on.

Note: The hotkey for reading zone 10 is Caps Lock + Alt + 0.
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= To navigate through all reading zones

1.

Open the application that contains the reading zones you want to
navigate.

To active the Navigate Zones mode, do one of the following:

e On the Reader toolbar tab, select Zones Navigate.
e Press the Navigate Zones hotkey: Caps Lock + Alt + G

Navigate Mode becomes active and the Reading Zones toolbar appears
over the first active zone. The zone name and number are spoken.

To start and stop reading of the zone, click the Play/Pause button.

Note: The Play/Pause button is disabled (grayed-out) when
navigating to non-spoken zones.

To navigate to another zone, click the Next and Previous buttons.

To exit Navigate Mode, right-click or press Esc.
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The Reading Zones Toolbar

The Reading Zones toolbar appears over the active reading zone
whenever you access reading zones. The toolbar provides controls for
navigating and reading the defined zones.

1D KM X 1D X

Reading Zones toolbar: Reading Zones toolbar:
Edit and Navigate modes Trigger mode

p
Il

Play/Pause/Stop. Starts and stops reading. When Play mode
is executed, the Pause or Stop button appears on the toolbar,
according to the mode that is active. The Pause button
appears in Trigger and Navigate modes where you can pause
and restart reading at the highlighted word. The Stop button
appears in Edit mode where reading always restarts at the
first word in the zone.

Shortcut Key: Enter

4

Previous. Activates the previous reading zone.
Shortcut Key: Shift + Tab
Note: This button does not appear in 'Trigger' mode.

Pl

Next Activates the next reading zone.
Shortcut Key: Tab
Note: This button does not appear in 'Trigger' mode.

Close Exits the Reading Zone mode.
Shortcut Key: Esc
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Reading Zones Settings

The Reading Zones settings allow you to create, examine and edit
reading zones. When activated, the Reading Zones dialog displays a list
of zones that have been defined in the current application. By selecting a
zone in the Zones list, you can modity its settings, trigger the zone, or
delete the zone. You can also create new zones or navigate through all
zones in the current application.

For complete information on creating, editing, navigating and triggering
zones, see Creating and Editing Reading Zones and Using Reading
Zones.

= To adjust the reading zone settings
1. In the Reader toolbar tab, choose Zones > Settings.
The Reading dialog appears with the Zones tab displayed.

2. Adjust the reading zone settings as desired.

3. Click OK.
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Reading Zones

Show zones defined For:

Microsaft Ward W

Zones Zone Mame
1. My First Zone | My Firsk Zone

Zone is relative to

(®) Top-left

() Top-right
() Bottom-left
() Botkom-right
O Center

, Z Ak
Hatkey: | Caps Lock + Al + 1 | HnE ALLINS

() Speak text in zane

Edit Delete Trigger () Display zane

(®) Display and speak zone
Highlight zome Far:

Mew Zone Mavigake Zones 1 second

*

Feturn ko previous location
Dim area outside of zone

Cancel Help

The Reading Zones dialog box.

Setting Description

Show zones defined for Displays a list of applications that are currently
running. Zones associated with the selected
application appear in the Zones list box.

Zones Displays a list of zones associated with the
selected application, selected in the Show zones
defined for: list box).

Hotkey Displays the hotkey for the selected zone.

Edit Activates the Edit Zone tool. When activated,
the Reading Zones dialog is hidden and zones
associated with the selected application appear.
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The Edit Zone tool also appears allowing you to
size and move any of the zones.

Delete

Deletes the selected zone.

Trigger

Triggers the selected zone. When triggered, the
Reading Zones dialog is hidden and the selected
zone is displayed and spoken according to its
zone settings. Afterward, the Reading Zone
dialog reappears.

New Zone

Activates the New Zone tool. When selected, the
Reading Zones dialog is hidden and zones
associated with the selected application appear.
The New Zone tool also appears allowing you
to create a new zone.

Navigate Zones

Activates the Zone Navigation mode. When
activated, the Reading Zones dialog is hidden
and the selected zone and Navigation toolbar
appear. Using the toolbar controls or keyboard
commands, you can start and stop reading of
the zone, and navigate to the next or previous
zone.

Zone Name

Allows you to type a meaningful name for the
selected zone. Zone names appear in the Zones
list box in the Readings Zones dialog. They also
appear in the Reading Zones menu (when
pressing the Reading Zones List hotkey: Caps
Lock + Alt + L) and when clicking Zones

> Trigger on the Reader toolbar tab.
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Zone is relative to

top-left, top-right,
bottom-left, bottom-
right, or center

Sets the relative position of the zone within the
application window. This keeps the zone in the
correct location even when the application
window has been resized or moved.

Note: In some cases, when resizing an
application window, controls within the
window may also be resized. When this occurs,
you may need to resize the individual zones.

Zone Actions

Speak text in zone

When the reading zone is triggered, all text
within the zone is spoken.

Display zone When the reading zone is triggered, the zone is
scrolled into view and highlighted.

Display and speak zone | When the reading zone is triggered, the zone is
scrolled into view, highlighted and spoken.

Highlight zone for Sets the amount of time (in seconds) that the

reading zone is highlighted.

Note: Highlighting only occurs when Scroll to
zone is selected.

Return to previous
location

After the zone is displayed, ZoomText scrolls
back to the location that was in view prior to
triggering the zone.

Dim area outside of
zone

When a reading zone is triggered, the area
outside of the reading zone is dimmed.
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Reading with the Text Cursor

Text cursor reading commands let you navigate and read while creating and

editing documents, by word, line, sentence or paragraph. When using these
commands, the text cursor moves in accordance with the command. For

example, when pressing the Say Next Sentence command, the cursor moves to

the beginning of the next sentence and the entire sentence is spoken. The

following table lists the text cursor reading commands.

Command Hotkey Layered Keys
Say Previous Character Left N/A
Say Next Character Right N/A
Say Previous Word Ctrl + Left N/A
Say Next Word Ctrl + Right N/A
Say Previous Line 3 Up N/A
Say Next Line 3 Down N/A
Say Previous Sentence Caps Lock + Alt + Left N/A
Say Next Sentence Caps Lock + Alt + Right N/A
Say Previous Paragraph Ctrl + Up N/A
Say Next Paragraph Ctrl + Down N/A
Say Current Character 1 Ctrl + Alt + Shift + Enter N/A
Say Current Word 2 Ctrl + Alt + Shift + Up N/A
Say Current Line Ctrl + Alt + Shift + Right N/A
Say Current Sentence Ctrl + Alt + Shift + Down N/A
Say Current Paragraph Ctrl + Alt + Shift + Left N/A
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1 Second press of the Say Current Character command speaks the
character phonetically: "Alpha, Bravo, Charlie, ...".

2 Repeated presses of the Say Current Word command provide the
following behavior:

e First press: speaks the word

e Second press: spells the word

e Third press: spells the word phonetically: "Alpha, Bravo, Charlie,

"

Note: Repeated presses must occur within two seconds.

3 This command reads the current word or entire line according to the
Program Echo setting When the text cursor moves into a new line.

In addition to the Text Reading commands listed above, ZoomText will also
speak when using standard text navigation and editing keys, listed in the
following table.

Application Action ZoomText Action

Backspace Deletes the character to | Speaks the deleted character.
the left of the cursor.

Delete Deletes the character to | Speaks the new character to the
the right of the cursor. right of the cursor.

Home Moves the cursor to the | Speaks the first word on the line
beginning of the line. (or nothing if the line begins with
a space or tab).

End Moves the cursor to the | Speaks "End of line."
end of the line.

Page Up Pages the application Speaks the word or line that the
window up. cursor appears on, according to
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the program echo setting When
the text cursor moves to a new
line.

Page Down Pages the application Speaks the word or line that the
window down. cursor appears on, according to
the program echo setting When
the text cursor moves to a new
line.
Ctrl + Home | Moves to beginning of Speaks the word or line that the
the document. cursor appears on, according to
the program echo setting When
the text cursor moves to a new
line.
Ctrl + End Moves to the end of the | Speaks the word or line that the

document.

cursor appears on, according to
the program echo setting When
the text cursor moves to a new
line.
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Say Commands announce miscellaneous desktop and application elements on
demand. By default, these commands do not have assigned hotkeys and must
be triggered using layered key commands. However, hotkeys may be

assigned in the Command Keys dialog box.

Command \ Hotkey Layered Keys

Say Current Date Unassigned Caps Lock + Spacebar, Y, D
Say Current Time Unassigned Caps Lock + Spacebar, Y, T
Say Cell Column Title Unassigned Caps Lock + Spacebar, Y, C
Say Cell Comment Unassigned Caps Lock + Spacebar, Y, N
Say Cell Formula Unassigned Caps Lock + Spacebar, Y, O
Say Cell Row Title Unassigned Caps Lock + Spacebar, Y, R
Say Clipboard Unassigned Caps Lock + Spacebar, Y, P
Say Dialog Default Button Unassigned Caps Lock + Spacebar, Y, B
Say Dialog Group Name Unassigned Caps Lock + Spacebar, Y, G
Say Dialog Message Unassigned Caps Lock + Spacebar, Y, M
Say Dialog Tab Unassigned Caps Lock + Spacebar, Y, A
Say Focus Unassigned Caps Lock + Spacebar, Y, F
Say Selected Text Unassigned Caps Lock + Spacebar, Y, S
Say Status Bar Unassigned Caps Lock + Spacebar, Y, U
Say Windows Title Unassigned Caps Lock + Spacebar, Y, W
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Chapter 7
Tools Features

"Tools Features" represent extra productivity tools that are available on
the "Tools" toolbar tab, including the Finder, Camera, Background
Reader and Recorder.

e The Tools Toolbar Tab

e Finder
e (Camera

e Background Reader

e Recorder

Note: The Background Reader and Recorder features are not available
in ZoomText Magnifier.
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The Tools Toolbar Tab

The Tools toolbar tab provides quick-action buttons for launching
ZoomText's Tools features. Many of these buttons are split-button
controls that allow you to toggle the feature on and off and open a menu
of related settings. The buttons are grouped by category and have
intuitive icons and labels for easy identification.

ZoornText MagnifierfReader - X

bagnifier Reader Tools

%@@El

Flnder Camera | Background Recorder
- Reader -

Finder Carnera Listening

The Tools toolbar tab.

Note: The Background Reader and Recorder only appear in ZoomText
Magnitier/Reader.

e Finder. Launches the Finder to search, skim, navigate and read
text in documents, web pages and email.

e Camera. Launches the ZoomText Camera feature, when a
supported camera is connected and available to ZoomText.

e Background Reader. Launches the Background Reader with text
captured from the Windows Clipboard.

e Recorder. Launches the ZoomText Recorder with text captured
from the Windows Clipboard.
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Finder

The Finder allows you to swiftly search, skim, navigate and read
documents, web pages and email. You can search for words or phrases
to find topics of interest. When you have found a topic of interest you
can have Finder start reading from that location. Finder can also find
and execute links and controls allowing you to seamlessly navigate
between pages. All of these actions are performed using the Finder’s
toolbar/dialog and command keys.

Note: The Voice and AppReader features are not available when
running the Finder in ZoomText Magnifier.

Finder provides two modes for searching pages: Page Search and List
Search. These modes and how to switch between them are described in
the sections below.

Note: Finder can be used in a variety of document based applications,
including Internet Explorer, Chrome, Firefox, Microsoft Word and
Microsoft Outlook.

Starting Finder
= To start Finder
Do one of the following;:

e On the Tools toolbar tab, click the Finder button.
e Press the Launch Finder hotkey: Caps Lock + Ctrl + F

The Finder toolbar/dialog appears.
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Page Search

Page Search displays a simple toolbar where you can type a word or
phrase that you want to find, and then use toolbar controls or keyboard
commands to navigate through all of the instances on the page. You can
also limit the page search to specific web page elements such as
headings, links or controls.

hﬁ- ZoomText Finder

Al Text  ~ | ZoomText e |

4 M

Previous Mext

Wil =

Execute  AppReader List

Page lterns Search

Finder: Page Search toolbar.

= To use Page Search

1. If Finder is currently in List Search mode, click the List button to
switch to Page Search mode.

2. Select the type of Page Items that you want to search. Choose All
Text, recommended for most searches, to search for words or
phrases anywhere on the page, including hidden labels for images
and controls.

3. In the Search box, type a word or phrase that you want to find.

If the word or phrase does not exist in the selected type of page item the
Search box will turn orange and the navigation buttons will be
disabled.

Note: When Page Items is set to All Text, you must type at least
one character in the Search box to initiate a search. When Page
Items is set to any other type, you can navigate through those
items without entering a search word or phrase.
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Click the Next and Previous buttons to navigate forward and
backward through the matching items.

As you navigate each item is highlighted. When using ZoomText
Magnifier/Reader with Finder speech enabled, the sentence containing
the item is announced.

To have Finder execute a link or control in the current item, click
the Execute button.

To have Finder start reading at the current item, click the
AppReader button. *

To enable and disable Finder speech output, click the Speech
button. *

To exit Finder, click the Exit button in the title bar.

* In ZoomText Magnifier, the AppReader and Speech options are not
available so these buttons are disabled (grayed out).

List Search

List Search expands the toolbar into a dialog that displays a list of
headings, links, controls and other common elements that are located in
the page. You can search, filter and sort the list to quickly locate an item
of interest.
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h-'i FoomText Finder

Page lterns Search SppReader List

Lisk Search displays resulks matching the Page Items setting and Search kext,

ZoormText b | iq bi @

Items found: 4 Sort by | Type “ Refresh List
Mame Tvpe
ZoomText | ZoomText Lago Mavigation Section: Banner Landmark
Helping people is our priority.  Our mankra is “Weve got accessibiliby covered” a...  Section: Complement. ..
Products to meet vour needs.  We understand that accessibility needs chang. .. Section: Complement., ..

ZoomText is the world’s leading magnification and screen reading software for th,.,  Section: Main Landmark,

Hide unnamed images Sektings. ..

Close Help

Finder: List Search toolbar/dialog

= To use List Search

1.

If Finder is currently in Page Search mode, click the List button to
switch to List Search mode.

In the Page Items combo box, select the type of items that you
want to view in the Items found list.

To search (or filter) the list, type a word or phrase in the Search
box.

As you type in the Search box the list is automatically filtered to
display only items that contain the search string. The Search box turns
orange when the typed word or phrase does not exist within the list of
items.
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Select the desired sorting order in the Sort by list box. You can also
sort the list by clicking on the Name and Type headings at the top
of the list.

To have Finder start reading from the selected item, click the
AppReader button. *

To have Finder execute an item that contains a link or control,
click the Execute button.

To have Finder go to the location of the selected item, click the
GoTo button.

To exit Finder, click the Exit button in the title bar.

* In ZoomText Magnifier, the AppReader option is not available so this
button is disabled.

= Refreshing the list in List Search

Some web pages contain areas of dynamically changing content, such
as the top headlines on news sites or sports scores. When Finder starts
or switches to List Search, it captures the current page content to
populate the list and then ignores subsequent dynamic changes. If
you know that a web page has been dynamically updated and you
want to update the Found items list, click the Refresh List button.

= Hiding unnamed images in List Search

Many web pages contain images that are unnamed and ambiguous to
the viewer. To keep these unnamed images from cluttering up the
Found items list, place a checkmark next to Hide unnamed items
check box.
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Finder Command Keys
The following hotkey can be used to launch the Finder.

Command

\ Hotkeys

Launch Finder Caps Lock + Ctrl + F

The following layered keys can be used to launch the Finder.

Command

Layered Keys

Launch Finder Caps Lock + Spacebar, F

While the Finder is active, the following modal keys can be used to operate
the Finder.

Command \ Keys

Cycle Page Items Type Up Ctrl + Up
Cycle Page Items Type Down Ctrl + Down
Execute Item Ctrl + Enter
First Item (in filtered list) Ctrl + Home
Last Item (in filtered list) Ctrl + End
Next Control Ctrl + C
Next Form Ctrl + F
Next Heading Ctrl + H
Next Heading Level 1 ... 6 Ctrl+1...6
Next Image Ctrl +1
Next Link Ctrl + L
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Next List Ctrl +S

Next Table Ctrl +T

Next Item Enter OR Ctrl + Right
Previous Control Ctrl + Shift + C
Previous Form Ctrl + Shift + F
Previous Heading Ctrl + Shift + H

Previous Heading Level 1 ... 6

Ctrl + Shift+1 ... 6

Previous Image Ctrl + Shift + 1
Previous Link Ctrl + Shift + L
Previous List Ctrl + Shift + S
Previous Table Ctrl + Shift + T

Previous Item

Shift + Enter OR Ctrl + Left

AppReader Alt+R
Toggle List Search Alt+L
Exit Finder Esc




200

Finder Highlight and Voice Settings

The Finder settings allow you to configure the search highlight and
voice that is used when skimming found items. The highlight makes it
easy to see and follow each found item when using the next and
previous commands. The Finder highlight settings allow you to
customize the appearance of the highlighting including the highlight
shape, color and transparency level. The Finder voice announces each
found item when using the next and previous commands. The Finder
voice settings allow you to enable and disable the announcement of
found items.

= To adjust the Finder Highlight settings

1. On the Tools toolbar tab, click the arrow next to Finder or
navigate to Finder and press the down arrow key.

2. In the Finder menu, choose Settings.
The Finder Settings dialog box appears.

3. Choose the Highlight tab.
4. Adjust the highlight settings as desired.
5. Click OK.
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Finder Settings

H ighlight Waice
Finder Highlight

Transparenc':.-'

Calar Clear . Solid

Thickness

Medium w

Presview

Sample Finder Item

Cancel Help

The Finder Settings Highlight tab.

Setting Description

Finder Highlight

Shape Sets the shape used to highlight the current
search word/phrase or web page item: Block,
Underline or Frame.

Color Sets the highlight color.

Thickness Sets the thickness of the highlight shape.

Transparency Sets the transparency of the highlight.
Note: This setting is not available when the
highlight color is set to 'Invert.'

Preview Displays sample text with a preview of the
selected highlight settings.
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= To adjust the Finder Voice settings

1. On the Tools toolbar tab, click the arrow next to Finder or
navigate to Finder and press the down arrow key.

2. In the Finder menu, choose Settings.
The Finder Settings dialog box appears.
3. Choose the Voice tab.

4. Adjust the voice settings as desired.

5. Click OK.

Finder Settings

Highlight Vaice

Finder Voice

?ﬂnnu:uunu:e each found item when using the
Pext and Previous commands {

Cancel Help

The Finder Settings Voice tab.

Setting \ Description

Finder Voice

Announce each found item Enables and disables announcement of
when using the Next and found items when using any of the Next
Previous commands and Previous commands.
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ZoomText Camera

The ZoomText Camera feature allows you to use any high-definition
webcam to magnify printed items and other objects right on your
computer screen—including bills, magazines, photographs, medicine
labels, craft items and more. Simple controls allow you to quickly zoom
in and out and choose between full and high contrast colors. You can
also switch between Full and Docked screen views which allow you to
see the camera image and your Windows desktop at the same time. And
by utilizing affordable and readily available HD webcams, the
ZoomText Camera feature offers a portable and affordable compliment
or alternative to conventional CCTVs.

ZoomText 11 is a powerful comput ZoomText 10 is a powerful computs
impaired. Consisting of two adapti impaired. Consisting of two adaptiv
screen reading — ZoomText allows screen reading — ZoomText allows

computer screen, providing comp
and the Internet. ZoomText 10 als
standard HD webcam.

ZoomText Camera: Full view ZoomText Camera: Docked View

Getting Started With ZoomText Camera

Before you can use the ZoomText Camera feature you must acquire a
suitable camera and camera stand, set up the camera in your work space
and choose your camera in the ZoomText Camera settings.
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Acquiring a suitable camera and stand

To use the ZoomText Camera feature, you will need an HD webcam
with autofocus. For best quality, your webcam should deliver 1080p
video resolution with automatic low-light correction. An available USB
2.0 port is also required to connect your webcam.

In addition to a camera, you will also need a camera stand that can
securely position the camera over the items you want to view. The stand
should be adjustable and stable.

Freedom Scientific offers high quality webcam and camera stand
packages that are flexible, portable and affordable. For more
information on these packages, visit the Freedom Scientific website at
www.freedomscientific.com, or contact your Freedom Scientific dealer.

Setting up your camera in your workspace

To achieve best performance and usability with the ZoomText Camera
feature, use the following guidelines when setting up your camera in
your workspace:

e Position the camera as close as possible to your computer screen.
This will allow you to easily manipulate items under the camera
while viewing the image.

e Make sure there is sufficient lighting around the camera to
minimize shadows in the camera's view.

e Adjust the camera stand so that the camera is about 4 inches from
the target item.

e Selecting a camera (when more than one camera is present).

ZoomText automatically detects all webcams that are attached or built
into your system. If your computer has more than one webcam, you will
need to tell ZoomText which webcam you want it to use. This setting
resides in the Camera settings in ZoomText's Tools dialog box.
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= To select a camera

1. On the Tools toolbar tab, click the arrow next to Camera or
navigate to Camera and press the down arrow key.

2. In the Camera menu, choose Settings.
The Camera Settings dialog box appears.

3. In the Active Camera list box, choose the camera you want to use.

4. Click OK.

Using ZoomText Camera

Use the following steps to start, configure and use ZoomText Camera.
= To start ZoomText Camera
1. Do one of the following:

e On the Tools toolbar tab, click the Camera button.
e Press the Launch Camera hotkey: Caps Lock + Ctrl + C

The camera image appears in the top half of the screen while
ZoomText's magnified view of the desktop remains on the bottom half
of the screen. The ZoomText Camera toolbar appears in the bottom
half.

2. If the Camera toolbar is not in view, press Caps Lock + Ctrl + C to
engage the camera layered key command mode and then press T
to bring the toolbar into view.

ZoomText Camera

=" o AT
o L 2l B 2g G (B [+
Zoom+ Eull Docked  Rotate Color Clarity Focus

The ZoomText Camera toolbar
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= To rotate the camera image

Place a document under the camera so that it is right-side up from
your perspective. If the document is not oriented right-side up on the
screen, click the Rotate button until the image appears right-side up.

= To zoom the image in and out

Click the Zoom + and Zoom - buttons to adjust the magnification to a
comfortable reading size.

= To adjust the image colors
1. Select the Color button.
The color menu appears.

2. Choose between Normal (full color) and a variety of high-contrast
Two-Color Schemes.

3. To toggle between Normal colors and the selected Two-Color
scheme by pressing Caps Lock + Ctrl + C to engage the camera
layered key command mode and then pressing Alt + Enter to
toggle the color mode.

= To adjust the camera clarity (Brightness/Contrast)
1. Select the Clarity button.

The Camera Clarity dialog appears.

Carnera Clarity

[|Enable brightness and contrast settings:

Brightness I

Contrask I

Resek Cancel
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2. Place a checkmark next to Enable brightness and contrast
settings.

3. Move the Brightness and Contrast sliders to adjust the clarity.

4. Click the Reset button to return the Brightness and Contrast
settings to the camera's defaults.

5. Click OK.

Tip: Use the Brightness setting to eliminate glare spots that are
appearing in the image.

Note: This button will be disabled (grayed out) if the active camera
does not support adjustments to both brightness and contrast.

= To adjust the camera focus
1. Select the Focus button.

The Camera Focus dialog appears.

Camera Focus

Enable manual camera Focus

Focus I

2. Place a checkmark next to Enable manual camera focus.
3. Move the Focus slider to adjust the image focus.

4. Click OK.

Note: This button will be disabled (grayed out) if the active camera
does not support autofocus.
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= To move the docked view location

Click the Docked button. Each click cycles through the docked views
in the following (clockwise) order: Docked Top > Docked Right >
Docked Bottom > Docked Letft.

= To switch between Full and Docked views
Do one of the following:

e To toggle between Full and Docked view, press Caps Lock + Ctrl +
C to engage the camera layered key command mode and then
press Tab to toggle the Docked/Full view.

e From Docked View, on the ZoomText Camera toolbar click the

Full button.

Note: By default, when starting or switching ZoomText Camera
into Full view, a dialog will appear to inform you that the
ZoomText Camera toolbar is not available in Full view. The dialog
also displays a list of hotkeys you can use to operate ZoomText
Camera in Full view (or Docked view). Should you become stuck
in Full view, press Esc to exit the ZoomText Camera.

= To exit the ZoomText Camera
Do one of the following;:

e From Full view, press Esc.

e From Docked view, click the Exit button.
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Camera Video and System Performance

On older computers, when using ZoomText Camera you may
experience slow system and camera video performance when the
camera is configured to run at a higher resolution, particularly at camera
resolutions of 1280 and above. To resolve this problem, lower the
camera resolution until your system and camera video performance is at
an acceptable level. The resolution setting for ZoomText Camera is
located in the Camera tab in ZoomText’s Tools dialog box. See
"ZoomText Camera Settings" below.

ZoomText Camera Settings

The ZoomText Camera settings allow you to configure and launch the
ZoomText Camera.

= To configure the ZoomText Camera settings

1. On the Tools toolbar tab, click the arrow next to Camera or
navigate to Camera and press the down arrow key.

2. In the Camera menu, choose Settings.
The Camera Settings dialog box appears.

3. Adjust the camera settings as desired.

4. Click OK.
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Carnera Settings

Camera
Active Camera
Logitech HD Webcam Ca15 e

Aukomatically sek camera resolution For widest view
Fesalutian Frame R.ate
1920 x 1030 10 FPS e

Moke: Use of both a high resolution and a high frame rate may slow
down overall swstem performance.

Zamera Yiew

Wieww Mode Image Rotation

Docked Top 0 degrees w
Enhancements

Colar Schermne

Mormal e

Advanced Settings
[ ]keep toolbar on top of other windows

Display command instruckions when ackivaking Full wview

Launch Camera

Corcel e

The ZoomText Camera dialog box.

Setting Description

Camera
Active Camera Displays the name of the camera currently being
used by ZoomText and allows you to select a
different camera.
Automatically set ZoomText auto-selects a camera resolution that
camera resolution for provides the closest match to the screen
widest view resolution.




Chapter 7—Tools Features 211

Resolution

Displays the current camera resolution and
allows you to select a specific camera resolution.
To use this setting you must uncheck
Automatically set camera resolution for widest
view.

Note: Use of both a high resolution and a high
frame rate may slow down overall system
performance.

Frame Rate

Displays the current camera frame rate and
allows you to select a specific camera frame rate.

Note: Use of both a high resolution and a high
frame rate may slow down overall system
performance.

Camera View

View Mode

Displays the current camera view and allows
you to select a different view for the ZoomText
Camera.

Image Rotation

Displays the current image rotation of the
camera image and allows you to select a
different image rotation.

Enhancements

Color Scheme

Displays the current color filter setting and
allows you to select a different color filter.
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Advanced Settings

Keep toolbar on top of
other windows

When checked, the Camera toolbar stays in
view (on top of other windows) even when it
does not have focus.

Note: This setting is also available in the system
menu in the Camera title bar (displayed by
clicking the Camera icon in the title bar of the
Camera toolbar).

Display command
instructions when
activating Full view

Enables or disables displaying an alert with
command instructions when switching to Full
view.

Launch Camera

Launches the ZoomText Camera. This button is
grayed out if the ZoomText Camera is already
active.
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ZoomText Camera Command Keys

The following hotkey can be used to launch the ZoomText Camera.

Command Hotkeys

Launch Camera Caps Lock + Ctrl + C

The following layered keys can be used to launch the ZoomText Camera.

Command Layered Keys

Launch Camera Caps Lock + Spacebar, C

While the Camera Toolbar is active, the following modal keys can be used to
adjust the ZoomText Camera settings.

Command Modal Keys

Show Toolbar T

Zoom In Up

Zoom Out Down

Rotate Image Left/Right
Docked/Full Toggle Tab

Docked Position Caps Lock + Left/Right
Clarity On/Off Shift + Enter
Clarity Reset Shift + Backspace
Brightness Increase Shift + Up
Brightness Decrease Shift + Down
Contrast Increase Shift + Left
Contrast Decrease Shift + Right
Two-Color On/Off Alt + Enter
Two-Color Scheme Alt + Left/Right
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Focus Automatic/Manual Ctrl + Enter

Focus In Ctrl + Up

Focus Out Ctrl + Down

Exit X
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Background Reader

Background Reader allows you to copy and listen to documents, web
pages, email or any text while you simultaneously perform other tasks.
You simply copy the text you want to listen to into the Windows
clipboard and start Background Reader. While the text is being read
aloud, you are free to type notes, browse the web or do other work on
your computer.

= To launch the Background Reader

1. Select the text that you want to listen to and copy it to the
Windows Clipboard.
2. Do one of the following to launch the Background Reader:
¢ On the Tools toolbar tab, select the Background Reader
button.
e Press the Launch Background Reader hotkey: Caps Lock +
Ctrl + B

The Background Reader toolbar appears and automatically starts
reading the text that you copied into the Windows Clipboard.

_r: ZoomText Background Reader

4 M

Presious Mext

U @ 9

Capture Play Restart

The Background Reader toolbar

Note: If the toolbar does not appear when starting Background
Reader the "Start toolbar minimized" option has been selected in
the Background Reader settings. To access and disable this setting,
see Background Reader Settings below.
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Once you have started Background Reader you can operate it using
the toolbar or the command keys.

= To bring the Background Reader toolbar into view

Press the Launch Background Reader hotkey: Caps Lock + Ctrl + B,
then press T.

= To operate Background Reader using the toolbar

1.
2.

5.

To start and stop reading, click the Play/Pause button.

To skim forward and backward, click the Next and Previous
buttons.

To restart reading at the beginning, click the Restart button.

To read new text that you have placed in the Windows Clipboard,
click the Capture button.

To exit Background Reader, click the Close button in the title bar.

= To operate Background Reader using command keys

1.

If the Background Reader is not active, press the Background
Reader hotkey: Caps Lock + Ctrl + B

To start and stop reading, press Enter.

To skim forward and backward by next and previous sentence,
press Right or Left.

To skim forward and backward by word, press Ctrl + Right or
Ctrl + Left.

To restart reading at the beginning, press Shift + Enter.

To read new text that you have placed in the Windows Clipboard,
press C.

To exit Background Reader, press X.
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Background Reader Settings

The Background Reader settings allow you to choose how the toolbar
appears when you start and run Background Reader.

= To adjust the Background Reader settings

1. On the Tools toolbar tab, click the arrow next to Background
Reader or navigate to Background Reader and press the down
arrow key.

2. In the Background Reader menu, choose Settings.
The Background Reader Settings dialog box appears.

3. Adjust the Background Reader settings as desired.
4. Click OK.

Background Reader Settings

Toolbar Options

[+]keep toolbar on top of other windows!

[ ]5tart toalbar minimized when launched by hotkey

Cancel Help

The Background Reader dialog box.

Setting Description

Toolbar Options
Keep toolbar on top of The Background Reader toolbar will remain on
other windows top of all other application windows even when

ZoomText is not the active application.

Start toolbar minimized | When Background Reader is started by a hotkey
when launched by (Read Clipboard Text or Read Selected Text), the
hotkey toolbar starts up minimized to the Windows
taskbar.
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Background Reader Command Keys

The following hotkey can be used to launch the Background Reader.

Command \ Hotkeys

Launch Background Reader Caps Lock + Ctrl + B

The following layered keys can be used to launch the Background Reader.

Command Layered Keys

Launch Background Reader Caps Lock + Spacebar, B

While the Background Reader toolbar is active, the following modal keys can
be used to operate the Background Reader.

Command \ Modal Keys

Show Toolbar T

Capture C

Play / Pause Enter

Restart (from the beginning) Shift + Enter

Next Sentence Right

Previous Sentence Left

Next Word Ctrl + Right

Previous Word Ctrl + Left

Current Word Ctrl + Alt + Shift + Up
Current Sentence Ctrl + Alt + Shift + Down
Exit X
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ZoomText Recorder

ZoomText Recorder allows you to turn text from documents, web pages,
email or other sources into audio recordings that you can listen to on
your computer or transfer to your mobile device for listening to on the
go. You simply copy the text you want to record and start ZoomText
Recorder. With a few simple steps you give your recording a friendly
name, choose a destination to record to and click the record button. And
each recording is created using your choice of ZoomText voices or any
other voices available on your system. When choosing iTunes or
Windows Media Player as your destination your recordings are
conveniently placed in a "ZoomText Recorder" playlist. And when using
iTunes your recordings can be automatically synced when you plug in
your iPod, iPhone or other iDevice.

= To record text from the Windows Clipboard
1. Select the text that you want to listen to and copy it to the
Windows Clipboard.
2. Do one of the following to launch the Background Reader:

e On the Reader toolbar tab, select the Recorder button.
e Press the Launch Recorder hotkey: Caps Lock + Ctrl + D

The Background Reader toolbar appears with the text you copied into
the Windows Clipboard.

Completing the Recording Process

When you start ZoomText Recorder its dialog appears with the captured
text ready to record. All you have to do is choose the desired recording
options and select the Record Text button. A progress indicator appears
during the recording process to let you know that it is working. You can
stay and watch the progress indicator or switch to another application
and make better use of your time. A friendly chime will sound when the
recording process is complete.
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Recording times vary depending on the size of the text selection, chosen
synthesizer, destination and speed of the system. However, our general
rule of thumb for recording time is about 5 to 10 seconds per page of
text.

Note: When "Record text to:" is set to iTunes the iTunes application will
open at the end of the recording process.

n ZoomText Recorder

IJse ZoomText Recorder to convert selected or copied kext into an audio
recording in iTunes, Windows Media Plaver or a selected folder,

Record kext ko

FIlE L

Track, Mame Track Type
| Helping people is our priarity | W e
Track Location

| Vivmware-hostl shared FoldersiDeskiop |

Record Text

Preview and Capture

Listen ko Preview Helping people is aur priority,

Capture Clipboard

Hide Swvnthesizer Settings Close Help
Synthesizer Setkings
Language English >~
Synthesizer | ZT English, United States (Kate) w
Vaice Kate e
Fate Pitch Wolurne

o 0% - 100% =

The ZoomText Recorder dialog box.
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Description

Record text to:

Selects the destination for your recording. Choices are
iTunes, Windows Media Player or to a file. Note:
iTunes and Windows Media Player will not appear in
the list if they are not installed on the system.

Track Name

Allows you to type a meaningful name for your
recording. Each time new text is captured the track
name is automatically set to the first 5 words of the
captured text. You can type over this text. Note:
Invalid file naming characters are replaced with the
underscore character.

Track Type

Selects or displays the type of audio file format in
which the recorded text will be saved.

o If "Record Text To" is set to File, you can choose
WAV or WMA.

e If "Record Text To" is set to iTunes, the audio file
is automatically set to MP3.

e If "Record Text To" is set to Windows Media
Player, the audio file is automatically set to
WMA.

Track Location

Displays the current folder location where the audio
file will be saved and allows you to enter a new
folder location. Note: The control is disabled (grayed
out) when the Track Location is set to iTunes —
because the location is predefined for iTunes.

Browse...

Opens a Windows Explorer dialog for selecting a
location to save the audio file. Note: The button is
disabled (grayed out) when the Track Location is set
to iTunes.
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Record Text

Initiates the recording process. During the recording
process this button changes to "Cancel Recording".

Preview and Capture

Listen to Preview /
Cancel Preview

Speaks up to the first 400 words of the captures text.
During the preview this button changes to "Cancel
Preview".

Capture Clipboard | Captures the text currently in the Windows
Clipboard (replacing the previously captured text).

Show / Hide Expands and collapses the section of the ZoomText

Synthesizer Recorder dialog that contains the synthesizer settings.

Settings

Synthesizer Settings

Language Displays a list of speech synthesizer languages
available on your system.

Synthesizer Displays a list of available synthesizers on your
system. Note: ZoomText supports SAPI 4 and SAPI 5
based speech synthesizers.

Voice Displays a list of available voices in the selected
synthesizer.

Rate Adjusts the voice rate (if supported by the
synthesizer).

Pitch Adjusts the voice pitch (if supported by the
synthesizer).

Volume Adjusts the voice volume (if supported by the

synthesizer).
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Configurations

All ZoomText settings can be saved and restored using configuration
tiles. Configuration files control all ZoomText features; including
magnification level, the zoom window type, screen enhancements,
reading options, application settings and hotkeys. There is no limit on
the number of configuration files that you can save, so feel free to create
and use as many as you like. You can also create application specific
settings that automatically load each time the application becomes
active.

e The Default Configuration

e Saving and Loading Configurations

e Configuration Hotkeys

e Application Settings
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The Default Configuration

When you start ZoomText, the default configuration file, ZT.ZXC, is
automatically loaded. This file contains the built-in defaults for all
ZoomText settings. You can create your default configuration, which
will load your custom settings whenever ZoomText is run. Don't worry
about losing the built-in settings; the original default file can be easily
restored.

= To save a custom default configuration

1. Set all ZoomText features as desired.

2. In the ZoomText menu, choose Configurations > Save As
Default.

A dialog appears prompting you to confirm saving the configuration.
3. Select Yes to overwrite the current default configuration.
= To restore the original default configuration file

1. In the ZoomText menu, choose Configurations > Restore Factory
Defaults.

A dialog appears prompting you to confirm restoring the
configuration.

2. Select Yes to overwrite the current default configuration.
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Saving and Loading Configurations

The current ZoomText settings can be saved to a configuration file at
any time. This configuration file can be loaded at a later time and the
saved settings will take effect immediately.

= To save settings to a configuration file

1. Set all ZoomText features as desired.

2. In the ZoomText menu, choose Configurations > Save Custom
Configuration.

The Save Configuration dialog box appears displaying the existing
configuration files.

3. Type the name of the new configuration in the File name: box.

4. Click OK.
= To load settings from a configuration file
1. In the ZoomText menu, choose Open Custom Configuration.

The Open Configuration dialog box appears displaying the existing
configuration files.

2. Highlight the desired configuration file.
3. Click Open.
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Configurations Hotkeys

You can use hotkeys to load configuration files, without activating the
ZoomText user interface. Before a configuration hotkey can be used, a
configuration file must be assigned to it. The following table lists the default
configuration hotkeys. For information on assigning configurations to
hotkeys, see " To assign a configuration file to a Load Configuration
command" in The Command Keys Dialog.

Setting \ Description

Load Configuration File 1 Caps Lock +1
Load Configuration File 2 Caps Lock +2
Load Configuration File 3 Caps Lock +3
Load Configuration File 4 Caps Lock + 4
Load Configuration File 5 Caps Lock +5
Load Configuration File 6 Caps Lock + 6
Load Configuration File 7 Caps Lock +7
Load Configuration File 8 Caps Lock + 8
Load Configuration File 9 Caps Lock +9
Load Configuration File 10 Caps Lock + 0
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Application Settings

Within each ZoomText configuration, you can define custom settings for
each application that you use. For example, you can have ZoomText
display your web browser at one magnification level and your word
processor at another. Whenever these applications become active their
application settings are automatically restored. Applications for which
settings have not been defined are displayed and spoken according to
the default settings of the configuration file.

= To define and save application settings

1. Open the application for which you want to define custom
settings.

2. Use the ZoomText command keys to select the desired ZoomText
settings or switch directly to the ZoomText toolbar to select the
desired settings.

3. Press the Save Application Settings hotkey: Caps Lock + Ctrl + 5,
or on the ZoomText toolbar, choose ZoomText > Application
Settings > Save Application Settings.

A dialog prompts you to save the application settings.

4. Click Yes to save the settings.

At any time, you can disable or delete application settings. Disabled
application settings remain in your configuration and may be re-enabled
at any time. Deleted application settings are removed from your
configuration.
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= To disable or delete application settings

1.

Press the Manage Application Settings hotkey: Caps Lock + Ctrl +
M, or on the ZoomText toolbar, choose ZoomText > Application
Settings > Manage Application Settings.

The Manage Application Settings dialog appears.

To disable application settings; in the Use application Settings for
list box, uncheck the desired applications.

The selected application remains in the list, but application settings
are not invoked when using the application.

To delete application settings, select the desired application, and
then choose Delete Selected.

The selected application is removed from the list.

Click OK.

Marage Application Settings

Ilse application settings for:

Windows Explarer
Enable All

Disable All

Delete Selected

Cancel Help

The Manage Application Settings dialog.
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Setting Description

Use application settings Displays a list of application settings that have

for: been saved in the current ZoomText
configuration.

Enable All Enables all items listed in the Use Application
Settings for list box.

Disable All Disables all items listed in the Use Application
Settings for list box.

Delete Selected Deletes the selected items in the Use Application
Settings for list box.
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Chapter 9
Preference Settings

Preference settings allow you to control how ZoomText starts and exits,
how ZoomText updates itself and reports errors, the appearance of the
ZoomText user interface, and the type of smoothing that ZoomText
applies in the magnified view.

e Program Preferences

e User Interface Preferences

e Smoothing Preferences

e Run ZoomText As
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Program Preferences

Program preferences control how ZoomText starts and exits, and allows
you to enable automatic updating.

= To adjust the program preferences
1. In the ZoomText menu, choose Preferences > Program.
The Preferences dialog appears with the Program tab displayed.

2. Adjust the program preference settings as desired.

3. Select OK.

Preferences

Frogram IJzer Interface Smoothing

Logon Suppork

[ ]Enable ZoomText in the Windows logon prompt;

Skartup Setkings

[]start ZoomText automatically when Windows starts
[ ] 5tart ZoomTe:xk with the toolbar minimized

Display the "welcome" window when ZoomText starts
Display a ZoomText icon on the deskiop

Exit Settings

[ ]5ave ZoomText settings automatically when exiting
Prompt to confirm intent to exit ZoomTexk

Unload magnification process when exiting ZoomText

Automatic Updating

Check for online updates each time ZoomText is launched

Error F.eporking

[ ]Report ZoomText errors ko Freedom Scientific via the Inkernet

Cancel Help

The Program tab.
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Setting Description

Logon Support

Enable ZoomText in the | Enables the ZoomText Secure Mode utility in
Windows logon prompt | the Windows logon prompt and other Windows
secure mode prompts. ZoomText Secure Mode
provides essential magnification and screen
reading features in the secure mode prompts.

Startup Settings
Start ZoomText ZoomText will automatically run each time you
automatically when start your system.

Windows starts

Start ZoomText with the | The ZoomText user interface is minimized when
toolbar minimized ZoomText is started.

Display the “Welcome” | Each time ZoomText is started the Welcome

window when window appears along with the ZoomText

ZoomText starts toolbar. The Welcome window displays
instructions and hotkeys that are helpful for
new users.

Display a ZoomText Displays the ZoomText desktop icon.

icon on the desktop

If launched on a remote | When ZoomText (or Fusion) is started on a
server, wait for a client remote server, if ZoomText (or Fusion) is not

to connect running on the client machine, it will start up in
dormant mode and wake up when ZoomText
(or Fusion) has been launched on the client
machine.
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Exit Settings

Save ZoomText settings
automatically when
exiting

All ZoomText settings are saved to the active
configuration when the program exits.

Prompt to confirm
intent to exit ZoomText

You are prompted to confirm your choice to exit
the program.

Unload magnification
process when exiting
ZoomText

Unloads ZoomText's magnification process
when you exit ZoomText. This process will
otherwise continue running to provide faster
restart of ZoomText in the same Windows
session.

Automatic Updating

Check for online
updates each time
ZoomText is launched

Each time you start ZoomText, if an Internet
connection is established, ZoomText will check
online for available program updates. If updates
are available, the Update Wizard will give you
the option to download and install the updates.

Error Reporting

Report ZoomText errors
to Freedom Scientific
via the Internet

When a ZoomText program error occurs, an
error report is transmitted to Freedom Scientific
via the Internet (if an active Internet connection
exists). No personal information is included in
the error report.
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User Interface Preferences

User interface preferences control how the ZoomText user interface
appears on the Windows desktop.

= To adjust the user interface preferences
1. In the ZoomText menu, choose Preferences > User Interface.
The Preferences dialog appears with the User Interface tab displayed.

2. Adjust the user interface preference settings as desired.

3. Select OK.

Preferences

Pragram Uzer Interface Smoothing

Toolbar Settings
[«*]|Display toolkips For the ribbon contralsi

[ ]keep toolbar on top of other windows

[ ]Restare toolbar afrer using a ZoomText taal

Toolbar highlight color: ||:| Tan -

Taskbar Settings

(®) Display ZoomTezxt taskbar button and tray icon
() Display ZoomText taskbar butkon only
() Display ZoomTezxt tray icon only

ser Interface Language

Language: | English {United States) w

Cther Settings

Enable transition effects for screen enhancements

Cancel Help

The User Interface tab.




236

Description

Toolbar Settings

Display tooltips for the
ribbon controls

Enables display of informative tooltips when
moving the mouse over the controls on the
ZoomText toolbar.

Keep toolbar on top of
other windows

The ZoomText user interface window will
remain on top of all other windows, even when
ZoomText is not the active application.

Restore toolbar after
using a ZoomText tool

The ZoomText toolbar is always restored when
exiting a ZoomText tool.

Toolbar highlight color

Selects the color that is used to highlight the
controls on the ZoomText toolbar.

Taskbar Settings
Display ZoomText When ZoomText is running, its taskbar button
taskbar button and tray | and tray icon are both displayed.
icon
Display ZoomText When ZoomText is running, only its taskbar
taskbar button only button is displayed.
Display ZoomText tray | When ZoomText is running, only its system tray
icon only icon is displayed.

User Interface Language
Language Selects the language that the ZoomText user

interface will appear in.

Note: This option is not available in English
only versions.
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Other Settings

Enable transition effects
for screen
enhancements

Enables smooth visual shifts when switching
between ZoomText’s screen enhancement
schemes.
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Smoothing Preferences

Smoothing preferences control how ZoomText smooths and sharpens
text and graphics (including photographs) in the magnified view.
ZoomText provides two types of smoothing, xFont® and Geometric
Smoothing, which can be enabled individually or together.

e xFont applies only to text and displays the highest quality of
magnified text. It is not available in all applications. When xFont is
not available, Geometric Smoothing will smooth the magnified
text (if enabled).

e Geometric Smoothing provides high-quality smoothing both to
graphics and to text where xFont magnification cannot be applied.
Two types of Geometric Smoothing are available: ClearSharp and
Legacy.

o ClearSharp is the newer type of geometric smoothing that
produces enhanced smoothing quality with better system
performance.

o Legacy is the older type of geometric smoothing that remains
available for users that prefer the appearance of legacy
smoothing.

When ZoomText is enabled and magnifying the screen, you can cycle
through the smoothing modes to determine individual or combined
types of smoothing that work best for you.

= To cycle the smoothing mode

e Press the Smoothing Mode hotkey: Caps Lock + X

You can view and configure the Smoothing settings in the Preferences
dialog box.
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= To adjust the smoothing preferences
1. In the ZoomText menu, choose Preferences > Smoothing.
The Preferences dialog appears with the Smoothing tab displayed.

2. Adjust the smoothing preference settings as desired.

3. Select OK.

Preferences

Frograrm User Interface Smaothing

xFant Options

xFont Magnification applies only to kext and displays the highest quality
of magnified text, It is nok available in all applications.

[~]Enable =Font Maonification:
[ ]Bold xFont magnified ket

Exclude Applications. ..

Geometric Smookhing

Geometric Smookhing provides high-quality smoothing both to graphics
and to text where xFonk Magnification cannot be applied.

(®) Clearsharp
(O Legacy

() Mone

Cancel Help

The Smoothing tab.
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Description
xFont Options

Enable xFont Enables xFont magnification. xFont displays the

Magnification highest quality of magnified text and should
always be enabled.

Bold xFont magnified Adds boldness to text magnified by xFont.

text

Exclude Applications Displays settings for excluding the use of xFont

in problem applications. See "Excluding xFont in
Problem Applications" below.

Geometric Smoothing

ClearSharp Enables ClearSharp geometric smoothing.
Legacy Enables Legacy geometric smoothing.
None

Disables geometric smoothing.

Excluding xFont in Problem Applications

Some applications contain user-interface components that are not
compatible with ZoomText's xFont feature, resulting in missing or
corrupted text. When this occurs, you can exclude the use of xFont
within the problem application by selecting (checking) the application's
name in the Exclude Applications dialog box.

Note: Applications that have known conflicts with xFont have been
excluded in the default ZoomText configuration.
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= To exclude xFont in selected applications
1. In the ZoomText menu, choose Preferences > Smoothing.
The Preferences dialog appears with the Smoothing tab displayed.
2. Choose Exclude Applications...
The Exclude Applications dialog box appears.

2. In the Exclude xFont from list box, check the applications in which
you would like to exclude the use of xFont.

3. Click OK.

4. Restart ZoomText. This step is required to activate the changes
applied in the Exclude Applications dialog box.

Exclude &pplications

In some applications, xFonk texk enhancements may nok waork,
properly. Should this occur, check the application in the list belov
ko exclude the use of xFont within that application,

Exclude =Font From;:

Application Mame Displayed Mame 2
E::plorer . EXE \indows Explarer

] fontdrvhost exe

|:| GfExperienceService, exe

[ ]iexplore.exe Internet Explorer

[ ]lsass.exe Local Security Authority Ser,
|:| Memary Compressian

[ ] MpCmdrun, exe

] M3ASCuiL.exe o

< >

Coreel | [

The Exclude Applications dialog box

Description

Exclude xFont from: Displays a list of applications that are currently

running on the system. Checked applications are
excluded from xFont processing.
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Run ZoomText As

In certain situations, you may want an installation of ZoomText
Magnifier/Reader to startup and run as ZoomText Magnifier. You can
do this in the Run ZoomText As dialog box.

= To switch with product type ZoomText runs as
1. In the ZoomText menu, choose Preferences > Run ZoomText As.
The ZoomText Run As dialog box appears.

2. Select the product type that you want ZoomText to run as.
3. Click Restart ZoomText Now.

ZoomText will exit and restart as the selected product type.

Fun LoomText fs

Restark wour ZoomText software o run as:
() ZoomText Magnifier
(®) FoomText Magnifier/Reader!

Restark ZoomTexk Mow | Cancel I

The Run ZoomText As dialog box.

Setting Description

ZoomText Magnifier Sets ZoomText to start up as ZoomText
Magnifier.

ZoomText Sets ZoomText to start up as ZoomText

Magnifier/Reader Magnitier/Reader.

Restart ZoomText Now Exits and restarts ZoomText as the selected
product type.
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ZoomText Commands

This section provides a complete listing of ZoomText Command keys,
including hotkeys, layered keys, and modal keys.

e AppReader Commands

e Background Reader Commands

e (Camera Commands

e Finder Commands

e Lavered Keys Command Mode

e Magnifier Commands

e Program Commands

e Reader Commands

e Reading Zones Commands

e Recorder Commands

e Sayv Commands

e Scroll Commands

e Support Commands

e Text Cursor Commands

¢ Window Commands
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AppReader Commands

The following hotkeys can be used to launch the AppReader.

Command \ Hotkeys

Launch AppReader from Pointer | Caps Lock + Alt + Left-Click
Launch App View Caps Lock + Alt + A
Launch Text View Caps Lock + Alt+T

Launch SpeaklIt Tool Caps Lock + Alt+S

Launch AppReader (selected Caps Lock + Alt+ R

mode)

The following layered keys can be used to launch the AppReader.

Command Layered Keys

Launch AppReader Caps Lock + Spacebar, A

While the AppReader is active, the following modal keys can be used to
operate the AppReader.

Command \ Modal Keys

Next Word Ctrl + Right
Previous Word Ctrl + Left
Next Sentence Right
Previous Sentence Left

Next Paragraph Down
Previous Paragraph Up

Next Page Page Down
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Previous Page Page Up

Current Word * Ctrl + Alt + Shift + Up
Current Line Ctrl + Alt + Shift + Right
Current Sentence Ctrl + Alt + Shift + Down
Current Paragraph Ctrl + Alt + Shift + Left
First Word On Line Home

Last Word On Line End

Beginning of Document Ctrl + Home

End of Document Ctrl + End

Next Link L

Previous Link Shift + L

Execute Link Ctrl + Enter

* When using the Current Word command, repeated presses within two
seconds provides the following behavior:

e First press: speaks the word

e Second press: spells the word

e Third press: spells the word phonetically ("Alpha, Bravo, Charlie,

)
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Background Reader Commands

The following hotkeys can be used to launch the Background Reader.

Command \ Hotkeys

Launch Background Reader Caps Lock + Ctrl + B

The following layered keys can be used to launch the Background Reader.

Command Layered Keys

Launch Background Reader Caps Lock + Spacebar, B

While the Background Reader toolbar is active, the following modal keys can
be used to operate the Background Reader.

Command \ Modal Keys

Show Toolbar T

Capture C

Play / Pause Enter

Restart (from the beginning) Shift + Enter

Next Sentence Right

Previous Sentence Left

Next Word Ctrl + Right

Previous Word Ctrl + Left

Current Word Ctrl + Alt + Shift + Up
Current Sentence Ctrl + Alt + Shift + Down
Exit X
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Camera Commands

The following hotkeys can be used to launch the ZoomText Camera.

Command \ Hotkeys

Launch Camera Caps Lock + Ctrl + C

The following layered keys can be used to launch the ZoomText Camera.

Command Layered Keys

Launch Camera Caps Lock + Spacebar, C

While the Camera Toolbar is active, the following modal keys can be used to
adjust the ZoomText Camera settings.

Command \ Modal Keys

Show Toolbar T

Zoom In Up

Zoom QOut Down

Rotate Image Left/Right
Docked/Full Toggle Tab

Docked Position Caps Lock + Left/Right
Clarity On/Off Shift + Enter
Clarity Reset Shift + Backspace
Brightness Increase Shift + Up
Brightness Decrease Shift + Down
Contrast Increase Shift + Left
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Contrast Decrease Shift + Right
Two-Color On/Off Alt + Enter
Two-Color Scheme Alt + Left/Right
Focus Automatic/Manual Ctrl + Enter
Focus In Ctrl+ Up
Focus Out Ctrl + Down
Exit X
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Finder Commands

The following hotkeys can be used to launch the Finder.

Command \ Hotkeys

Launch Finder Caps Lock + Ctrl + F

The following layered keys can be used to launch the Finder.

Command Layered Keys

Launch Finder Caps Lock + Spacebar, F

While the Finder is active, the following modal keys can be used to operate
the Finder.

Command \ Keys

Cycle Page Items Type Up Ctrl+ Up
Cycle Page Items Type Down Ctrl + Down
Execute Item Ctrl + Enter
First Item (in filtered list) Ctrl + Home
Last Item (in filtered list) Ctrl + End
Next Control Ctrl+ C
Next Form Ctrl +F
Next Heading Ctrl+ H
Next Heading Level 1 ... 6 Ctrl+1..6
Next Image Ctrl +1
Next Link Ctrl +L
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Next List Ctrl +S

Next Table Ctrl +T

Next Item Enter OR Ctrl + Right
Previous Control Ctrl + Shift + C
Previous Form Ctrl + Shift + F
Previous Heading Ctrl + Shift + H

Previous Heading Level 1 ... 6

Ctrl + Shift+1...6

Previous Image Ctrl + Shift + 1
Previous Link Ctrl + Shift + L
Previous List Ctrl + Shift + S
Previous Table Ctrl + Shift + T

Previous Item

Shift + Enter OR Ctrl + Left

AppReader Alt+R
Toggle List Search Alt+L
Exit Finder Esc
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Layered Keys Command Mode

The following hotkeys can be used to launch the layered keys command
mode.

Command Hotkeys

Command Mode Selection Caps Lock + Spacebar

When the command mode is active, the following layered keys can be used to
enter the available command mode groups.

Command \ Layered Keys

AppReader Commands A
Launch Background Reader B
Launch Camera C
Launch Finder F
Launch Recorder D
Magnifier Commands M
Program Commands P
Reader Commands R
Say Commands Y
Scroll Commands S
Support Commands U
Window Commands W
Zones Commands Z
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Magnifier Commands

The following hotkeys can be used to operate the Magnifier Commands.

Command \ Hotkeys

Magnifier Commands Unassigned
Enhance Colors On/Off Caps Lock + C
Enhance Cursor On/Off Caps Lock +R
Enhance Focus On/Off Caps Lock + F
Enhance Pointer On/Off Caps Lock + P
Enhance Smart Invert On/Off Caps Lock +1
Smoothing Mode Caps Lock + X
Toggle Zoom and 1x Caps Lock + Enter
Zoom In Caps Lock + Up
Zoom Out Caps Lock + Down

The following layered keys can be used to operate the Magnifier Commands.

Command \ Layered Keys
Magnifier Commands Caps Lock + Spacebar, M
Enhance Colors On/Off C

Enhance Cursor On/Off R

Enhance Focus On/Off F

Enhance Pointer On/Off P

Enhance Smart Invert On/Off I
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Smoothing Mode X
Toggle Zoom and 1x Enter
Zoom In Up
Zoom QOut Down
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Program Commands

The following hotkeys can be used to operate the Program Commands.

Command \ Hotkeys

Program Commands Unassigned
ZoomText On/Off Caps Lock + Ctrl + Enter
Show User Interface Caps Lock + Ctrl + U

Load Configuration 1 ... 10

Caps Lock + Ctrl +1 ... 0
Note: 0 is used to load configuration 10

Manage Application Settings

Caps Lock + Ctrl + M

Save Application Settings

Caps Lock + Ctrl + S

The following layered keys can be used to operate the Program Commands.

Command \ Layered Keys

Program Commands Caps Lock + Spacebar, P
ZoomText On/Off Enter

Show User Interface U

Load Configuration 1 ... 10 1..10

Note: 0 is used to load configuration 10

Manage Application Settings

M

Save Application Settings

S
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Reader Commands

The following hotkeys can be used to operate the Reader Commands.

Command \ Hotkeys

Reader Commands Unassigned

Echo Keyboard Mode Caps Lock + Alt+ K
Echo Mouse Mode Caps Lock + Alt+ M
Echo Verbosity Level Caps Lock + Alt + B
Voice On/Off Caps Lock + Alt + Enter
Voice Select Caps Lock + Alt+V
Voice Faster Caps Lock + Alt + Up
Voice Slower Caps Lock + Alt + Down

The following layered keys can be used to operate the Reader Commands.

Command \ Layered Keys

Reader Commands Caps Lock + Spacebar, R
Echo Keyboard Mode K

Echo Mouse Mode M

Echo Verbosity Level B

Voice On/Off Enter

Voice Select Vv

Voice Faster Up

Voice Slower Down
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Reading Zones Commands

The following hotkeys can be used to operate the Magnifier Commands.

Command \ Hotkeys

Zones Commands Caps Lock + Alt+ Z
Create Zone Caps Lock + Alt+C
Edit Zone Caps Lock + Alt+ E
List Zone Caps Lock + Alt + L
Navigate Zones Caps Lock + Alt+ G
Next Zone Caps Lock + Alt+ N
Previous Zone Caps Lock + Alt + P

Trigger Zone 1 ... 10

Caps Lock + Alt+1 ... 0
Note: 0 triggers Zone 10.

The following layered keys can be used to operate the Magnifier Commands.

Command \ Layered Keys

Zones Commands

Caps Lock + Spacebar, Z

Create Zone C
Edit Zone E
List Zone L
Navigate Zones G
Next Zone N
Previous Zone P
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Trigger Zone 1 ... 10

1..0
Note: 0 triggers Zone 10.
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Recorder Commands

The following hotkeys can be used to launch the ZoomText Recorder.

Command \ Hotkeys

Launch Recorder Caps Lock + Ctrl + D

The following layered keys can be used to launch the ZoomText Recorder.

Command Layered Keys

Launch Recorder Caps Lock + Spacebar, D
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Say Commands

The following hotkeys can be used to trigger the Say Commands.

Command Hotkeys

Say Commands Unassigned

The following layered keys can be used to trigger the Say Commands.

Command \ Layered Keys

Say Commands Caps Lock + Spacebar, Y

Say Current Date

Say Current Time

Say Cell Column Title

Say Cell Comment

Say Cell Formula

Say Cell Row Title

Say Clipboard

Say Dialog Default Button

Say Dialog Group Name

Say Dialog Message

Say Dialog Tab

Say Focus

Say Selected Text

Say Status Bar

sla|le|=|s|z|lo|=|~|®m|o|lz|0|=|0C

Say Window Title
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Scroll Commands

The following hotkeys can be used to operate the Scroll Commands.

Command \ Hotkeys

Scroll Commands Unassigned

Scroll Up Caps Lock + Shift + Up
Scroll Down Caps Lock + Shift + Down
Scroll Left Caps Lock + Shift + Left
Scroll Right Caps Lock + Shift + Right
Scroll Stop Caps Lock + Shift + Enter
Jump Up Caps Lock + Ctrl + Up
Jump Down Caps Lock + Ctrl + Down
Jump Left Caps Lock + Ctrl + Left
Jump Right Caps Lock + Ctrl + Right
Jump Center Caps Lock + Ctrl + Home
Save View Caps Lock + Ctrl + Page Up
Restore View Caps Lock + Ctrl + Page Down




The following layered keys can be used to operate the Scroll Commands.
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Command \ Layered Keys
Scroll Commands Caps Lock + Spacebar, S
Scroll Up Up

Scroll Down Down

Scroll Left Left

Scroll Right Right
Scroll Stop Enter
Jump Up Ctrl + Up

Jump Down Ctrl + Down
Jump Left Ctrl + Left
Jump Right Ctrl + Right
Jump Center Ctrl + Home
Save View Ctrl + Page Up
Restore View Ctrl + Page Down
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Support Commands

The following hotkeys can be used to operate the Magnifier Commands.

Command \ Hotkeys

Support Commands Unassigned

AHOI On/Off Ctrl + Alt + Shift + A
AHOI Report Ctrl + Alt + Shift + R
Capture Screen Ctrl + Alt + Shift + C
Detect Cursor Ctrl + Alt + Shift + D
Pass Next Hotkey Ctrl + Alt + Shift + P
Tracking On/Off Ctrl + Alt + Shift+ T
Refresh Screen Model Ctrl + Alt + Shift + U
ZoomText Information Ctrl + Alt + Shift + I

The following layered keys can be used to operate the Magnifier Commands.

Command \ Layered Keys

Support Commands Caps Lock + Spacebar, U
AHOI On/Off A

AHOI Report R

Capture Screen C

Detect Cursor D

Pass Next Hotkey P

Tracking On/Off T
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Refresh Screen Model

ZoomText Information
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Text Cursor Commands

The following hotkeys can be used to operate the Text Cursor Commands.

Command \ Hotkeys

Current Character Ctrl + Alt + Shift + Enter
Current Word Ctrl + Alt + Shift + Up
Current Line Ctrl + Alt + Shift + Right
Current Sentence Ctrl + Alt + Shift + Down
Current Paragraph Ctrl + Alt + Shift + Left
Next Sentence Caps Lock + Alt + Right
Previous Sentence Caps Lock + Alt + Left

The following keys are standard Windows keyboard commands for moving
the text cursor through text.

Command \ Windows Keys

Next Character Right
Previous Character Left

Next Word Ctrl + Right
Previous Word Ctrl + Left
Next Line Up
Previous Line Down

Next Paragraph Ctrl + Down
Previous Paragraph Ctrl+ Up
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Window Commands

The following hotkeys can be used to operate the Window Commands.

Command \ Hotkeys

Window Commands Unassigned

Zoom Window Type Caps Lock +Z
Zoom Window Adjust Tool Caps Lock + A
Freeze View On/Off Caps Lock + E
Freeze View New Caps Lock + N
Route Mouse to View Unassigned

Route View to Mouse Unassigned

Switch Active View Caps Lock + V
View Locator On/Off Caps Lock + L
Overview Mode On/Off Caps Lock + O

The following layered keys can be used to operate the Window Commands.

Command \ Layered Keys

Window Commands Caps Lock + Spacebar, W
Zoom Window Type Z

Zoom Window Adjust Tool A

Freeze View On/Off E

Freeze View New N

Route Mouse to View Down
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Route View to Mouse Up
Switch Active View \Y%
View Locator On/Off

Overview Mode On/Off O
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ZoomText Support

ZoomText comes with a variety of built-in and online support tools and
services that are available 24 hours a day, 7 days a week. These tools and
services include information gathering utilities, technical and how-to-
articles, feature videos and a fast way to report a problem to the
ZoomText product support team. Some of these tools may also be called
on when working a problem with a ZoomText support representative.

e System Info

e Report a Problem

e Fix-It Command

e System Profiler

e Online Help Center
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System Information

The System Info dialog displays a collection of information about your
system's hardware, software and configuration that may be useful in
diagnosing a problem.

= To view the System Info dialog
In the ZoomText menu, choose ZoomText Support > System Info.

The ZoomText Support dialog box appears with the System Info tab

displayed.
Loom Text Su pport
Syztem Info Fiepart a Problem Fiw-lt
Swskerm
05 Marme: | Windows 10
05 Version: | 10,0.17134
System RAM: | 6183 MB

Windows Direckory: | W TRDICS

Swskem Direckory: | CM IMDOW S swskemn 32

CPU: | Inkel(R) CoredTH iS5 CPU 661 @ 3,33GHz
Device Descripkion: | AMD Radeon HD 5700 Series

Driver Yersion: | 15.201.1151.1008

Driver Date: | 11-4-2015

Bits per pixel: | 3z

Screen Resolution: | 1920 x 1080

Directy Feature Level: | Feature Lewvel 11_0

Magnification Engine: | Rt |

Cloze Help

The System Info tab.
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Report a Problem

The Report a Problem dialog lets you electronically submit reports on
problems you are experience when using ZoomText. Submitting a
report requires you to complete a short form, providing a description of
the problem along with your contact information. When you submit the
report a collection of ZoomText performance and configuration files are
automatically attached the report. These files do not contain any
information of a personal or private nature.

= To use the Report a Problem dialog

In the ZoomText menu, choose ZoomText Support > Report a
Problem.

The ZoomText Support dialog box appears with the Report a Problem
tab displayed.
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Zoom Te:

System Info Report a Problem Fim-lt

Please describe the problem yvou are encountering, with details abouk the
applications the problem occurs in, steps to reproduce the problem, and the
frequency of occurence,

How smooth does ZoomText run on wour computer?

St
First Marne: | |
Last Marme: | |
Ermail: | |
Phione: |.-'nc.'.-_m'e your areadbourtny code |

Your submitked repaort will include the ZoomText performance logs and
configuration files that will help Freedom Scientific diagnose wour reported
problem.,

Wiew Files Subrit Repork

Cloze Help

The Report a Problem tab.
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Fix-It Command

Fix-It commands are used to fix unique performance and behavioral
problems that have been diagnosed by a ZoomText support technician.
The Fix-It command is provided by the support technician and entered
and applied as instructed in the Fix-It dialog.

= To use the Fix-It Command dialog

In the ZoomText menu, choose ZoomText Support > Fix-It
Command.

The ZoomText Support dialog box appears with the Fix-It tab
displayed.

ZoomText Support

Suster Info Fepaort a Problem Fislt

Fix-It Cammands

If a support technician gives wou a Fix-Ik command, please bype

ﬁ the cormmand in the field below and then click on the Fix-It
button,

Enter the Fix-It command bere: | |

Apply Eix-IE Cormmand

Cloze Help

The Fix-It tab.



272

System Profiler

The ZoomText System Profiler identifies potential problems with your
system configuration that may degrade the system's performance when
running ZoomText.

= To run the ZoomText System Profiler
In the ZoomText menu, choose ZoomText Support > System Profiler.

The ZoomText System Profiler dialog box appears.

Zoom Text Systern Profiler

The ZoomText System Profiler identifies potential problems

in a syskem’s hardware, saftware and configurations thak rmay
deqgrade the system's performance when running ZoomText,
The profiler has identified the Following potential problems.

Windows Experience Index is below 5.0

Mare infarmation, ..

[] alert me of potential problems when starting ZoomText,

The ZoomText System Profiler dialog box.
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ZoomText Online Support

The ZoomText Online Help Center provides a wide variety of how-to
and technical articles on ZoomText.

= To open the online help center

¢ In the ZoomText menu, choose ZoomText Support > Online Help
Center.
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About ZoomText

The About ZoomText dialog shows program and license information,
including the product type, version, serial number and user name.

» To view the About ZoomText information
1. In the ZoomText menu, choose About ZoomText.
The About ZoomText dialog appears.
2. When you are done viewing the dialog, click OK.

About Zoorm Text

Program Info

ZoomText@E 2019 {64-hit) Special pdate Code
Copyright € 2018 by Freedom Scientific, Inc,

Protected by 11,5, paktent no, 7,483,592

Protected by U3, patent no, 7,912,322

Protected by LLK, patent no. 2,422,082

Licensed under U5, patent no, 5,490,216

Product: | FoomText Magnifier/Reader
Type: | Local Fusion ILM, 0 upgrades remaining
Serial: |

Femoke Access; | Disabled

|
|
Versian: | 2019.1811,55 ILM |
|
|
|

Locking Code: |

Acknowledgernents

Cloze Help

The About ZoomText dialog box
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Setting Description

Product Displays the type of product: 'Magnifier' or
'Magnifier/Reader".

Type Displays the type of installation: Product’ or
"Trial'.

Version Displays the ZoomText product version and

build number.

Serial Number Displays the product serial number.

Note: a serial number is not displayed when
running a trial version of ZoomText.

Name Displays the name of the registered user.

Company Displays the company name of the registered
user.
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Chapter 12
Scripting

In today's computer-centric world, visually-impaired individuals are
challenged to meet the same performance goals as their normal-sighted
peers. In many situations, especially job related, it can be difficult for
these individuals to meet their goals, even when equipped with
ZoomText.

With ZoomText's scripting feature you can create and utilize scripts to
customize the behavior of ZoomText and other applications, providing
more informative visual and audible feedback, and automation of tasks.
This is turn allows you to work with improved speed and efficiency.

Here are just a few examples of things you can do with ZoomText
scripting;:

e Automatically announce selected fields of information in a
database or spreadsheet.

e Automatically announce new items in your email inbox and
automatically read email when opened.

e Automatically announce application controls and data in more
meaningful way.

e Automatically read new text that arrives in a chat window.

e Automatically announce when a selected field of information
changes, such as the balance in spreadsheet dipping below a
specified value.
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This section provides instructions for writing, registering, managing
ZoomText scripts.

e What Are Scripts?

e Writing Scripts

e Registering Scripts

e Managing Scripts

e Script Hotkeys

e Documentation
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What are Scripts and Scripting Languages?

What is a script? A script is a text file containing programming
commands that initiate a given ZoomText or application task. Scripts
can consist of a few lines of very simple commands or many lines of
complex programming. ZoomText scripts are written using one of the
industry standard scripting languages, such as VBScript,
Jscript/JavaScript, C# or Perl. No special tools are required to write a
script, in fact, scripts can be written using the Windows Notepad.
However, you must have some knowledge and experience writing
scripts.

What are scripting languages? Scripting languages are programming
languages that control existing applications or their components.
Scripting languages can be created and used without special
programming software or the need for traditional compiling and
building of program code. Thus, they favor rapid development and the
ability to communicate with other programs. There are many different
scripting languages, each of which is generally designed for a specific
type of use.

What scripting languages can be used to write ZoomText scripts? The
standard industry scripting languages that we suggest are: VBScript,
Jscript/JavaScript, C# and Perl.
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Writing ZoomText Scripts

Although most anyone can learn to write basic ZoomText scripts,
writing true productivity scripts requires an amount of experience and
expertise. Therefore, Freedom Scientific recommends using an
experienced script writer to design, create and test scripts — preferably
one that is understands the challenges faced by visually-impaired
computer users.

An experienced script writer may be available within your company or
organization — start by checking with your department manager or IT
department. You may also find an experienced script writer through
services advertised on the Internet. If you are unable to find a script
writer on your own, Freedom Scientific may be able to assist you in
finding a script writer — contact Freedom Scientific’s product support
department at 727-803-8600 or send email to
support@freedomscientific.com.

Other Sources of ZoomText Scripts

With growing popularity of ZoomText scripting a variety of scripts for
mainstream applications will become available for users to download
and purchase. These scripts will be made available in the ZoomText
Scripting Library on Ai Squared’s website. For more information, go to
www.aisquared.com/scripting.
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Registering Scripts

In order to use scripts written for ZoomText they must first be registered
using ZoomText's Script Manager. There are two types of ZoomText
scripts that can be registered; script programs and script components.

e A script program is a text file and can be registered by simply
browsing to and selecting its corresponding file. Script program
files are typically written in VBscript (.VBS), Jscript (.JS) or Perl
(.PL) scripting languages.

e A script component is a program file that must first be registered
with Windows and ZoomText. These program files typically have
a .DLL or .WSC files extension.

Important! You must have administrative privileges to register scripts
and make changes in the ZoomText Script Manager. Registering and
modifying scripts can adversely affect the behavior of your system and
should only be performed by a qualified individual or according to their
instructions.

= To register a 'script program' with ZoomText (e.g. VBS, JS, PL)
1. Inthe ZoomText menu, choose Scripting > Script Manager.
The Script Manager dialog appears.
2. In the Script Manager dialog, choose Register a Script...
The Register Script dialog appears.

3. Browse to folder containing the script program you want to
register.

4. Select the script program and click OK.
The Script Manager dialog appears.
5. Click OK.
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= To register a 'script component' with ZoomText (e.g. DLL, WSC)

1. If your script component is already registered with the Windows
operating system, proceed to step 2. Otherwise, register your
script with Windows as follows:

o To register a Windows scripting component (WSC file):
a) In Windows Explorer, locate the scripting file.
b) Right-click on the file and select Register.
o To register a COM scripting component (.DLL file):
a) Click on the Windows Start button and select Run...
b) Type: COMMAND
c) Click OK.

The command prompt appears.

d) At the command prompt, type: REGSVR32 {path filename of
script}

e) Press the Enter key.

The script is registered with Windows.
f) Type: EXIT
g) Press the Enter key.

The command prompt window closes.

2. In the Settings menu, choose Scripting Script Manager...
The Script Manager dialog appears.
3. In the Script Manager dialog, choose Register a Script...

The Register Script dialog appears.
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4. In the Script component program ID field, type the program ID
(aka ProgID) for the script component you want to register.

5. Click OK.

Register Script

To reqizter a zcrpt file, enter the path and filename far the script that
yoL want ko register,

Scnpt file path and name:

Browse...

To register a scrpt component, enter the program (D far the
component that you want to register.

Script companent pragram 1D [ProglD]:

Script information:

Mo information available on thiz zoript..

Ok Cancel Help

The Register Script dialog box.

Setting Description

Script file path and name: | Provides a place for you to type the location and
file name of the script program you want to
register. If you are not sure of the program's
location or file name, click Browse.

Browse... Displays the Select Script File dialog box, which
allows you to navigate files folders and select
existing script files.




284

Script component program
ID (ProgID):

Provides a place for you to type the program ID
for the script component you want to register.
Program IDs are provided by the script author.

Script information

Displays information about the specified script
file or script component (if provided within the
script), including the author date, version,
contact information and a description of the
script's purpose.

Show Script Information

When entering a program ID, clicking the Show
Script Information button will display the script
information (if provided within the script).
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Managing Scripts

ZoomText’s scripting feature allows you to register and run scripts for
any application. Some users may only require a few scripts for a single
application, while other may need many scripts for many applications.
The ZoomText Script Manager makes the process of registering, viewing
and managing scripts a simple and intuitive task.

Here's what you can do with the ZoomText Script Manager:

e Register new scripts written for ZoomText

e Quickly enable and disable scripts as needed (without having to
unregister them)

e Open and edit scripts. Important: Editing scripts should only be
performed by a qualified script writer.

e View a description of each script, including the scripts purpose

Note: You must have administrative privileges to make changes in the
ZoomText Script Manager. Registering and modifying scripts can
adversely affect the behavior of your system and should only be
performed by a qualified individual or according to their instructions.

= To view and manage ZoomText scripts
1. In the ZoomText menu, choose Scripting > Script Manager.
The Script Manager dialog appears.

2. Modify the registered scripts as desired.
3. Click Close.
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ZoornText Script Manager

Regztered Scrpts: S cript Actions:

Begizter a Script...

Script Infarmation:

Mo zonipt selected

Cloze Help

The ZoomText Script Manager dialog box.

Setting Description

Registered Scripts: Displays a list of scripts that are currently
registered for use when ZoomText is running.
Scripts that appear in this list may be enabled
and disabled, moved up and down to prioritize
their execution (when triggered by the same
event), or removed altogether by unregistering
the script. To perform these actions, select the
desired script (or scripts) and then choose the
desired script action.

Register a Script... Opens the Register Script dialog where you can
specify scripts that you want to register for use
with ZoomText. For information on how to
register a script, see Registering Scripts.
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Script Information: Displays information about the highlighted
script (if provided by the script author),
including the author date, version, contact
information and a description of the script's
purpose.

Script Actions

Enable Enables the highlighted script (or scripts). When
a script is enabled it is executed whenever
ZoomText is running — according to its
designed purpose.

Note: A script can also be enabled or disabled by
clicking its associated check box.

Disable Disables the highlighted script (or scripts). When
a script is disabled it remains registered with
ZoomText but is not executed.

Note: A script can also be enabled or disabled by
clicking its associated check box.

Edit... Opens the selected script in the Windows
Notepad where it may be viewed and edited.

Unregister Removes the selected script so that it is no longer
loaded by ZoomText. When a script is
unregistered it is immediately terminated and
removed from the list of Registered Scripts.

Settings Displays the Settings Interface for the selected
script.

For more information about creating and registering scripts, see the ZoomText
Scripting Documentation for Script Writers. In the ZoomText menu, choose
Scripting > Documentation.
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Script Hotkeys

ZoomText scripts can be written so that they execute automatically in
response to specified events or when pressing a hotkey (or hotkeys).
When a script is written for execution by hotkey(s), the hotkey(s) will
appear in ZoomText's Hotkeys dialog box. Like all ZoomText hotkeys,
you can view and modify the script hotkey assignments.

= To view the script hotkeys
1. In the ZoomText menu, choose Command Keys
The ZoomText Command Keys dialog appears.
2. In the Search box, type: SCRIPTS.
A list of script hotkeys appear in the Hotkeys Command list.

3. To view a script hotkeys assigned key combination, click on the
desired script hotkey.

The hotkey's assigned key combination appears in the Primary Key
and Modifier Keys settings.

4. Adjust the hotkey combination as desired.
5. Repeat steps 3 and 4 for each hotkey you wish to view or modity.
6. Click OK.
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Scripting Documentation for Script Writers

The ZoomText Scripting Documentation for Script Writers provides
instructional information for writing and testing ZoomText scripts.

= To view the Documentation for Script Writers

In the ZoomText menu, choose Scripting > Documentation.
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zoom windows
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